
 

 

UNIVERSIDAD POLITÉCNICA DE MADRID 
Escuela Técnica Superior de Ingenieros de Telecomunicación 

Design and Development of Two-Photon 

Polymerization System for Photonics 

Micro/Nanostructure Fabrication 

 

 

DOCTORAL THESIS 
Submitted for the degree of Doctor by: 

Byron Oswaldo Ganazhapa Jiménez 
MSc. Electronic Engineering 

 
 
 
 
 
 
 
 
 

  



  

UNIVERSIDAD POLITÉCNICA DE MADRID 

Escuela Técnica Superior de Ingenieros de 

Telecomunicación 

 

 

Doctoral Degree in Electronic Systems Engineering 

 

Design and Development of Two-Photon 

Polymerization System for Photonics 

Micro/Nanostructure Fabrication 

 

 

DOCTORAL THESIS 
Submitted for the degree of Doctor by: 

Byron Oswaldo Ganazhapa Jiménez 
MSc. Electronic Engineering 

 

 

Under the supervision of: 

Dr. Patxi Xabier Quintana Arregui 

Dr. Manuel Caño García 

 

 

 



 

i 

 

 

Title: Design and Development of Two-Photon Polymerization System for 

Photonics Micro/Nanostructure Fabrication 

Author: Byron Oswaldo Ganazhapa Jiménez 

Doctoral Programme:  Electronic Systems Engineering 

Thesis Supervision:   

Dr. Patxi Xabier Quintana Arregui, Full-profesor at Escuela Técnica 

Superior de Ingenieros de Telecomunicación – UPM (Supervisor) 

Dr. Manuel Caño García, researcher at Departamento de Electrónica y 

Tecnología de Computadores – Universidad de Granada (Supervisor) 

 

 

External Reviewers: 

 

 

 

Thesis Defense Committee: 

 

 

 

 

 

 

Thesis Defense Date: 

 

 

 

This thesis has been supported by the “Ayudas para la realización de Doctorados 

Industriales de la Comunidad de Madrid” (IND2020/TIC-17424). 

 





 

iii 

 

 

 

 

 

 

 

To my family… 

 

 

 

 





 

v 

 

Acknowledgement 

Muchas gracias a todos quienes han formado parte en este proyecto de investigación; amigos, 

colegas y familiares. 

Agradezco a todos catedráticos e investigadores del GFA, principalmente a mis directores de 

tesis, Xabier y Manuel (Lolo) por guiarme en la formación académica y ayudarme en la 

realización de este proyecto con sus ideas brillantes y experiencia. Agradezco a mis colegas, 

Javier y Ricardo, por acompañarme en la investigación, intercambiar ideas y comentarios 

constructivos, y por colaborar en la medición y presentación de resultados. También agradezco 

a Morten y José Manuel por su contribución en la presentación de resultados científicos y en la 

realización de esta tesis. ¡Gracias a todos de todo corazón! 

Agradezco a todos los colegas de la empresa Lasing S.A., especialmente a Gonzalo, Alberto y 

Pablo por la formación profesional brindada hacia mi persona para la realización de este 

doctorado industrial. ¡Gracias sinceras por dejarme ser parte de la familia Lasing S.A.! 

Ringrazio la mia compagna Barbara. Sei stata al mio fianco ogni secondo della mia vita, 

incoraggiandomi ad andare avanti in ogni scelta difficile e ostacolo, per cui sono felice e pieno 

di vita. Ringrazio tantissimo Dio per la tua esistenza, sei la mia anima e gioia che riempie il 

mio cuore. Dedico questa tesi specialmente a te. Ti amo tantissimo! 

Ringrazio anche Antonio e Loredana per il loro sostegno e i loro consigli; siete la mia famiglia 

che nessun altro potrà mai avere in questo mondo, e siete i miei genitori accoglienti. 

Agradezco a mi familia, Wilma, Segundo, Marta, Karla y Mónica por estar siempre a mi lado. 

Se que me han visto un ejemplo para seguir, pero la verdad es que son ustedes quienes han sido 

mi motor desde mis inicios. Dedico esta tesis también a ustedes. ¡Los quiero muchísimo! 

Muchas gracias a todos. 

 

 

 

 

 



 

vi 

 

Abstract 

This Thesis is focused on the design, manufacturing, test, calibration, and optimization of a 

two-photon polymerization (2PP) system for micro-fabrication of polymeric structures. The 

work has been carried out as a collaboration between the company Lasing S.A. and the Grupo 

de Fotónica Aplicada (GFA) of the Centro de Materiales y Dispositivos Avanzados para 

Tecnologías de la Información y Comunicaciones (CEMDATIC) at the Technical University 

of Madrid (UPM). It has been funded by the Comunidad de Madrid under an industrial PhD 

program. 

In the initial phase, the system was designed and assembled at the company Lasing S.A., and 

subsequently installed in the cleanroom of the GFA, resulting in a fully operational system for 

the polymerization of two- and three-dimensional (2D, 3D) microstructures based on 

commercial photoresists. 

Subsequently, the 2PP system was optimized to characterize the voxel in commercially 

available negative-tone and positive-tone photoresists. This work –a crucial aspect for 

achieving maximum resolution during direct laser writing (DLW) processes– was performed in 

the GFA cleanroom. The work provides a DLW analysis that correlates printing parameters 

(scanning speed and laser beam power control) with the lateral and axial voxel sizes. 

Once the system was optimized, 2D polymeric microstructures were fabricated. This involved 

controlling the voxel and the focus on ultrathin polymer surfaces to obtain repeatable patterns 

consisting of periodic microgrooves or microlines with 0.5 µm spacing for liquid crystal (LC) 

alignment. These arbitrary patterns enabled the generation of polarizers with high-quality 

alignment in SU-8 and S1805 photoresists. 

Finally, 3D polymeric microstructures were fabricated. In this case, the hatching technique was 

applied with an optimized voxel to fill the printed microstructures using both layer-by-layer 

and true 3D printing methods. Additionally, complex micro-scaffolds with resolution of about 

0.5 µm were fabricated in mr-DWL photoresist. 

The fully functional 2PP system has enabled the micro-fabrication of photonic structures for a 

wide range of future commercial and research applications, resulting in an industrial equipment 

that the company Lasing S.A. can commercialize. 
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Resumen 

Esta tesis se centra en el diseño, fabricación, prueba, calibración y optimización de un sistema 

de polimerización de dos fotones (2PP) para la micro-fabricación de estructuras poliméricas. El 

trabajo se ha realizado en colaboración entre la empresa Lasing S.A. y el Grupo de Fotónica 

Aplicada (GFA) del Centro de Materiales y Dispositivos Avanzados para Tecnologías de la 

Información y Comunicaciones (CEMDATIC) en la Universidad Politécnica de Madrid 

(UPM). Este proyecto ha sido financiado por la Comunidad de Madrid bajo un programa de 

doctorado industrial. 

En la fase inicial, el sistema fue diseñado y ensamblado en le empresa Lasing S.A., y 

posteriormente instalado en la cámara limpia del GFA, resultando en un sistema completamente 

operativo para la polimerización de microestructuras bidimensionales y tridimensionales (2D, 

3D) basado en fotoresinas comerciales. 

Posteriormente, el sistema 2PP fue optimizado para caracterizar el vóxel en fotoresinas 

comerciales de tono negativo y positivo. Este trabajo, un aspecto crucial para alcanzar la 

máxima resolución durante los procesos de escritura directa por láser (DLW), se llevó a cabo 

en la sala limpia del GFA. El trabajo proporciona un análisis de DLW que correlaciona los 

parámetros de impresión (velocidad de escaneo y control de la potencia del haz láser) con los 

tamaños lateral y axial del vóxel. 

Una vez optimizado el sistema, se fabricaron microestructuras poliméricas 2D. Esto implicó 

controlar el vóxel y el enfoque en superficies poliméricas ultradelgadas para obtener patrones 

repetibles consistentes en micro-surcos o micro-líneas periódicas con un espaciado de 0.5 µm 

para la alineación de cristales líquidos (LC). Estos patrones arbitrarios permitieron la 

generación de polarizadores con alineación de alta calidad en los fotoresinas SU-8 y S1805. 

Finalmente, se fabricaron microestructuras poliméricas 3D. En este caso, se aplicó la técnica de 

hatching con un vóxel optimizado para el relleno de las microestructuras impresas mediante los 

métodos de impresión capa por capa y 3D real. Además, se fabricaron micro-andamios 

complejos con una resolución de alrededor de 0.5 µm en la fotoresina mr-DWL. 

El sistema 2PP completamente funcional ha permitido la micro-fabricación de estructuras 

fotónicas para una vasta variedad de aplicaciones comerciales y de investigación futuras, 

culminando en un equipo industrial que la empresa Lasing S.A. puede comercializar. 
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CHAPTER 1 

1. Introduction 

1.1. Motivation 

Optical lithography is a widely used printing process in the manufacturing of photonic and 

semiconductor devices. This process can be: 

• conventional, using masks to transfer patterns onto a photosensitive material, or 

• maskless, employing direct laser writing (DLW) techniques with ultra-violet lasers. 

However, these techniques have limitations in terms of resolution and in the creation of three-

dimensional (3D) structures. Conventional techniques are generally limited to two-dimensional 

(2D) structures in a single fabrication process on one layer of material. The creation of 3D 

structures requires multiple fabrication steps across several layers, which poses a significant 

challenge. 

Two-photon polymerization (2PP) is an advanced maskless technique capable of manufacturing 

3D micro and nanostructures with dimensional precision and complex geometries, achieving 

resolutions down to just a few nanometers. 

In 2PP, the excitation of molecules, commonly photo-initiators within photoresists, is induced 

by two-photon absorption (2PA). This is a nonlinear and highly improbable phenomenon, 

meaning that the probability of simultaneous absorption of two or more photons is proportional 

to the square of the incident light intensity and therefore it is typically confined to a region 

around the focal point. As a result, 2PP only occurs in the volume where the photon density 

exceeds an intensity threshold, enabling the creation of 3D polymeric structures with arbitrary 

geometries and sub-diffraction features. This allows for the fabrication of free-form micro-

devices by moving the focal point of an ultrafast pulsed laser within the photoresists. 

Currently, there are various innovative 2PP systems, both custom-built and commercial, for 

manufacturing. Some of these systems aim to overcome the diffraction limit (based on optical 

microscopy principles) [1], others to optimize fabrication methods (such as layer-by-layer or 

true 3D) [2], [3], and others to increase production throughput [4]. However, all 2PP 

manufacturing methods are fully functional for the creation of micro-devices. Moreover, a wide 

variety of photoresists can be used in 2PP systems to fabricate microstructures for 
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multidisciplinary applications, including photonic engineering, electronics, medicine, and 

biology. 

This PhD thesis focuses on the development of a 2PP system for creating polymeric structures 

using commercial photoresists. This fully functional 2PP system, designed as a commercial 

prototype for the company Lasing S.A., will have the capability to manufacture photonic 

devices of interest for research and development areas of CEMDATIC at UPM and the local 

market. 

Intellectual Property and Commercialization 

In the first phase of development, the prototype is not subject to intellectual property protection 

(IPR) by the research directors or the executives of Lasing S.A., as it follows the open hardware 

philosophy. However, for the second phase, Lasing S.A. will discuss the implementation of 

legal protection measures for the commercial product. 

1.2. Objective of this thesis 

The main objective of this PhD thesis is to design and fabricate a customized system for the 

manufacturing of 2D and 3D micro- and nanostructures using the 2PP technique. This 2PP 

system is configured to integrate components that include a femtosecond laser, optical 

elements, precision mechanical positioning mechanisms, and electronic hardware control 

components, which enable the system's setup, calibration, and programming. This 

programming facilitates both basic and complex micro-fabrication and optimization processes. 

The fully functional 2PP system is designed to polymerize commercial photoresists, and it aims 

to optimize the DLW parameters for micro-fabrication. Additionally, the system is 

characterized by having fully customizable hardware, which allows for extending the 

functionalities of optical lithography. 

Finally, the manufacturing of 2D and 3D devices is proposed, achieving the high resolution, 

such as patterns on polymer surfaces for liquid crystal (LC) alignment and micro-scaffolds with 

complex fabrication features. Therefore, this proposed 2PP system is an accessible fabrication 

prototype that only requires optimal conditions in clean room, free of contaminants or particles 

and controlled illumination that could interfere with the DLW process on the photoresists. 

1.3. Structure of this thesis 

This PhD thesis is structured in several parts. 

In Chapter 2, a brief introduction to the lithography technologies used in micro-fabrication is 

presented, along with a comparison to state-of-the-art 2PP lithography. Additionally, basic 

concepts and some photon absorption mechanisms are explained, followed by the processes 
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involved in photopolymerization. Finally, several photoresists commonly used in 2PP are 

presented, and a broad range of applications developed through 2PP is listed. 

In Chapter 3, a comprehensive overview of the principles of DLW in polymerization is 

provided, with a focus on advanced 2PP-DLW techniques designed to enhance resolution. It 

also includes a brief discussion of various focusing configurations employed in DLW. 

In Chapter 4, the design and fabrication of the 2PP system are described, based on the proposal 

of an appropriate setup for micro-fabrication, considering hardware and optical design criteria. 

The chapter also includes details on the final assembly of the custom system. In addition, a 

setup for one-photon polymerization (1PP) is added for the optimization process. 

In Chapter 5, the commissioning of the 2PP system is described, followed by its optimization 

for both 1PP-DLW and 2PP-DLW. Additionally, the chapter covers the characterization of 

voxels (lateral and axial sizes) in commercial negative-tone and positive-tone photoresists. 

In Chapter 6, the results of micrometric 2D fabrication for functional devices are presented, 

specifically focusing on the surface alignment of polymers to create complex patterns in LC 

polarizers. 

In Chapter 7, the results of micrometric 3D fabrication are presented. The chapter showcases 

microstructures created in 2.5D (layer-by-layer printing) and true 3D. Additionally, the 

successful fabrication of complex micro-scaffolds with the typical resolution achieved is 

discussed. 

Finally, conclusions and potential future work are presented in Chapter 8. 
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CHAPTER 2 

2. Two-photon polymerization 
Two-photon polymerization (2PP) is an advanced micro/nanofabrication technique known for 

its capacity to produce highly intricate two-dimensional (2D) and three-dimensional (3D) 

structures with exceptional spatial resolution. This method has garnered significant attention 

across various fields due to its ability to create complex architectures that are challenging to 

achieve with conventional techniques, which often offer limited control over microstructural 

design. 

To fabricate precisely tailored 3D micro/nanostructures using 2PP, it is essential to 

comprehensively understand photon absorption mechanisms, photopolymerization processes, 

and involved materials. Additionally, 2PP addresses critical limitations and challenges related 

to material selection and manufacturing processes. Recent advancements have provided 

valuable insights into future 2PP applications, incorporating a wide range of compatible 

material composites. Overall, this state-of-the-art review aims to provide a foundational 

understanding of the 2PP technique as a lithography technology, highlighting its role in 

producing high-precision functional micro/nanostructures for a broad range of applications. 

This chapter begins with a brief overview of the state of the art in available technologies for 

microstructure manufacturing, followed by an exploration of the fundamental photon 

absorption mechanisms involved in photopolymerization. It then introduces the photosensitive 

materials used in 2PP. Additionally, the chapter examines a range of applications, including 

photonic devices, micromachining, surface patterning, microfluidics, and medical and 

biological uses. 

2.1. State of the art 

Nowadays, polymerization by commercial laser rapid prototyping machines is an indispensable 

part of industrial processing for high-resolution structures [5]. Ultrafast pulsed laser for 

fabrication is a widely used technology to induce the 2PP technique [6], [7]. Photosensitive 

materials (e.g. positive-tone and negative-tone photoresists) are commonly curable by ultra-

violet (UV) lasers for any 2D microstructures [8]. However, with 2PP the materials are not 

polymerized by UV radiation, but by absorption of photons at longer wavelengths, usually in 

the near-infrared (N-IR) spectrum, generating submicrometer 3D structures [9], [10]. 
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The 2PP technique effectively processes photosensitive materials with high resolution [11] and 

offers significant advantages over conventional fabrication techniques, such as template-guided 

electrodeposition [12] or mask-mediated photolithography for nanostructures [13]. For 

example, the laser power penetrates deeply into the processed materials, inducing 

polymerization in a region confined to the focal spot. Additionally, the nonlinear dependence 

of the polymerization rate on light intensity enables true 3D spatial resolution [5], [14]. These 

capabilities allow for the successful production of various photonic and micromechanical 

devices [9], [15], [16] and extend the technique’s applications to biological and biomedical 

fields [17], [18], [19]. 

2.1.1. Additive manufacturing technologies 

Currently, 2PP lithography, also known as 2PP direct laser writing (2PP-DLW), is a versatile 

prototyping technique for fabricating 2D and 3D micro/nanostructures. Unlike traditional layer-

by-layer lithography or 2.5D techniques, which build structures in a layered or partially three-

dimensional manner, 2PP enables the creation of complex 3D features with high precision. The 

capability to accurately control and maneuver the laser focal spot in any direction within the 

material is a key advantage, surpassing the limitations of other additive manufacturing (AM) 

technologies [20], [21]. Although AM technologies —encompassing various materials such as 

ceramics, acrylates, hydrogels, and metals— are widely used, they often present constraints in 

producing highly intricate micro/nanostructures. Therefore, a comparison of AM technologies 

with 2PP, as summarized in Table 2.1, underscores the distinct advantages and sophistication 

of the 2PP technique [22]. 
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Table 2.1: Summary of relevant additive manufacturing (AM) technologies. 

AM Technology 
Manufacturing 

process 

Printing 

Resolution 
Typical materials Advantage Disadvantage Ref. 

2PP-DLW 
2.5D, 

3D 
25–100 nm 

Acrylates, epoxides, 

ceramics, hydrogels 
Very high resolution 

Low build speed, limited 

materials 

[23], 

[24] 

Micro 

stereolithography 

(M-SLA) 

2.5D 1–10 µm Acrylates, epoxides High resolution 
Low build speed, limited 

mechanical properties 
[25] 

Digital Light 

Processing (DLP) 
2.5D 10−50 µm Acrylates, epoxides Low oxygen effect 

Low vertical resolution, 

Limited mechanical properties 

[21], 

[25] 

Continuous Liquid 

Interface 

Production (CLIP) 

2.5D 75 µm Acrylates High build speed Low-viscosity material required [21] 

Selective laser 

sintering (SLS) 
2.5D 80 µm 

Polyamide powder, 

Polymers 

Very high build speed, better 

mechanical properties 

Limited materials, rough 

surfaces, powdery surface 

[21], 

[26] 

Inkjet and Aerosol 

Jet printing 
2.5D 

10 µm, 

100 µm 

Conductive inks and 

dielectrics 

High resolution, very high build 

speed 
low viscosity ink required [25] 

Laminated object 

manufacturing 

(LOM) 

2.5D 200−300 µm Polymers, paper 
Good Chemical resistance and 

strength 

Limited materials, low 

resolution 
[21] 

Direct ink writing 

(DIW) 
2.5D 200 µm 

Polymers, metals, 

ceramics, hydrogels 

Broad range of materials, high 

build speed 

Speed and temperature affect 

process 
[20] 

Direct laser 

deposition (DLD) 

2.5D, 

3D 
25−500 µm 

Metals, polymers, 

ceramics 
Material waste reduced 

Very high laser power, low 

build speed, rough surfaces 
[27] 
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2.1.2. 2PP micro-fabrication systems available 

2PP experimental systems implemented in the research labs consist of a number of custom-

made setups built for specific needs. Each setup gathers specific features such as the laser 

source, optical components, motion control system, printing mode, and custom photosensitive 

materials, all operating under cleanroom conditions [2], [28], [29], [30], [31]. In contrast, 

commercial systems are designed to meet fundamental requirements for nano-, micro-, and 

mesoscale fabrication. These commercial systems offer a more generalized set of features and 

capabilities intended for a broad range of applications, focusing on reliability and ease of use. 

Powerful micro-fabrication systems are flexible, precise, versatile, fast, and user-friendly. 

Many of them implement sophisticated techniques to enhance printing capabilities required for 

both scientific and industrial (R&D) applications [32], [33], [34]. Nevertheless, the state-of-

the-art commercial systems listed in Table 2.2 represent the most relevant systems for micro-

fabrication using the 2PP technique. 

Table 2.2: Comparison of commercial systems for micro-fabrication based on 2PP. 

2PP system 

(manufacturer) 

Resolution 

[nm] 

Build volume 

[mm³] 

Max. scan 

speed [m/s] 

Manufacturing 

process 

Roughness 

[nm] 
Ref. 

Photonic 

Professional GT2 

(Nanoscribe 

GmbH) 

160 100×100×8 0.1–0.625 Layer-by-layer ≤ 20 [32] 

MPO 100 

(Heidelberg 

Instruments) 

100 100×100×10 1–10 Layer-by-layer ≤ 10 [33] 

NanoOne 

(UpNano GmbH) 
100 100×120×49* Up to 1.2 Layer-by-layer ≤ 10 [34] 

MicroFAB-3D 

(Microlight3D) 
< 200 100×75×20 10-4–10-3 Layer-by-layer ≥ 20 [35] 

PROME-Uni 

(Moji-nano 

Technology) 

70 300×300×70* Up to 80 3D* ≤ 10 [36] 

Laser Nanofactory 

(Femtika) 
150 160×160×60* Up to 0.03 3D ≤ 20 [37] 

* The accessible printing volume is determined by the XYZ travel specified in the system's datasheet or 

manufacturer's reports. 

 

The combination of ultrafast pulsed lasers and XYZ motion systems leads to increased process 

efficiency, higher quality, and more effective machining of very small features compared to 

conventional laser processing or other AM technologies [4].  

The vast majority of AM technologies employ multiple-axis linear translational stages to 

perform object geometry on the photoresist material. Galvanometer-based optical scanners 
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(galvos) are frequently used for fast scan up to 10 m/s [33], or 80 m/s [36]. Galvos are electro-

mechanical systems composed of mirrors installed on motors without mechanical inertia in an 

orthogonal configuration. This can be quickly rotated around their axes, allowing the beam to 

be scanned in two dimensions. 

Galvos offers high precision and short latency times in the order of a few hundred 

microseconds, enabling fast mirror scanning in the kHz frequency domain with excellent 

angular resolution. However, they are limited by the field of view (FOV) of the objective lens. 

While this limitation can be addressed by stitching to create larger structures, it introduces 

potential alignment errors during the process of joining substructures created in smaller areas. 

Stitching requires the use of a linear translating stage to move the sample on the XY-plane [33], 

as well as along the Z-axis. 

Linear translating stages have the advantage of not being constrained by the objective's FOV, 

as they enable movement of the sample along all three axes, with a travel range that can exceed 

tens of millimeters on each direction. However, they are limited in scanning speed, typically up 

to 1 mm/s [35], which impacts overall scanning time. Additionally, these stages tend to be 

bulkier and heavier, with limited acceleration capabilities. 

The commercial systems presented in Table 2.2 employ both galvos and linear translational 

stages. The first set consists of fast stages with a large travel range for quicker coarse 

positioning of the sample, while the second set employs slower and more precise stages [32], 

[33], [34], [35]. Additionally, the scanning times and printing resolution (adjustable voxel) can 

be controlled by speed and laser exposure time to create 3D microstructures [4], [37]. These 

factors, along with the resulting surface roughness (typically less than 20 nm), should be 

carefully considered for systems intended for research labs and industrial applications [2]. 

2.2. Photon absorption mechanisms 

The mechanisms of light-matter interaction can vary depending on the applied light intensity, 

the exposure time, the incident light wavelength, the light polarization, and the properties of the 

material. For instance, these interactions can lead to effects such as heating, melting, 

vaporization, gas formation (e.g., within metals), and, notably, induce polymerization (e.g., 

within polymers) [38]. 

Polymerization is a phenomenon driven by photoexcitation that leads to the cross-linking of 

monomers or oligomers in the excited state of the material [39], i.e., through the absorption of 

photons. The number of photons absorbed by the photosensitive molecules in the material can 

vary, ranging from single to multiple photons. The extent of photon absorption influences the 

manifestation of various linear and nonlinear optical phenomena [40], [41], [42]. These 
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phenomena are classified based on the material's response to the external electric field, which 

characterizes its linear or nonlinear optical polarization [38], [43]. 

In the following subsections, various photon absorption mechanisms that may be used to induce 

the polymerization of photosensitive materials are described. These mechanisms are presented 

in simplified terms, excluding detailed processes involving singlet or triplet states, to facilitate 

a better understanding of the fundamental concepts and terminology. 

2.2.1. One-photon absorption 

One-photon absorption (1PA), also called single photon absorption (SPA) is the common 

mechanism of light-matter interaction and is a linear quantum mechanical process, where an 

electron of an atom or molecule modifies its energy level upon absorption of one photon. 

In conventional optical absorption, an electron absorbs the energy of an incident photon. The 

atom or molecule is driven from the ground state |𝑆0⟩ to a higher electronic level, defined as 

excited state |𝑆1⟩ [44], as depicted in Figure 2.1. The energy of the absorbed photon must be 

equal to or greater than the energy gap between |𝑆1⟩ and |𝑆0⟩ to induce an absorption event, as 

defined in Equation (2.1). After reaching the excited state, the system eventually returns to the 

ground state (the minimum energy configuration) by emitting either phonons (non-radiative 

decay) or photons (luminescence). 

 𝐸S0 →S1  ≥  𝐸𝑆1 − 𝐸𝑆0  =  ℎ𝜈𝑝ℎ (2.1) 

 

 

Figure 2.1: Schematic illustration of one-photon absorption (1PA). The violet upward 

arrow indicates the excitation process due to photon absorption, while the green downward 

arrow represents the return to the ground state |𝑆0⟩ via radiative or non-radiative pathways. 

The incremental decrease of the intensity light propagation through an absorptive medium (e.g. 

in the z direction), is proportional to the intensity itself: 

 
𝑑𝐼(𝑧)

𝑑𝑧
 = – 𝛼𝐼(𝑧) (2.2) 
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where 𝐼 is the light intensity, 𝑧 is the propagation distance, and 𝛼 is the absorption coefficient 

of the material independent of the light intensity [40], [41], [45] when the saturation intensity 

is not reached. That means that 1PA is a linear optical process. From Equation (2.2), the 

intensity attenuation can be expressed by Lambert–Beer’s law [40], [45]: 

 𝐼 (𝑧) =  𝐼(0)𝑒–𝛼𝑧 (2.3) 

The probability of absorption is proportional to the initial light intensity 𝐼(0), being higher near 

the surface of the material and decreasing as the light penetrates deeper. Consequently, the light 

intensity exponentially decreases along the propagation through the material as defined in 

Equation (2.3). 

 𝑇 =
𝐼(𝑧 = 𝑙)

𝐼(0)
= 𝑒–𝛼𝑙 (2.4) 

The transmission defined in the Equation (2.4) depends on the absorption properties of the 

material but is not directly proportional to the initial intensity 𝐼(0). The absorption probability 

in the material is influenced by the incident light intensity, but the relationship is more complex 

and not simply direct and proportional [40]. 

2.2.2. Multi-photon absorption 

Multi-photon absorption (MPA) is a non-linear quantum mechanical process where the 

transition is driven by a few photons acting collectively [46]. MPA proceeds through one or 

more virtual states, allowing electron transitions to states that cannot be reached by 1PA [47]. 

To induce MPA, all photons must be present at the same time and place. The probability of the 

absorption event scales with the light intensity raised to the power of the number of photons 

needed (𝑛-photon absorption ∝ 𝑛𝑡ℎ power of the photon flux density), typically two, known as 

two-photon absorption (2PA), but in some cases three-photon absorption (3PA) or more. 

 

Figure 2.2: Schematic illustration of two-photon absorption (2PA) with a virtual energy 

state. a) degenerate, and b) non-degenerate 2PA. The red upward arrows indicate the 

excitation absorption, while green downward arrow indicates the relaxation back to the 

ground state |𝑆0⟩ through radiative (fluorescence) or non-radiative pathways. 
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2PA is a well-known mechanism and was first theorized by Maria Goeppert Mayer in 1931 

[48], experimentally observed by Kaiser and Garrett in 1961 [49], and subsequently 

implemented by Pao in 1965 [50]. 

2PA is a simultaneous absorption process with quantum mechanical three-states process, where 

an electron of an atom or molecule absorbs two photons simultaneously to transcend the energy 

gap in one excitation event [5]. The electronic transition from ground state to excited state 

(|𝑆0⟩
∆ℎ𝑣
→  |𝑆1⟩), the material is transparent to photons wavelength (i.e., the optical frequency 𝜈 

of the photons is out of resonance of electrons in the material). When the first photon is 

absorbed, a non-stationary virtual state |𝑖⟩ is created, that has an extremely short lifetime, 

persisting for only several femtoseconds [24], in accordance with Heisenberg’s uncertainty 

principle. 2PA occurs only if a second photon is absorbed within the lifetime of the virtual state 

before it decays. Afterwards, the system returns to the ground state either by relaxation (non-

radiative decay) or by emitting fluorescence. Therefore, the energy gap is given by Equation 

(2.1), but the energy gap is twice the energy of either of the photons absorbed (degenerate case 

in Figure 2.2-a), or the sum of each different energy photon absorbed (non-degenerate case in 

Figure 2.2-b) [51]. 

Degenerate 2PA: 𝐸S0 →S1 = 2 ℎ𝜈𝑝ℎ1,2 
(2.5) 

Non-degenerate 2PA: 𝐸S0 →S1 = ℎ𝜈𝑝ℎ1 + ℎ𝜈𝑝ℎ2 

The light intensity passing through a UV-absorptive optical medium does not follow the linear 

behavior described by Equation (2.2) or Equation (2.3) if the intensity of the incident light is 

high enough. The attenuation coefficient 𝛼 is not constant and varies depending on the incident 

light due to an absorption saturation effect [41]. Therefore, the attenuation of intense light 

tightly focused on the material is higher, and Equation (2.2) must be redefined as: 

 
𝑑𝐼(𝑧)

𝑑𝑧
 =  −𝛼𝐼 (𝑧) − 𝛽𝐼2(𝑧) (2.6) 

where 𝛽 is the 2PA coefficient. In some cases, where 3PA or more processes are considered, 

Equation (2.6) should be generalized to be the following form: 

 
𝑑𝐼(𝑧)

𝑑𝑧
 = – 𝛼𝐼(𝑧) − 𝛽𝐼2(𝑧) − 𝛾𝐼3(𝑧) − · · · (2.7) 

where 𝛾 is 3PA coefficient, and so on.  

From Equation (2.6), the intensity attenuation can be expressed by the following expression 

[52], [53]: 

 𝐼 (𝑧) =  𝐼(0)
(1 − 𝑅)2𝑒−𝛼𝑧

1 +
𝛽
𝛼 𝐼
(0) ⋅ (1 − 𝑅)(1 − 𝑒−𝛼𝑧)

 (2.8) 
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where 𝑅 is the reflectivity of the material. 

The probability of exciting atoms or molecules is much higher at the focal spot of the light 

compared to any other region of the light beam. In other words, out-of-focus regions have a 

minimal effect on the attenuation of the light beam [6], because of high transmittance along of 

the material. This is due to the squared intensity of the incident light beam within the material, 

which is inversely proportional to the square of the focused area, 𝐴2(𝑧), of any transverse 

section, and directly proportional to the number of molecules within the focused volume pixel, 

represented as 𝐴2(𝑧) × 𝑑𝑧, which is referred as a voxel in 2PP. 

Thus, the coherent interaction of intense light with matter, as described by Equations (2.6) or 

(2.7), induces nonlinear phenomena that can be explained using advanced methods of nonlinear 

optics. MPA can reveal information about transitions that are not accessible through 1PA 

process. Initially, MPA was applied as a spectroscopic tool to identify energy states that are not 

connected to the ground state through 1PA [19], [24], [47]. 

2.2.3. Excited-state absorption 

Excited-state absorption (ESA) is another nonlinear quantum mechanical process that is 

considered a type of MPA mechanism. ESA involves a stepwise process of MPA characterized 

by the presence of a real intermediate energy state with relatively long lifetime [54]. Stepwise 

2PA with three-states systems is introduced to explain ESA as depicted in Figure 2.3. 

 

Figure 2.3: Schematic illustration of excited-state absorption (ESA) with an actual energy 

state. The diagram describes the case of degenerate 2PA to illustrate ESA. The red and blue 

upward arrows indicate the excitation absorption, while green downward arrow indicates 

the relaxation back to the ground state |𝑆0⟩ through radiative (fluorescence) or non-

radiative pathways. 

ESA involves the sequential absorption of photons by an atom or molecule, where the excited 

state |𝑆1⟩ is further pumped to a higher energy state |𝑆2⟩ by absorbing another photon with the 

same energy ℎ𝜈𝑝ℎ1 = ℎ𝜈𝑝ℎ2. For example, if the lifetime of the excited state |𝑆1⟩ is relatively 

long compared to the duration of the incident light (i.e., very short excitation exposure time), a 
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second photon can be directly absorbed (|𝑆1⟩ ⟶ |𝑆2⟩). Afterwards, the atom or molecule 

returns to the ground state |𝑆0⟩ by non-radiative decay or luminescence. [55]: 

 𝐸S0 →S2 = 𝐸S0 →S1 + 𝐸S1 →S2 (2.9) 

The difference between ESA and simultaneous 2PA lies in the coherence of the incident light. 

ESA typically involves two light sources, which may have the same or different wavelengths, 

with pulse durations on the order of picoseconds to nanoseconds. ESA can satisfy MPA when 

the system has already absorbed one or more photons and, from that excited state |𝑆1⟩, continues 

to absorb additional photons to reach even higher energy states [41], [47]. This phenomenon is 

fundamental in certain nonlinear optical processes, such as laser light generation and advanced 

spectroscopy. 

ESA may be considered as two sequential 1PAs and can be combined with simultaneous 2PA 

to improve the optical power limitation behavior of photosensitive materials with joint 

optimization of the efficiency and spectral overlap of the two processes [51], [56]. 

2.2.4. Cooperative absorption and luminescence 

Cooperative absorption (CA) and cooperative luminescence (CL) in photon absorption are 

nonlinear optical effects that arise from the interaction between species in a material. In these 

processes, which are depicted in Figure 2.4, the interaction involves two types of species, A 

and B. These effects are strongly dependent on the concentration of the species and the relative 

distance between them, often requiring high concentrations to observe significant interactions 

[43]. 

 

 

Figure 2.4: Cooperative mechanisms of MPA, cooperative absorption (CA) in (a) and 

cooperative luminescence (CL) in (b). The red upward arrows indicate the excitation 

absorption, while green downward arrows indicate the radiative pathways. 

In CA of Figure 2.4-a, the absorption process of species A and B (|𝑆0⟩ ⟶ |𝑆1⟩) occurs when 

there is cooperative absorption of one photon or simultaneous absorption by two relatively 

separated atoms or molecules within the species. Subsequently, a photon of the same energy is 
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observed by species A and B separately, leading to a higher excitation state (|𝑆1⟩ ⟶ |𝑆2⟩). After 

completing the absorption of the second photon, each species emits photons with higher energy 

than the absorbed photons [57], [58]. 

In CL of Figure 2.4-b, the absorption process of species A and B (|𝑆0⟩ ⟶ |𝑆1⟩) occurs when 

photons are absorbed separately. Cooperation occurs during the emission process, where the 

energy of the emitted photons is approximately double that of the excitation photons, resulting 

in luminescence. Moreover, cooperative emission can also occur when the absorbed photons 

produce luminescence in real non-excited states that coincide with the transition to the ground 

state [59]. 

2.3. Polymerization induced by 2PA 

The 2PP process is a versatile technique based on 2PA that uses laser radiation to convert 

unsaturated molecules in the liquid state to solid macromolecules through light-induced 

polymerization reactions in the UV, visible, and N-IR spectral ranges [5], [60]. 

Most of the available photosensitive materials, commonly known as photoresists, are designed 

to be polymerized using UV light sources. These materials have a higher absorption probability, 

typically in the 315-400 nm, and are transparent in the N-IR. 

The non-linear effect of the intensity concentration from an ultrafast pulsed N-IR laser 

(approximately 𝜆 = 800 nm and 𝜏 = 100 fs) on liquid photoresists can initiate polymerization 

within the voxel, where the photon flux density is sufficiently high [24], [61]. 2PA effectively 

halves the wavelength of the incident light (ℎ𝜈𝑝ℎ = 𝐸𝑆0 →𝑆1/2), as described in Equation (2.5). 

This results in polymerization occurring within the focal region of the laser in the UV spectral 

range of the photoresist [62], [63]. 

The key components of the photoresist used for 2PP are monomers mixed with photo-initiators 

or photosensitizers that are normally sensitive to the UV light and produce a free radical once 

excited by 2PA [6]. The concentration of the monomers and photo-initiators varies according 

to the manufacturers or researchers to develop an effective photoresist that performs 2PP 

efficiently [51], [64], [65], [66], [67]. 

The polymerization process consists of three steps:  

(i) photo-initiation (Equations (2.10), (2.11), and (2.12)), 

(ii) chain propagation (Equation (2.13)), and 

(iii) termination (Equation (2.14)). 

In polymeric materials, photo-initiation is the most important step, as it involves the production 

of active species that attack the monomers. In this step, the photo-initiators absorb two photons, 
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creating a pair of free photo-produced radicals, with a highly chemically reactive unpaired 

valence electron: 

 𝑃𝐼 + 2ℎ𝜈𝑝ℎ → 𝑃𝐼
∗ → 2𝑅𝐼

• (2.10) 

where 𝑃𝐼 is photo-initiator, 𝑅𝐼
• is photo-produced radical with unpaired electron (free radical) 

and 𝑃𝐼∗ is an intermediate state of the photo-initiator after absorbing photons energy. In the 

case of the photosensitizers, one molecule absorbs two photons and then transfers the energy to 

an active photo-initiator [5], [68]. The photo-initiation process is expressed as: 

 𝑆 + 2ℎ𝜈𝑝ℎ → 𝑆
∗…𝑃𝐼 → 𝑃𝐼∗ → 2𝑅𝐼

• (2.11) 

where 𝑆 is the photosensitizer.  

When using additive substances, such as co-initiators, they can work in combination with 

photo-initiators to enhance the formation of free radicals (or ionic polymerization). A co-

initiator by itself does not absorb light, but is involved in the production of radicals species 

generated by photo-initiators [5]. Co-initiators can improve the polymerization rate or the 

efficiency of the photo-initiator by assisting in the generation of radicals necessary for 

polymerization [69]. 

The second reaction of initiation is the addition of the photo-produced radical to the first 

monomer producing the chain-initiating radical: 

 𝑅𝐼
• +𝑀 → 𝑅𝑀• (2.12) 

where 𝑀 is monomer and 𝑅𝑀• is monomer-radical with unpair electron. 

In the second step, chain propagation consists of the successive additions of monomer-radical 

to new monomer producing the reaction that propagates through the photoresist: 

 
𝑅𝑀• +𝑀 → 𝑅𝑀2

•…
𝑅𝑀𝑛

• +𝑀 → 𝑅𝑀𝑛+1
•  (2.13) 

In the third step, termination occurs when two photo-produced radicals bond to each other, 

cross-linking the monomers to form a long polymer chain (𝑅𝑀𝑛,𝑚), with 𝑛 and 𝑚 monomers, 

or due to monomer depletion caused by the action of inhibitors [4], [6]: 

 

𝑅𝑀𝑛
• + 𝑅𝑀𝑚

• → 𝑅𝑀𝑛+𝑚𝑅 

or 

𝑅𝑀𝑛
• + 𝑅𝑀𝑚

• → 𝑅𝑀𝑛 + 𝑅𝑀𝑚 

(2.14) 

To improve the quantum yield of polymerization photo-initiation, one or more low-weight 

molecules that are more sensitive to light irradiation are added. These molecules form radical 

or cationic initiator species upon absorbing photons [5]. 
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2.4. Materials for 2PP processing 

Photoresists are widely used in photopolymerization processes with conventional technologies, 

generally being photosensitive to UV light. These technologies include M-SLA, DLP, CLIP, 

and specifically 2PP-DLW. A summary of these techniques is provided in Table 2.1. 

Several photoresists require a specific energy dose to expose the targeted area for 

polymerization [63], depending on the efficiency of the chemical compounds involved in the 

photo-initiation, propagation, and termination reactions. Adjusting the energy dosage can 

therefore achieve effective polymerization. Additionally, UV or visible light absorbers, which 

do not necessarily participate in photo-initiation, but can improve resolution [70]. Another 

important criterion is the layer thickness before exposure. The limits of deposition techniques, 

such as spin-coating, depend on both the method used and the properties of the photoresist. In 

this context, the viscosity and wetting behavior of the photoresist on the solidified part are 

critically important. Consequently, both negative-tone and positive-tone photoresist materials 

with varying characteristics are widely developed and used, including solvent-free options, to 

optimize the efficiency of polymerization processing. These developments advance the state of 

the art in 2PP applications using the most suitable photoresist, with its features summarized in 

Table 2.3. 

2.4.1. Negative-tone vs positive-tone photoresists 

Negative-tone and positive-tone photoresists refer to the performance of the material during the 

photopolymerization process: in negative-tone photoresists, the areas exposed to light undergo 

cross-linking the monomers that then form polymer chains, making the cross-linked regions 

less soluble to the developer/solvents and remaining a cured micro/nanostructure on a substrate 

after development. In contrast, in positive-tone photoresists, the material is first solidified by 

heat and then exposed to light. The exposed areas experience bond breaking in the polymer 

chains due to molecular degradation, generating shorter units that become more soluble. These 

regions are removed during development, resulting in an inverse pattern of the exposed areas. 

• SU-8 is an epoxy-based negative-tone photoresist, initially developed by IBM and currently 

commercialized by Kayaku Advanced Materials [71]. This is the most used photoresist for 

the fabrication of photonic devices and metamaterials with high resolution using optical 

lithography in the blue–UV spectral region [72]. SU-8 is thermally stable, transparent in the 

visible spectral region, and leaves behind a well-defined 3D microstructure once it is 

exposed to the light with high resistance to developing solutions while the unexposed portion 

is easily removed by solvents [73]. SU-8 is presented in various formulations to improve 

mechanical properties, resolution, aspect-ratio, adhesion to subtracts, curing speed, 

microstructures quality and viscosity (SU-8 100, 2000, 3000, 4000 and 6000 series). It is 
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also modified by researches & developers for specific developed applications [70], [74], 

[75], [76], [77]. 

• SCR-500 is an acrylate-based negative-tone photoresist developed by JSR Corporation [78], 

and is widely used in 2PP processes. This photoresist is sensitive to the UV spectral range 

and is employed to enhance resolution in nanostructure manufacturing for photonics and 

microelectronics applications [23], [79]. 

• EpoCore & EpoClad are epoxy-based, negative-tone photoresists from the chemically 

amplified series developed by Micro Resist Technology [80]. These photoresists are highly 

transparent in the visible spectral range, sensitive in the UV range, and exhibit high thermal 

stability. They are designed for pattern transfer processes in lithography, offering excellent 

mechanical stability. Currently, they are available in different viscosity for microelectronic 

applications, such as waveguides used in spectroscopy [81], [82], [83]. 

• ma-N is a novolak-based negative-tone photoresists developed by Micro Resist Technology 

[80]. This photoresist is sensitive to the UV spectrum and is used to enhance resolution and 

adhesion during nanostructure manufacturing, while also offering thermal stability [84]. 

Currently, it is available in ma-N 400, 1400 and 2400. 

• mr-DWL is a chemically amplified, epoxy-based negative-tone photoresist developed by 

Micro Resist Technology [80]. This photoresist is highly transparent in the visible spectral 

range, thermally stable, sensitive to the UV range (especially around 400 nm), and offers 

high resistance and suitability for 2PP-DLW in optical and microelectronic applications [83], 

[85]. Currently, it is available in mr-DWL 5, 40, and 100. 

• AZ-Photoresists are chemically amplified, acrylate-based photoresists, available in both 

positive-tone and negative-tone formulations (the latter using cross-linkers), developed by 

MicroChemicals GmbH [86]. These photoresists offer improved uniformity, mechanical 

stability, and thermal stability, with high resolution and aspect ratio suitable for lithography 

and optical and microelectronic applications [87], [88]. 

• S1800 G2 series are novolak-based positive-tone photoresist commercialized by Kayaku 

Advanced Materials [71]. This series is designed for photolithography applications, 

providing high resolution, thermal stability, and uniform coating. This photoresist is suitable 

for optoelectronic and microelectronic applications, offering excellent pattern transfer 

performance [89]. 

2.4.2. Solvent-free photoresists 

• IP-Photoresists are acrylic and methacrylic-based negative-tone photoresists, developed by 

Nanoscribe specially for 2PP [32]. These photoresists are designed for use in immersion 
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printing technologies, such as dip-in laser lithography and oil immersion techniques [90]. 

They are optimized for high-resolution micro-fabrication across various applications [91], 

especially bio-applications [18]. IP-Photoresists exhibit high resolution and strong 

mechanical stability for 3D micro/nanostructures. They come in various formulations, 

including IP-S, IP-L, IP-Q, IP-G, and IP-dip, tailored to different applications and 

microstructure manufacturing needs. Advantages of IP-Photoresists include low shrinkage, 

high aspect ratios, and smooth surface finishes with excellent shape accuracy. Additionally, 

new variants like IP-Visio offer low fluorescence and non-cytotoxicity, making them 

suitable for bio-applications [92]. For integrated photonic applications, the IP-n162 variant 

features a high refractive index [93]. 

• OrmoComp is an inorganic-organic hybrid negative-tone photoresist developed by Micro 

Resist Technology [80]. This is especially compatible to 2PP-DWL processes for (nano)-

imprint sensible to UV spectral range with high exposure dosage. OrmoComp is thermally 

stable, high resolution and non-oxygen sensibility. Finally, it is designed for micro-optics, 

microfluidics, coupling connection applications, and bio-applications [94], [95]. 

• Other solvent-free photoresists, such as organically modified ceramics (ORMOCER), 

include OrmoClear, OrmoStamp, OrmoCore, and OrmoClad. These materials can be used 

in 2PP-DLW [39], [96]. However, they require high exposure energy in the UV spectral 

range and are highly transparent to near-UV and visible light. As a result, they may need 

higher photon flux to effectively induce 2PA. 

2.4.3. Other photosensitive polymers 

• Polymers that can be used for 2PP are those that require prior preparation to be exposed to 

light to induce 2PA, such as pentaerythritol triacrylate (PETA), polyethylene glycol (PEG), 

and polyethylene glycol diacrylate (PEGDA) precursor solutions [11], [97]. Their 

characteristics are summarized in Table 2.3. 

• Other photoresists that may be used are thiol-acrylic-based, which have favorable properties 

for inducing 2PA [98]. Monomers like trimethylolpropane triacrylate (TMPTA), 

polyethylene glycol (PEG), and bisphenol a epoxy acrylate (BAEA) are also effectively 

polymerized by combining appropriate photo-initiators to develop high-performance 

photoresists for 3D microstructure fabrication [66], [97], [99]. Additionally, incorporating 

solvents into the photoresist formulation can further enhance the efficiency of 2PP [100]. 
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Table 2.3: Photoresists available for 2PP. 

Photoresist Tone Photo-initiator Monomer Solvent Developer 

SU-8 Negative 
Triaryl sulfonium 

hexafluoroantimonate 

Eight epoxy functional 

groups 

Gamma-butyrolactone 

(GBL) or 

cyclopentanone 

Propylene glycol 

methyl ether acetate 

(PGMEA) and 

mr-Dev 600 

IP-

Photoresist 
Negative 

Triaryl sulfonium 

hexafluoroantimonate mixed with 

Rhodamine B for TPA. 

2-(hydroxymethyl)-2-[[(1- 

oxoallyl)oxy]methyl]-1,3- 

propanediyl diacrylate (for 

IPDip) 

Solvent-free 
PGMEA and 

mr-Dev 600 

SCR-500 Negative 

2,7-dibromo-9,9-diethylhexyl-9H-

fluorene, diphenyl(4-vinylphenyl) 

amine photosensitizer 

Urethane acrylate-based 

oligomer 
Chloroform Ethanol 

ma-N Negative Aromatic bisazide Novolak-based Safe solvents 
aqueous-alkaline 

development 

EpoCore & 

EpoClad 
Negative Camphorquinone Epoxy-based oligomers Cyclopentanone mr-Dev 600 

mr-DWL Negative 
bis(p-tolyl)iodonium 

hexafluorophosphate 
Epoxy-based 

GBL, propylene 

carbonate 
mr-Dev 600 
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Photoresist Tone Photo-initiator Monomer Solvent Developer 

AZ-

Photoresist 

Positive 

and 

Negative 

diazo-naphthoquinone (DNQ) for 

positive-tone. 

Melamine cross-linker for negative-

tone 

Acrylic-based monomers 
Acetone, Isopropoanol, 

or Ethanol 

Metal Ion Free (MIF) 

and Inorganic 

developers 

S1800 Series Positive Diazo photoactive compound mixed cresol novolak-based 

Ethylene glycol derived 

ether. 

Methoxy-1-propanol 

acetate 

MIF, Metal- 

Ion-Bearing (MIB), 

Microposit developer 

OrmoComp Negative 

Diphenyl (2,4,6-trimethyl-benzoyl) 

phosphine oxide; ,3,5- 

trisIJ2-(9-ethylcabazyl-3) ethylene) 

benzene 

Inorganic-organic hybrid 

polymer 
Solvent-free OrmoDev 

PETA Negative 
Irgacure 369 or 819 (Silane 

crosslinker) 
Pentaerythritol triacrylate 

Acetone, Isopropanol, 

or Ethanol 
Methyl isobutyl keton 

PEG Negative 
2-Hydroxy-2-methyl-1-phenyl-

propan-1-one 

Polyethylene glycol (PEG 258) 

and PEG diacrylate (PEG 700) 
TE buffer 

Ethanol solution 

containing 0.05% 

Tween 20 

PEGDA Negative 

2-hydroxy-40-(2-hydroxyethoxy)-2-

methylpriophenone and 

Irgacure photo-initiators 

Polyethylene glycol diacrylate 

precursor solution 
Methanol mr-Dev 600 
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2.5. 2PP applications 

Applications are being developed using various tailored photoresists with optical, electrical, 

mechanical and chemical properties to create 2D and 3D micro/nanostructures for functional 

devices. For instance, materials optimized for mechanical and optical properties are used for 

signal conduction in optoelectronics and surface patterning for liquid crystal (LC) alignment in 

displays [101]. Some applications of 2PP are outlined below. 

2.5.1. Photonics devices 

2PP enables the creation of intricate micro/nanostructures beyond the diffraction limit, 

supporting rapid prototyping. Its high resolution, material versatility, and true 3D capabilities 

offer disruptive solutions for miniaturized photonic devices, advancing optical designs beyond 

traditional methods [102]. 

Micro-lenses are manufactured using 2PP with various strategies to achieve specific optical 

properties while ensuring mechanical stability and shape reproducibility [103], [104]. 2PP 

allows the creation of intricate submicrometric structures beyond the diffraction limit, enabling 

rapid prototyping and alignment-free 3D designs. Its high resolution, material versatility, and 

true 3D capabilities offer disruptive solutions for miniaturized photonic devices with advanced 

optical designs [105], [106]. These include axicon lenses [107], convergent lenses [9], meta-

lenses [108], among others [102]. 

Periodic structures, such as woodpiles or micro-pillar arrays, are valuable for optically active 

microstructures, including photonic crystals, waveguides, micro-resonators and metamaterials 

[15], [109], [110], [111]. Additionally, 2PP has enabled innovative strategies for fabricating 

micro-optical elements in vortex beam generators [112], [113], as well as for the compact 

optical integration of dynamic and geometric phase elements [114]. 

2PP has been explored for fabricating optical fibers for holograms. This includes creating 

multifocal diffractive optical components on fiber end facets [115], and ring-shaped phase 

masks on fiber tips for improved projection and beam shaping [116]. 

Integrated optics has other potential applications [117]. For example, the fabrication of single-

channel photonic links using 3D waveguides [118] and the hybrid integration of light sources 

with photonic circuits [119], [120] (see Figure 2.5). 
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Figure 2.5: Fiber-to-chip interface using photonic wire bonds (PWB) to connect the 

individual cores of a multi-core fiber to different on-chip silicon-on-insulator (SOI) 

waveguides [121]. Line trace strategies in 2PP processes (left) and PWB in negative-tone 

photoresists (right). 

Attractive photonic devices for controlling and manipulating the propagation of light were 

created using 2PP [122]. For instance, crystals with 3D dielectric structure that generate a 

photonic bandgap which blocks certain frequencies of electromagnetic waves [123], [124]. 2PP 

has been used to develop advanced 3D photonic devices, including chiral photonic crystals that 

exhibit properties such as circular dichroism and differential transmittance [125]. 

2.5.2. Micromachines and microelectromechanical systems 

Micro- and nanomachines consist of 3D, movable micro-components produced by 2PP, which 

float freely in a photoresist due to its high viscosity [63].  

To manipulate a micromachine, photoresists are typically doped with magnetic particles to 

magnetically driven micro-turbine or micro-springs [126], [127] (see Figure 2.6-a). 

The interaction between laser light and optical micromachines allows for precise adjustments 

of their movements and behaviors at the micrometer scale. Laser beams influence both the 

rotational symmetry of the micromachines and the torque they exert [128]. 

A useful application of optically driven micromachines is the creation of lobular rotors within 

a microchannel. These rotors can function as micropumps to control the flow rate of fluids in 

microfluidic devices [129] (see Figure 2.6-b). 

Advances in sensors, actuators, and communication systems at the micrometric scale are crucial 

for microelectromechanical systems (MEMS) [130]. Electrode patterns enhance MEMS 

functionality and enable complex applications [131]. Moreover, electrodes and microchannels 

are essential in microfluidic applications within MEMS, including fluid analysis and precise 

fluid handling for lab-on-a-chip systems [132]. 



Byron Oswaldo Ganazhapa Jiménez 

24 

 

 

Figure 2.6: Micromachine models developed in 2PP. a) Model of a micro-turbine with 

circumgyration cycle in remote control [127]. b) Model of a lobed micropump with 

optically driven movements [129]. 

2.5.3. Surface patterning, alignment, and grating 

Recent investigations have applied 2PP to surface patterning for the fabrication of devices that 

manipulate light in novel ways. For instance, aligning polymeric surfaces to control LC 

molecules is a common application [133]. Several strategies have been explored, including 

single polymerized layers [93], multiple layers [134] (see Figure 2.7), and rewriting LC patterns 

[135]. Chapter 6 is dedicated to surface patterning and alignment techniques for generating 

arbitrarily patterned polarizers in two polymeric photoresists. 

 

Figure 2.7: Multi-layer structure in liquid crystal (LC) alignment using 2PP [134]. Design 

with N number of LC layers (left) and a three-layer LC cell (right). A multi-layer LC spatial 

light modulator enables significant phase changes while maintaining fast response times. 

Grating structures, in combination with 2PP, significantly accelerate the reproduction of 

microstructures. For instance, holographic diffraction gratings are used to generate interference 
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patterns that precisely control the polymerization process in photoresists [62]. Additionally, 

spatial light modulators can divide the laser beam to enable simultaneous fabrication of multiple 

microstructures [136]. The use of diffractive optical elements further enhances the efficiency 

in manufacturing complex structures through parallel processing [137]. 

2.5.4. Micro-fluidics 

Microfluidic systems are widely used in chemistry, biology, medicine, environmental science, 

and materials science. These systems, part of MEMS, can integrate functional 3D 

microstructures made with negative-tone photoresists and 3D microfluidic structures from 

positive-tone photoresists. 

Sensors based on negative-tone photoresists, integrated into microchannels to measure liquid 

flow rates, were developed via 2PP for optoelectronic systems [138]. Methods for controlling 

flow rates were developed, including microstructures designed to manage liquid transport in 

microchannels [139], and filtering systems for particle separation using micro-sieves fabricated 

in existing micro-devices [140] (see Figure 2.8). 

Before mentioning the bio-applications, functional micro-components embedded in 

microfluidic devices can be fabricated using 2PP, employing a mixture of proteins and photo-

initiators [141]. 

 

Figure 2.8: Embellishment of a microfluidic system by 2PP [140]. Schematic illustration 

for fabrication in SU-8, covering the device with a PDMS slab (left). Microsieve pores of 

different sizes to sort particles (center). Control of the microfluidics (right). If the particle 

size is smaller than the pores, it will pass through the sieve; otherwise, it will be blocked. 

2.5.5. Medical and biological applications 

Medical and biological applications on 2PP are also extensively developed with biocompatible 

photoresists from tissue engineering, cell engineering and biological MEMS [18], [142], [143]. 

One of the microdevices developed through 2PP related to microfluidics are microneedles 

designed for the transdermal delivery of protein and nucleic acid-based pharmacological agents 

[144]. Microdevices aimed at treating neurodegenerative diseases, focusing on cell survival and 

integration, have also been developed [145] (see Figure 2.9). Additionally, micro-actuators 

inspired by human flexible joints are created with multiple deformation modalities for 
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applications in soft robots, wearable devices, and similar technologies [146]. Functional 

microdevices featuring microvalves implanted into the human body are presented to prevent 

the reversal of blood flow in veins [147]. 

 

Figure 2.9: Induced pluripotent stem cell-derived retinal progenitor cells in juxtaposed 

micro-scaffolds [145]. a) Microstructure for cell loading. b)-c) Ordered and consistently 

sized vertical pores. d) Micro-scaffolds loaded with human retinal progenitor cells. e) Cell 

movement and survival in micro-scaffold pores. 

 

Figure 2.10: Models of human tissues using 2PP [143]. Vascular network, heart, and 

muscle fiber bundles in (a), and their printed models in (b). Orbicularis, longus, multifidus, 

and pinna muscles in (c), and their printed models in (d). The functional tissues are 

stimulated by applying electrical signals. 

2PP opens new strategies in biomedical applications for creating artificial organ and tissue 

substrates [148]. For instance, it enables the printing of both the internal and external shapes of 
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functional muscle tissues, which can be activated through electrical stimulation using hydrogels 

[143] (see Figure 2.10). 

Finally, micro-scaffolding using 2PP has been extensively applied in various biological and 

medical sectors. Micro-scaffolds are artificial structures designed for studying cell migration, 

tissue growth and development [15], [149], [150], [151], [152] (see Figure 2.9). Successful 

micro-scaffolds, as detailed in Chapter 7, involve optimization of microstructures and have the 

potential of enhancing the analysis of bio-applications. 
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CHAPTER 3 

3. Direct laser writing  
The two-photon polymerization (2PP) technique has found applications in micro-optics, 

microelectronics, microelectromechanical systems (MEMS), microfluidics, biology, and 

medicine due to its resolution capabilities beyond the diffraction limit. However, achieving high 

precision in fabrication processes, such as micro-optics and photonic crystals, requires dealing 

with dimensional accuracy, shape, and surface finish in micro/nanostructures to eliminate 

inaccuracies that can significantly impact device performance or even render them unusable. 

To produce precise two- and three-dimensional (2D, 3D) micro/nanostructures, it is essential 

to systematically and comprehensively assess the factors affecting the accuracy of the direct 

laser writing (DLW) process. This chapter reviews the principles of DWL in polymerization, 

covering advanced 2PP-DLW methods for enhancing resolution. Additionally, the chapter 

briefly discusses focusing configurations. 

3.1. DLW method in photopolymerization, 1PP vs 2PP 

DLW is an optical lithography technique widely used in the fabrication of polymer structures. 

DLW is typically based on one-photon absorption (1PA) to trigger a photochemical reaction in 

a UV-sensitive photoresist [8], [13], [153], a process known as one-photon polymerization 

(1PP), sometimes referenced as OPP [154]. In a maskless process, 1PP-DLW utilizes a focused 

laser spot moving across the photoresist surface, typically to create 2D microstructures. This 

method is commonly implemented using continuous-wave (CW) lasers at blue-UV 

wavelengths focused through high numerical aperture (NA) objective lenses (OL) [154], [155]. 

However, a significant limitation of 1PP is that light absorption occurs primarily near the 

surface of the photoresist, restricting the fabrication of true 3D microstructures throughout the 

entire layer thickness [45]. As the light penetrates deeper into the material, the absorption 

probability decreases, especially in photoresists with a high concentration of photo-initiators 

(high optical density), leading to reduced polymerization efficiency in deeper layers [1]. For 

photoresists with a lower concentration of photo-initiators, 3D microstructures might be 

achieved (low optical density); however, this can result in lower resolution due to the formation 

of a conical exposure region where polymerization occurs both above and below the focal plane, 

leading to overexposure and reduced precision. 
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Figure 3.1: Illustration of absorption probability behavior for 1PA and 2PA when focusing 

a Gaussian beam from above into a photoresist volume. (a) Strongly absorbing photoresist 

attenuating the incoming beam through 1PA. (b) Weakly absorbing photoresist allows the 

beam to penetrate the photoresist and be absorbed at all z-positions via 1PA. (c) Highly 

absorbing photoresist in the laser spot where absorption occurs through 2PA. 

In contrast, 2PP-DLW is a non-linear process that enables the fabrication of high-resolution 3D 

microstructures within a photoresist volume [156]. In 2PP-based direct laser writing (2PP-

DLW), the nonlinear mechanism of two-photon absorption (2PA) predominates [157], allowing 

polymerization to occur exclusively within a confined volume pixel, known as a voxel. This 

voxel is generated by tightly focusing an ultrafast pulsed laser—typically a femtosecond 

(femto) laser—operating in the near-infrared (NIR) range [99], [158]. The key advantage of 

2PP is that the probability of absorption is proportional to the square of the light intensity, which 

localizes the polymerization strictly within the focal region [53]. In this process, the N-IR 

wavelength used is typically longer (approximately double) than the wavelength used in a 1PP-

DLW process (i.e., 𝜆𝑁‑𝐼𝑅 ≈ 2𝜆𝑈𝑉), enabling 2PA by the photo-initiator molecules. This non-

linearity prevents undesired exposure and polymerization outside the voxel, enabling precise 

control over the fabrication of complex 3D structures. Moreover, the N-IR wavelengths used in 

2PP are out of resonance with the vibrational modes of the material, making the photoresist 

transparent and allowing deeper light penetration without significant loss of energy [19]. Figure 

3.1 shows and comparison of the absorption probability of 1PP vs 2PP. 

In 2PP, the ultrafast pulsed laser delivers a high concentration of photons within an extremely 

short time window [159], significantly increasing the probability that two photons will be 

absorbed simultaneously by a photo-initiator molecule. This requirement for both temporal and 

spatial overlap makes 2PP inherently more selective than 1PP, enabling high-resolution micro-

fabrication with minimal exposure beyond the focal point. Thus, the polymerized region of 2PP 

is smaller than that of 1PP [2]. Figure 3.2 shows the intensity distribution of 1PP vs 2PP. 

Moreover, the polymerization threshold in 2PP can be precisely tuned by adjusting parameters 

such as laser power, pulse duration, repetition rate, and exposure time, offering extensive 

control over the properties of the resulting microstructure. 
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Figure 3.2: Light intensity distribution in the laser focus of a Gaussian beam for 1PP and 

2PP processes. Polymerization occurs in regions where the intensity exceeds the threshold. 

Table 3.1: Comparison of properties for 1PP-DLW versus 2PP-DLW method. 

Properties 1PP-DLW 2PP-DLW Ref. 

Photon absorption 

mechanism 
1PA 2PA 

[41], 

[44] 

Light propagation 
𝑑𝐼(𝑧)

𝑑𝑧
 = –𝛼𝐼(𝑧)  

𝑑𝐼(𝑧)

𝑑𝑧
 =  −𝛼𝐼(𝑧) − 𝛽𝐼2(𝑧)  [41] 

Transmitted light 

intensity 
𝐼(𝑧) = 𝐼(0)𝑒–𝛼𝑧  𝐼(𝑧) = 𝐼(0)

(1−𝑅)2𝑒−𝛼𝑧

1+
𝛽

𝛼
𝐼(0)⋅(1−𝑅)(1−𝑒−𝛼𝑧)

  [41] 

Transmittance of the 

photoresist (𝑇), with 

thickness 𝑙 

𝐼(𝑧=𝑙)

𝐼(0)
= 𝑒–𝛼𝑙  

𝐼(𝑧=𝑙)

𝐼(0)
=

(1−𝑅)2𝑒−𝛼𝑙

1+
𝛽

𝛼
𝐼(0)⋅(1−𝑅)(1−𝑒−𝛼𝑙)

  [45], 

[157] 

Absorption probability 

(𝑝) 
𝑝 ∝ 𝐼  𝑝 ∝ 𝐼2  

[1], 

[157] 

Polymerization 

Threshold (𝐷) 
𝐷 = 𝐼 ⋅ 𝑡  𝐷 = 𝐼2 ⋅ 𝑡  [1] 

Polymerization 

Efficiency 

Decreases with depth, 

particularly in photoresists with 

high optical density. 

Efficient polymerization strictly 

within the voxel. 
[1] 

 

To successfully obtain microstructures in both 1PP-DLW and 2PP-DLW, sufficient cross-

linking of monomers is necessary to form stable polymer chains. However, achieving effective 

polymerization in 2PP is more complex than in 1PP due to the intricate interaction between 

laser parameters and material properties [38]. In 1PP, polymerization occurs when the exposure 

dose surpasses a certain threshold, leading to widespread polymerization in exposed areas. In 

contrast, 2PP requires higher light intensity to achieve the necessary photon flux density for 

effective 2PA. Despite the added complexity, the 2PP-DLW process is generally preferred for 

applications requiring precise 3D microstructures, as it offers superior resolution and accuracy 

compared to 1PP-DLW processes [1]. 

Finally, while 1PP-DLW is effective for fabricating 2D structures or basic 3D designs with 

limited depth control [160], 2PP-DLW excels in creating intricate 3D microstructures with high 
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spatial resolution due to its nonlinear optical effects. The choice between 1PP and 2PP depends 

on application requirements, the desired structural complexity, resolution and the specific 

properties of the photoresist material [161]. Table 3.1 provides a comparative overview of the 

key characteristics of 1PP-DLW and 2PP-DLW methods. 

3.2. Advanced 2PP-DLW methods for improving resolution 

Resolution is the most important parameter in 2PP-DLW for micro/nanostructures, surpassing 

Abbe’s diffraction limit [162] of the material [163], [164], as expressed in Equation (3.1). 

Several methods and techniques are developed to reduce polymeric nanostructure sizes, i.e., 

lateral and axial of the voxel, from prepolymer preparation (such as adding effective photo-

initiators [165] and radical quenchers [166]), to depletion mechanisms [2], [158], [167]. 

 𝑑 =
𝜆

2𝑁𝐴
 (3.1) 

In standard 2PP-DLW, a laser excites the photo-initiators via 2PA. Then, they undergo 

relaxation, i.e., vibronic relaxation, and internal conversion (IC), while remaining in the lower 

excited singlet state |𝑆1⟩ [168]. Afterward, a significant number of these photo-initiators 

undergo intersystem crossing (ISC) from the lower singlet state |𝑆1⟩ to a reactive pathway and 

long-lived triplet state |𝑇1⟩. Triplet relaxation also occurs without IC coupling [168]. From the 

lowest |𝑇1⟩ state, free radicals are generated via cleavage or charge transfer to other molecules, 

which then propagate polymerization by adding monomers until the chains are terminated or 

the monomer is depleted. Once the polymer is sufficiently cross-linked, it becomes irreversible 

and insoluble. This process is explained in Chapter 2. Therefore, processes that reduce this 

chain propagation can contribute to improved resolution. 

Next, the main depletion microscopy to be applied to lithography is presented. 

3.2.1. STED-DLW 

The development of stimulated emission depletion (STED) microscopy is one of the most 

widely used technologies for reducing feature size in combination with 2PP-DLW to break the 

diffraction limit [169], as defined in Equation (3.1), achieving resolutions higher than 10 nm 

[170]. 
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Figure 3.3: Schematic illustration of the molecular electronic states and transitions in 

STED-DLW [1]. After the photo-initiators (𝑃𝐼) undergo intersystem crossing (ISC) from 

|𝑆1⟩ to |𝑇1⟩ and relaxation (Rel.), polymerization is initiated by the generation of radicals 

(𝑅𝐼
•) from the lower |𝑇1⟩ of the 𝑃𝐼. These generated radicals then react with monomers to 

form monomer-radicals (𝑅𝑀•), which are crucial for the formation of long polymer chains. 

In STED-DLW, a femto laser is used to excite the photo-initiators to a higher singlet state |𝑆1⟩ 

via 2PA (population of the photo-initiators by the excitation pulse). Subsequently, a second 

laser (depletion laser) induces stimulated emission (SE) of the excited photo-initiators before 

they can transition to the reactive triplet state |𝑇1⟩ via ISC, partially inhibiting polymerization. 

This SE process returns the photo-initiators to their ground state |𝑆0⟩, preventing the generation 

of free radicals outside the central excitation region. Figure 3.3 illustrates the principle of 

STED-DLW. 

The depletion efficiency depends on the intensity of the depletion laser (commonly CW laser 

at 532 nm of wavelength [171] or nanosecond pulsed laser [172]) and the competition among 

the different deactivation channels from the lower excited singlet state |𝑆1⟩ (depopulation of 

the photo-initiator’s excited state) [168], including fluorescence, ISC, and non-radiative decay. 

By carefully adjusting the depletion laser’s power, it is possible to significantly reduce the 

polymerization volume, enabling precise control over the voxel geometry. 

This combination of 2PP-DLW with STED enables the fabrication of microstructures with 

much finer details than those achievable by conventional DLW. It allows for printing speeds in 

the m/s range but requires very high depletion laser power [167]. Additionally, photoresists 

under SE eject energy from the system through photons, rather than relying on heat to complete 

polymerization. 

3.2.2. RAPID lithography 

Resolution augmentation through photo-induced deactivation (RAPID) also allows for 

surpassing the diffraction limit of conventional lithography [173]. Initially, RAPID was 

designed to support STED by incorporating special cationic dyes as photo-initiators [174]. A 



Byron Oswaldo Ganazhapa Jiménez 

34 

 

common example is malachite green carbinol base (MGCB), which has a high extinction 

coefficient and absorbs at 620 nm, with an additional shoulder around 430 nm. 2PA of 

femtosecond pulses can excite MGCB to a higher singlet state |𝑆1⟩, followed by non-radiative 

relaxation to a lower singlet state, with expected fluorescence emission around 700 nm (not 

shown in Figure 3.4) [167]. 

 

Figure 3.4: Schematic illustration of the molecular electronic states and transitions in 

RAPID lithography [1]. Upon CW laser exposure, the long-lived intermediate state |𝐼⟩ is 

deactivated. This deactivation can result in non-radiative decay or the formation of non-

initiating products, which ultimately reduces the extent of cross-linking in the polymer. 

RAPID lithography can be implemented using two lasers at the same wavelength: an ultrafast 

pulsed laser (200 fs) for excitation and a CW laser for deactivation. Figure 3.4 illustrates the 

principle of RAPID lithography. Although MGCB was initially expected to support STED, no 

luminescence has been detected. However, it was observed that depletion laser activation can 

effectively inhibit polymerization in MGCB-based photoresists [167]. This effect is attributed 

to the depletion of a long-lived intermediate state |𝐼⟩, enabling the use of a CW laser without 

requiring precise synchronization. The exact nature of this intermediate state remains 

undetermined, but it may involve weakly reactive radical pairs [173] or solvated electrons [174] 

that can recombine with the parent molecules through a photoinduced electron back-transfer. 

The drawback of using MGCB is that it absorbs light across the 400-700 nm range, covering 

the entire visible spectrum. Other photo-initiators, such as malachite green carbinol 

hydrochloride (MGC-HCl), have also been used [174]. This photo-initiator is particularly 

sensitive, showing a depletion effect even with femtosecond pulses, but it becomes independent 

of printing speed and does not contribute to the effective resolution of the polymer when speed 

increases. 

3.2.3. 2PII lithography 

Two-color photo-initiation/inhibition (2PII) lithography is not based on the direct deactivation 

of an excited intermediate state of the photo-initiator but instead utilizes two independent and 
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opposing high-efficiency processes [175]. The photo-initiation process generates free radicals 

via 1PA driven by a CW laser, e.g., blue light (photo-initiation laser), while the photo-inhibition 

process is activated via 1PA using a second CW laser, e.g., UV light (photo-inhibition laser), 

in a Gauss-Laguerre “donut” mode [176], generating inhibiting species (weakly reactive 

radicals). These radical quenchers can efficiently scavenge free radicals and terminate the chain 

propagation process. 2PII allows for a reduction in the formation of insoluble cross-linked 

polymer chains. Figure 3.5 illustrates the principle of 2PII lithography. 

  

Figure 3.5: Schematic illustration of the molecular electronic states and transitions in 2PII 

lithography [1]. Deactivation is carried out by combining radical quenchers (𝑄•) with free 

radicals (𝑅•) that scavenge the initiation process, and with chain-initiating radical (𝑅𝑀•) 
that terminate the propagation process. 

Photo-initiators and photo-inhibitors must be activated separately by different wavelengths that 

do not cause interference, which requires preparing a specific photoresist to apply 2PII 

lithography. The photo-initiators, camphorquinone and ethyl 4-(dimethylamino)benzoate, and 

the photo-inhibitors, tetraethylthiuram disulfide, are combined with triethylene glycol 

dimethacrylate monomers to obtain a functional photoresist [176]. 

The advantage of 2PII lithography is that it confines effective excitation and also reduces 

excitation blurring caused by radical diffusion, which is particularly useful in low-viscosity 

photoresists [167]. However, a challenge in 2PII is the difficulty in fabricating complex 3D 

structures. When focusing deeper into the photoresist volume, beams from the photo-initiation 

laser and the photo-inhibition laser attenuate as they pass through the material, as they rely on 

the principle of 1PA, making the required laser powers highly depth-dependent. Additionally, 

this can lead to excessive consumption of the photo-initiator or photo-inhibitor and continuous 

heating of the photoresist throughout the entire cone of the focused laser beams [167]. 

3.2.4. Other depletion methods based on excited-state absorption 

Depletion mechanisms based on excited-state absorption (ESA) can be alternative methods to 

improve resolution [30]. Photo-initiators are excited via 2PA, and ESA occurs directly from the 

lowest excited state |𝑆1⟩ or from the triplet state |𝑇1⟩. After light absorption, the system may 
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relax non-radiatively from highly excited states of |𝑆2⟩ or |𝑇2⟩ back to the ground state |𝑆0⟩. 

Additionally, free radicals generated from |𝑇1⟩ can absorb depletion light and contribute to the 

reduction of cross-linked polymers [177]. This method is referred to as ESA + non-radiative 

decay [167] and is illustrated in Figure 3.6-a. 

 

Figure 3.6: Schematic illustration of the molecular electronic states and transitions in ESA 

lithography [1]. (a) ESA + non-radiative decay. (b) ESA + Resist heating. 

Another mechanism involves multiple excitations and rapid non-radiative relaxations to the 

same excited state, applying heat and leading to dominant thermal effects that enhance 

resolution (|𝑆1⟩
heat
→  |𝑆2⟩) or (|𝑇1⟩

heat
→  |𝑇2⟩). In other words, the efficiency decreases as the 2PA 

cross-section of a molecule can significantly drop with increasing temperature, which also 

decreases the quantum yield due to non-radiative decay in the lowest excited state |𝑆1⟩ [178]. 

This method is referred to as ESA + resist heating [167] and is illustrated in Figure 3.6-b. 

These thermal mechanisms require less laser power but limit writing speed, due to the long 

lifetime of triplet states |𝑇1⟩ (~msec). In comparison, SE extracts energy from the system, which 

could make STED superior [167]. 

3.3. Challenges on 2PP-DLW 

Submicron-scale 2PP-DLW printing is highly versatile, particularly for the precise 

functionalization of surfaces, but its slow printing speed limits its broader adoption in research 

and industry. The high resolution it offers is akin to the precision of sketching with a fine-tip 

pencil. Techniques have been developed to enhance the precision and accuracy of 

microstructures, such as shape pre-compensation, multipath scanning method, 2D slicing 

method, and improving surface roughness [2]. Printing time is influenced by voxel size, 

structure shape, and the limited field of view of high NA objective lens [179]. 

Recently, methods to accelerate manufacturing have been proposed [4], such as parallel 

fabrication with multiple foci generated by microlenses, diffractive optical elements (DOE) 
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[28], spatial light modulators (SLM) [31], [180], and digital micromirror devices (DMD) [181]. 

DMDs enable precise control of multiple foci, accelerating printing without compromising 

resolution. Additionally, when combined with high-power lasers, they facilitate the rapid 

printing of 3D structures without losing detail. 

3.4. 2PP focusing configuration 

2PP-DLW is carried out using custom and commercial systems, according to the optical design, 

photoresist properties, and light spread in the materials to reach higher resolution [32], [33], 

[182], [183]. Next, three main focusing configurations available to make micro/nanostructures 

are described. 

 

Figure 3.7: Comparison between air configuration (a), oil immersion (b), and dip-in laser 

(c). In illustrations (a) and (c), the refractive index of the substrate is irrelevant. However, 

if focusing is done directly on the substrate in the air configuration, the effects of the 

substrate’s refractive index must be considered. 

3.4.1. Air configuration 

Air configuration is also referred to as free-immersion. The light from a laser source can be 

focused directly on the photoresist on any opaque or transparent substrate, or through the glass 

substrate. The focusing accuracy depends on the vertical position of the laser spot in the 

photoresist. The maximum structure height is defined by the working distance (WD) of the 

objective lens (OL) and the refractive indices of the materials. Figure 3.7-a illustrates a 

perspective of focusing using two propagation materials. The structures are limited by 

photoresist thickness if the laser is focused directly on the photoresist. 

A disadvantage of this configuration is that an elongated voxel results from Snell’s law when 

passing from one medium to another with a high refractive index (𝑛𝑎𝑖𝑟 < 𝑛𝑝ℎ𝑟) at the 
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wavelength of the excitation light at a specific angle of incidence by the OL, and also, the 

changes in refractive indices can affect the position and accuracy of beam focusing. 

3.4.2. Oil immersion 

The laser is focused on the sample through a transparent substrate. In this configuration, only 

transparent substrates can be used, and the effect of the refractive index is negligible. Between 

the OL and the substrate, immersion oil is employed, which has a refractive index similar to 

that of the OL glass and the substrate (𝑛𝑂𝐿 ≈ 𝑛𝑜𝑖𝑙 ≈ 𝑛𝑠𝑢𝑏𝑠). This minimizes light scattering and 

reduces optical aberrations, allowing for an optimal focus at the substrate-resist interface. In 

addition, the refractive index of the photoresist should match that of the surrounding materials 

to avoid distortions and loss of resolution. 

However, as the laser is focused deeper into the photoresist, spherical aberrations increase due 

to the light passing through different materials. These aberrations affect the focus quality, which 

can lead to reduced precision in the fabricated structures. Figure 3.7-b shows a schematic of 

this configuration. Therefore, the height limitations of the structures are determined by the WD 

of the OL and the substrate thickness. 

3.4.3. Dip-in laser 

In this configuration, the OL is directly immersed in the photoresist. Spherical aberrations are 

minimal and consistent throughout the thickness of the photoresist. Additionally, the heights of 

the structures are limited by the photoresist support. Figure 3.7-c shows the Dip-in laser. 

The refractive indices of the OL and the photoresist are approximately matched (𝑛𝑂𝐿 ≈ 𝑛𝑝ℎ𝑟). 

The issue with this configuration is that if other photoresists are used, they may damage the 

optical system of the OL or result in poor quality of the fabricated structures. 
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CHAPTER 4 

4. Design and fabrication of a 2PP system 
Two-photon polymerization direct laser writing (2PP-DLW) micro-fabrication can be 

performed using three different strategies: 

(i) moving the samples across a fixed laser beam,  

(ii) moving the laser beam within a fixed sample, or  

(iii) moving both the sample and the laser beam sequentially.  

In the first case, the sample is moved in three orthogonal directions with the help of three linear 

translational stages along the X, Y, and Z axes. In the second case, an optical scanner is used 

to rotate a set of mirrors to sweep the laser beam over an XY-plane, and a Z lineal translation 

stage is used to move the laser beam vertically. The third case is a hybrid combination of the 

previous two cases, allowing the system to have better printing features in terms printing area 

with high speed, and better resolution and precision. 

In this section, a custom fabrication system gathering features of a hybrid system is described. 

It allows sequential movement in the XYZ dimensions using linear translational stages and 

galvanometric scanners, while considering the requirements and components necessary for the 

optical design and setup. This leads to the launch of the fully functional 2PP system for 3D 

micro/nanostructures. Additionally, an extension for one-photon polymerization direct laser 

writing (1PP-DLW) has been added for the simple calibration and optimization of the 2PP 

system without considering fine focusing on the photoresists for polymerization. A low-cost 

violet laser was incorporated to minimize optical path errors and improve positioning accuracy. 

4.1. System requirements 

The 2PP system combines control and synchronization features of XYZ nano-positioning 

stages, minimizing positioning errors at high speeds and synchronizing movements with the 

laser beam (shutter modulation and power light during the laser writing process). 

The galvanometer-based optical scanners (galvos) are better suited for nanometric positioning 

in an XY-plane for fabrication of micro/nano-structures with complex geometry at extremely 

high scanning speeds (up to 3 m/s in Newson galvos [184]). Galvos are electro-mechanical 

systems composed of mirrors installed in an orthogonal configuration, on motors with very low 
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mechanical inertia, allowing swift rotation about their axes. This allows the beam to be scanned 

in two dimensions. 

Galvos are very precise, with short latency times (few hundred microseconds). Fast scanning 

of mirrors in the kHz frequency domain with good angular resolution is therefore allowed. 

However, their field of view (FOV) is limited when a magnifying lens is used, significantly 

reducing and constraining its operation to small structures confined within of FOV. This is not 

an issue when manufacturing of larger structures, but stitching is required; however, it induces 

structural errors during the process of combination substructures made in smaller areas. 

Stitching forces the systems to use linear translational stages (linear stages) to move the sample 

in the XY-plane [33], and also along of the Z-axis to achieve real 3D fabrication [4]. 

Linear stages have the advantage of not being limited by the objective's FOV. They move the 

sample along all three axes, with a travel range that can exceed hundreds of millimeters in each 

direction. However, their printing speed is limited to up to 50 mm/s under conditioned load and 

power supply in Tecnotion linear motor [185]. As a result, linear stages tend to be significantly 

larger and heavier compared to galvos, which reduces acceleration. This results in a non-

uniform displacement speed along the stage travel range, that implies some time is required to 

reach the printing speed, thereby adding extra printing time. Consequently, affecting the 

accuracy in nanometric positioning (>100 nm). 

Nano-positioning forces the system to use piezoelectric transducer (piezo) to move the samples 

with high accuracy along the X, Y, and Z axes. It is advantageous for fine positioning with 

nanometric precision and resolution less than 1 nm. 

Piezo is an actuator that uses the inverse piezoelectric effect to generate mechanical 

displacement of the piezoelectric material (usually quartz) when an electric field is applied. 

This displacement can be precisely controlled by the applied electric signal. When an electric 

voltage is applied, it causes the internal dipoles of the material to align, resulting in a physical 

expansion or contraction of the material, and producing linear movements directly proportional 

to the electric voltage. 

Piezo has very high precision and resolution (0.3 nm), with high resonance frequency for 

movements of high dynamic response around of the kHz, over a travel range of a few hundreds 

of micrometers in Newport piezos [186]. However, it has limited load capacity due to 

deformation of the piezoelectric material, which reduces the resonance frequency under heavier 

loads, increases the rise time for applied signals, and consequently reduces the printing speed. 

This affect the performance and printing times, but it is not an issue when it is used just to move 

smaller loads for smaller trajectories, i.e. move a set of lenses along the Z-axis at up to 100µm/s. 

Finally, all movements must be thoroughly synchronized with the laser beam. The laser is 

dependent of the printing times and speed, e.g. turn on/off and power light modulation. Ultrafast 
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pulsed laser beam can be manipulated by an acousto-optic modulator (AOM) or a half-wave 

plate (HWP). 

The AOM has the advantage of diffracting the incoming light into several orders without 

turning on/off delays, with the majority of the laser beam intensity being diffracted into the 1st 

order. It utilizes the acousto-optic effect to diffract light in different directions (nth orders) by 

using sound waves created inside a material (like quartz or glass) attached to a piezoelectric 

material that vibrates in response to applied pure sinusoidal electrical signals. The main issue 

is that the rest of the light intensity is distributed in all diffraction orders, resulting in a waste 

of light of the laser beam source and reducing the diffraction efficiency in the best conditions 

up to 99 % in the 1st order in Gooch & Housego AOMs [187]. However, this is not an issue 

when the exposure of the laser beam is higher than the threshold intensity of the photoresists to 

be polymerized, as the printing speed and laser beam power can be adjusted accordingly. 

HWPs can be used to adjust and control the polarization state of the laser beam. It is based on 

birefringent materials (such as quartz or calcite) that introduce a phase difference of 𝜋 radians 

between two orthogonal components of linearly polarized light [188]. It can function as a 

continuously adjustable polarization rotator, but it requires the use of a rotary stage to precisely 

adjust the rotation. When coupled with a rotary stage, the HWP is particularly useful with a 

polarizer for attenuating the intensity of laser light [189], [190], which is often necessary for 

photoresists requiring varying levels of power for 2PP-DLW processes. 

4.2. System components 

The performance of the system is fundamentally characterized by: 

(i) the capacity to control and synchronize combined movements of the motion stages 

(linear stages, rotary stage, galvos, and piezo), 

(ii) the capacity to control and synchronize the motion stages along with the laser beam 

(shutter and power attenuation) for printing processes, and 

(iii) the capacity to configure and program recipes to execute printing processes in any 

photoresists. 
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Figure 4.1: Block diagram of the electronic 2PP system. 

Considering these points, the proposed control architecture is shown in Figure 4.1. The system 

provides processing pseudo-algorithms (settings and recipes) for polymerizing photoresists by 

custom software (user program) installed on the PC. These pseudo-algorithms are translated 

into interactions stored in the motion controller, which provides laser processing functionality. 

The interactions are algorithms executed in the buffers of the motion controller simultaneously, 

translating processing parameters and geometric objects (control and processing properties) 

into combined and synchronized movements of the stages, laser power control, modulations, 

and switching of the motion stages at execution rates of 20 kHz and synchronization times of 

0.1 µs. In addition, a software package translates part of the galvo interactions executed in the 

galvo controller, providing synchronization to the deflectors (joint synchronization with the 

laser beam and the XY linear stages) at control rates of 100 kHz and up to 40 MHz laser 

activation. This allows for the execution of high dynamic parts. In addition, the galvo controller 

executes interactions that provide synchronization to the deflectors at control rates of 100kHz 

and up to 40 MHz laser activation. 

The movements of the motion stages are fed back to their respective controllers in closed-loop 

operation mode, to provide precise positioning control with nanometric resolution. The piezo 

controller is connected to analog signal conditioning hardware, which in turn is connected to 

the motion drivers to calibrate and control the piezo movements through interactions executed 

in the motion controller. The synchronization of the linear stages and the piezo with respect to 

the galvos is ensured via the high-speed digital communication protocol (EtherCAT) to 

minimize potential desynchronization errors and movement delays. 
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The motion drivers and galvo controller manage the power modulation of the laser beam 

(shutter signal by galvos or linear stages) via two selective digital signals. For example, if the 

processing properties of the geometric objects are configured to be printed with the galvos, the 

galvo modulation signal is activated while the linear stages modulation signal is deactivated, 

but never both together. Additionally, the attenuation of the laser beam power is controlled by 

an HWP coupled to a rotary stage and a polarizer placed ahead the HWP. The motion drivers 

correctly synchronize the rotary stage to rotate the output polarization of the HWP and obtain 

the appropriate power at the output of the polarizer required by the printing processes 

programmed in the software recipes. 

The galvo controller is correctly synchronized with the motion controller using a software 

package integrated into the user program (Galvos and XYZ stages Synchronization Package). 

Finally, a real-time vision and image processing software package has been integrated. This 

allows for inspecting all XYZ movements, focus adjustments, stage configurations, and 

calibration of the motion stages to correct XY surface deformations and stitching parameters. 

Additionally, to provide a greater range for the Z-axis, the system is reconfigurable to include 

another linear Z stage, offering extended vertical travel range. This is advantageous when 

working with 3D structures that require vertical travel greater than the range the piezo stage can 

provide. It also enhances system scalability by allowing flexibility to change focusing lenses 

for different focal distances and surface mapping. 

4.3. Optical design 

4.3.1. Optical design for 2PP using near-infrared light 

The design of the optical system is primarily characterized by a power control part and laser 

beam expansion. 

Considering a high-performance laser source that emits ultrafast pulsed light, i.e., a laser beam 

with a very high polarization extinction ratio (PER) and beam quality (M²) very close to 1, there 

is no need to modify it to enhance its propagation characteristics. This holds true if the 

divergence and aberrations of the light are negligible so the efficiency in the 2D and 3D 2PP-

DLW processes is not reduced. 

The laser beam power control consists of an AOM, a HWP, and a polarizer. The light is 

diffracted at the output of the AOM at different diffraction angles (nth orders) according to the 

Bragg condition, where the 1st order diffracted beam is used, while the non-1st orders are 

eliminated, as shown in Figure 4.2. 
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Figure 4.2: Simplified diagram of ultrafast pulsed near-infrared (N-IR) laser beam control 

and expansion. This design is used to induce 2PP via two-photon absorption (2PA). 

Considering that the electric field of the beam is linearly polarized and that the light intensity 

remains constant during propagation, its intensity can be varied by modifying the polarization 

rotation and filtering it out through a polarizer [189], [190]. 

The HWP rotates the orthogonal components of the light by 𝜃 degrees on the plane of incidence. 

This causes the transmitted light to have different amplitudes according to 𝜃, without phase 

shifts in p- and s-polarization, as shown in the Jones vector in Table 4.1. The polarizer is a filter 

that separates the orthogonal components of linearly polarized light, transmitting the electric 

field polarized parallel to the plane of incidence of the polarizer (p-polarization) and reflecting 

the component perpendicular to the plane of incidence (s-polarization). 

The principle of operation for power control is based on Malus's law [190], where the intensity 

𝐼 of polarized light passing through the polarizer is given by: 

 𝐼 = 𝐼𝑜 ⋅ cos
2(𝜃) (4.1) 

where 𝐼𝑜 is the input intensity and 𝜃 is the angle between the initial direction of the polarized 

beam and the fast axis of the HWP. The angle of the HWP allows continuous rotation in the 

polarization direction of the beam. 
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Table 4.1: Jones vectors description for spatial polarization state of light [189]. 

Linearly polarized wave Vector Description 

Plane of polarization parallel in 𝑥 axis 

(𝜃 = 0°) 
[
1
0
] 

 

Plane of polarization perpendicular in 𝑥 

axis 

(𝜃 = 90°) 
[
0
1
] 

 

Plane of polarization making angle 𝜃 with 

𝑥 axis 
[
cos 𝜃
sin 𝜃

] 

 

 

Eventually, the laser beam passes through the expansion set, which consists of a collimator with 

two lenses configured like an astronomical telescope, as depicted in its simplest form in Figure 

4.2. The first lens must have a diameter larger than the input beam waist (𝐷1) to prevent clipping 

the beam. Similarly, the diameter of the output lens must be larger than the expanded beam 

waist (𝐷2). 

The expansion geometry is based on a Keplerian telescope, which uses two plano-convex lenses 

with positive focal lengths [191]. The magnification of the system must satisfy the optical 

design requirements, according to the expression: 

 𝑚 =
𝑓2
𝑓1
=
𝐷2
𝐷1

 (4.2) 

where 𝑓1 and 𝑓2 are the focal lengths of the respective lenses and the spacing between them is 

equal to the sum of the focal lengths (𝑓1 + 𝑓2). To reduce aberrations, only the central part of 

the lenses should be used, i.e., 𝐷1 and 𝐷2 should be as small as possible about the optical axis 

of the system. However, for a large magnification (𝑛 times the input), the usable extended beam 

waist can be up to a maximum of 80 % of the total diameter of the lenses. 

 𝐷1,2 ≤ 0.8 ⋅ ∅𝐿𝑒𝑛𝑠𝑒𝑠 (4.3) 

Furthermore, to avoid clipping at the end of the optical path of the system, the extended beam 

waist should not diverge from the exit of the second expansion lens to the entrance of the 

objective lens (OL). Ideally, this divergence should be less than 10−3 mrad and the extended 

beam waist should not exceed the entrance pupil diameter (∅𝐸𝑃) of the OL. 

Both the OL and the additional lenses must adhere to the optical design specifications of the 

system. Specifically, the extended beam waist should occupy at least 80 % of the entire ∅𝐸𝑃 of 

the OL, satisfying Equation (4.4): 
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 0.8 × ∅𝐸𝑃 ≤ 𝐷2 < ∅𝐸𝑃 (4.4) 

while ∅𝐸𝑃 can be calculated using the Equation (4.5): 

 ∅𝐸𝑃  =  2 ⋅ 𝑁𝐴 ⋅ 𝐸𝐹𝐿 (4.5) 

where 𝐸𝐹𝐿 is the effective focal length of the OL and 𝑁𝐴 is its numerical aperture. Between 

Lens 2 and the OL shown in Figure 4.2, additional optical components, such as mirrors to define 

the optical path and galvos to move the laser beam on the photoresists, will be used. 

4.3.2. Optical design for 1PP using violet light 

This optical design is integrated into the 2PP system to calibrate and optimize the linear 

translational stages and galvanometric scanners due to the difficulty of applying 2PP directly at 

the substrate-photoresist interface without considering fine focusing on the photoresists for 

processes. This design is primarily characterized by a power control and collimation part of the 

laser beam. 

 

Figure 4.3: Simplified diagram of violet continuous-wave (CW) laser beam control and 

collimation. This design is used to induce 1PP via one-photon absorption (1PA). 

Considering a laser diode as the continuous-wave (CW) emission source in the violet spectrum 

(~405 nm), it is only necessary to perform power control and beam homogenization for its 

projection at the entrance of the OL with no need to improve other characteristics of the 

propagation. Therefore, a low-cost laser diode can be the appropriate choice for high-resolution 

1PP-DLW processes in 2D printing. 

The laser beam power control is composed of a variable attenuator as shown in Figure 4.3, 

where the rotation angle (𝜃) determines the appropriate power for the used photoresists, given 

by: 

 𝐼 = 𝐼𝑜 ⋅ 10
−𝑂𝐷(𝜃) (4.6) 

where 𝐼𝑜 is the input power intensity and 𝑂𝐷 is the optical density of the attenuator as a function 

of the rotation angle. 
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Laser diodes typically emit light with a wider divergence than other laser sources, requiring 

collimation to make the photons highly directional and propagate nearly parallel to the optical 

axis of the system [191]. 

The geometry of the optical design consists of two plano-convex lenses with equal focal lengths 

(𝑓1 = 𝑓2); hence the system magnification is 1×, according to Equation (4.2). They are separated 

by twice the focal length to avoid introducing divergence. Equations (4.3) and (4.4) also satisfy 

the system requirements to reduce aberrations. The diameters of the lenses 𝐷1 and 𝐷2 must be 

sufficiently large to avoid clipping of the beam, with 𝐷2 ranging between 80–99% at the 

entrance of the OL. Finally, the optical components between Lens 2 and the OL will be the 

same as those mentioned in the optical design for 2PP. 

4.3.3. Focusing and surface mapping design 

The 2PP system is characterized by its focusing and surface mapping technique like an optical 

measurement tool using displacement lasers [192]. The design in Figure 4.4 consists of a single 

device emitting low-power red light and a sensor that detects the reflected light at an incidence 

point on the first layer of the photoresist. The device measures the distance between a point on 

the photoresist surface and the optical receiver [193]. This design requires moving the Z stage 

to find the OL focus, and the X and Y stages to construct a topography of the photoresist through 

multiple measurement points. This approach enables compensation for surface inclination 

errors and ensures the focusing precision in DLW processes. This design is based on air 

configuration mode, and the uniformity of the photoresist thickness is mandatory. 

 

Figure 4.4: Simplified diagram of focusing and surface mapping design using a 

displacement laser. The measurement points may be captured by software, which also 

calculates the focus of the objective lens (OL) and the photoresist topography. 
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4.3.4. Vision design 

 

Figure 4.5: Simplified diagram of vision design (infinite conjugate microscope). 

The vision system shown in Figure 4.5 indicate a conventional microscope setup. The focal 

length (𝑙′) can be adjusted up to 2 times the focal distance (𝑓) of the tube lens to enhance the 

image quality of an object focused within the FOV of the system. This adjustment provides a 

linear zoom along the optical axis corresponding to the magnification of the OL. 

The FOV of this vision design with a digital camera can be calculated by: 

 
𝐹𝑂𝑉 =

𝐶𝐴 ⋅ 𝑠

𝑀𝑂𝐿 ⋅
𝑙′

𝑓𝑂𝐿

 
(4.7) 

where 𝐶𝐴 is the size of the camera sensor in (height × width) pixels, 𝑠 is the size of a single 

pixel, 𝑓𝑂𝐿 and 𝑀𝑂𝐿 are the focal length and the magnification of the OL. Depending on the 

technical parameters of the used OL, the FOV of the vision system can increase or decrease. 

The galvos’ FOV is not part of the vision design, but it must be considered in the design criteria. 

Galvos’ FOV is defined by the separation between the last galvos mirror and OL and is limited 

by the technical parameters of the OL. Therefore, galvos’ FOV must be smaller than the FOV 

of the vision system to avoid clipping the beam. 

 𝐹𝑂𝑉𝑔𝑎𝑙𝑣𝑜𝑠 < 𝐹𝑂𝑉𝑣𝑖𝑠𝑖𝑜𝑛 (4.8) 

The illumination within the vision design enables visualization of the DLW processes and 

focusing on the material plane. The 2PP system is equipped with two red light illumination 

sources: one from the bottom and one from the top. 

The bottom illumination is a type of backlighting (e.g., Koehler illumination), where incident 

light floods the entire FOV under inspection from behind. This illumination does not require 

any additional lens, as it can be a bright and uniform source in the object plane. 
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The top illumination above the OL is collinear with the vision and laser beam, where incident 

light on the material in the object plane reaches at an angle due to the OL, resulting in a very 

compact illumination that is both intense and precise. 

The optical design depicted in Figure 4.5 shows a system conjugate to infinity, i.e., the vision, 

illumination, and laser beam at the entrance pupil of the OL focused on a plane of the material 

are parallel and collinear (infinite focal length). This feature also allows varying magnification 

depending on the employed OL; based on this, the focal length (𝑙′) of the lens can be adjusted 

to produce a sharp image. Furthermore, this design allows for the introduction of additional 

optics in the infinite conjugate tube length (𝑧′), such as beam-splitters and transparent filters in 

the visible spectrum to adjust light parallel to the optical axis of the vision. 

Given that the Z-axis is variable in the 2PP system (due to focusing, surface mapping, or the 

OL used), the maximum distance between the OL and the tube lens (𝑧𝑚𝑎𝑥
′ ) can be determined 

by: 

 𝑧′𝑚𝑎𝑥 =
∅𝐿 − ∅𝐸𝑃
𝐶𝐴 ⋅ 𝑠

⋅ 𝑓𝐿 (4.9) 

where ∅𝐿 and 𝑓𝐿 are the diameter and focal length of the camera focus lens respectively. 

4.4. System setup 

4.4.1. 2PP setup 

The combination of all stages and optical components is described in the setup of the 2PP 

nanofabrication system in Figure 4.6, and the technical specifications are summarized in Table 

4.2. 

The ultrafast pulsed laser source (femto laser) generates a pulsed beam with a high repetition 

rate in the order of MHz and a pulse width in the femtosecond range at a wavelength N-IR. The 

AOM diffracts the laser beam into the 1st diffraction order through sinusoidal signals generated 

by a modulator provided by the AOM. The iris diaphragm (I1) blocks the remaining 

components of the diffracted light coming from the AOM. An HWP and a polarizing beam-

splitter (PBS) control the power of the linearly polarized laser beam. 

The intensity of the laser beam for the 2PP setup can be expressed in terms of power (𝑃 ∝ 𝐼). 

Therefore, Equation (4.1) becomes: 

 𝑃 = 𝑃𝑚𝑎𝑥 ⋅ cos
2(2𝜃 − 𝜑) (4.10) 

where 𝑃𝑚𝑎𝑥 is the maximum power of the 1st order diffracted laser beam and 𝜑 is the offset 

angle of the fast principal axis of the HWP installed in the rotary stage of the optical path. The 
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beam dump absorbs the s-polarization of the laser beam, while the PBS transmits the p-

polarization for the 2PP-DLW processes. 

 

Figure 4.6: 2PP setup: A femtosecond laser source (femto laser), an acousto-optic 

modulator (AOM), an iris (I1), a half-wave plate (HWP), a polarizing beam-splitter (PBS), 

two plano-convex lenses (L1, L2), two mirrors (M1, M2), a XY galvanometer scanner (XY 

galvo), a dichroic mirror (DM), a piezoelectric stage (Z piezo), a Z stage, an objective lens 

(OL) and a XY large stage compose the nanofabrication part of the system. Two lighting 

sources (LED spotlight and backlight), the OL, the DM, a beam-splitter (BS), a mirror 

(M3), a plano-convex lens (L3), a filter (F1) and a CMOS camera compose the real-time 

monitoring part of the system. The motion, galvo and piezo controller manage XYZ 

micro/nano-positioning, while the AOM, HWP, and PBS control the increase or attenuation 

of the laser beam power. The CMOS camera is managed by software on the computer. 

Two planoconvex lenses (L1, L2) with focal lengths of 25.0 mm and 100.0 mm respectively 

allow the laser beam to be expanded 4 times, resulting in an expanded beam waist (𝐷2) of 5.2 

mm according to Equation (4.2), and satisfying the condition of Equation (4.3) for a diameter 

of ½” for both lenses, i.e., 5.2 mm ≤ (0.8 × 12.7) mm. 

The setup also consists of a pair of high-reflectance mirrors (M1, M2) to route the laser beam 

toward the galvanometer scanner (XY galvo) input. 

The laser beam is manipulated by the XY galvo to realize dimensional scanning in the XY-

plane, and a piezoelectric stage (Z piezo) with a 100 µm travel range is used to move the focused 

laser beam vertically along the Z-axis. The XY large stage, with a 200 mm travel range in both 

the X- and Y-axes is used to realize long-range positioning with high micrometric precision and 

repeatability. The XYZ nano-positioning is composed by the XY galvo and the Z piezo to 

realize nanostructures with higher nanometric precision and resolution. 
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The XY large stage allows working on microstructures larger than the FOV of the XY galvo in 

the XY-plane. It enables the use of stitching techniques to utilize the entire scanning area, 

dividing the XY-plane into adjusted tiles within the FOV of the XY galvo. Furthermore, the Z 

piezo allows for laser focal spot adjustment (focusing) and XY-plane representative surface 

mapping of a photoresist. 

A dichroic mirror (DM) is used as a short-pass filter to reflect the laser beam and transmit light 

in other bands, i.e., reflective for N-IR light and transparent in the visible light band-wide for 

the vision in the camera. 

An OL infinite conjugate with magnification of 50×, a NA of 0.8, a working distance (WD) of 

0.47 mm and effective focal length of 3.6 mm is used. Entrance pupil diameter (∅𝐸𝑃) was 

calculated as 5.76 mm, using Equation (4.5). According to Table 4.2, the diameter of the laser 

beam at the exit of the implemented femto laser is 1.3 mm. Therefore, the magnification (𝑚) at 

the entrance pupil of the OL is 5.2 mm, satisfying Equation (4.4). 

The customized 2PP system described in Figure 4.6 operates in air configuration mode, where 

the immersion medium is air. This mode allows the laser beam to be focused directly onto 

photoresists on either opaque or transparent substrates. Focusing and surface mapping are 

manipulated within the Z piezo travel range. However, for thicker substrates or larger 

photoresist thicknesses, an additional Z stage with a 25 mm travel range is employed, resulting 

in a total work volume of 200 × 200 × (0.1 + 25) mm³. 

The 2PP setup includes a real-time monitoring part for visualizing the 2PP-DLW process on 

photoresists. This monitoring part is composed of two illumination sources (LED spotlight and 

LED backlight), a CMOS camera, a beam-splitter (BS), a camera focus lens (L3), and additional 

optics (F1, M3) that adjust the FOV on the camera sensor. The lighting sources ensure excellent 

uniformity, high intensity, and red-light variability without spectral components that could 

inadvertently polymerize photoresists. An optical short-pass filter (F1) is employed to block N-

IR diffuse reflections from reaching the camera sensor, preventing pixel saturation or potential 

damage in the active region. 

The FOV of the vision system was calculated as 135.16 × 101.37 µm², using Equation (4.7), 

based on the size of the digital CMOS camera sensor presented in Table 4.2. 

The DM and the OL share the nanofabrication and the monitoring part of the system, whereas 

the motion controller executes the interaction for mechanical movement of the stages in the X 

Y and Z axes according to the geometric parameters of a CAD design in software recipes. 
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Table 4.2: Technical characteristics of the components for the 2PP setup. 

Part  Component Manufacturer System specifications required Ref. 

Femto laser Carmel X-780 Calmar Laser 

Repetition rate of 80 MHz, pulse width of 90 fs, average power of 250 mW, 

pulse energy of 3 nJ, central wavelength of 780 nm and, output beam diameter 

of 1.3 mm. 

[194] 

AOM AOMO 3080-122 Gooch & Housego 
Operating wavelength range 780–850 nm, frequency of 80 MHz, Bragg angle 

of 7.9 mrad and diffraction efficiency of 85 % (at 830 nm). 
[195] 

HWP WPH05M-780 

Thorlabs 

Operating wavelength of 780 nm, retardance of 𝜆/2, reflectance 0.1 %, beam 

deviation of <10 arcsec. 

[196] 

PBS CCM5-PBS202/M 
Wavelength range 620–1000 nm, transmission efficiency (p-pol.) of 90 % and 

reflection (s-pol.) of 95 %. 

Beam dump LB1/M 
Wavelength range 400 nm – 2 µm, pulse laser type and max average power of 

10 W. 

L1, L2, L3 

LA1560-AB, LA1207-

AB and AC254-150-A-

ML 

Focal length of 25.0 mm, 100.0 mm and 150 mm respectively. 

Wavelength ranges 400–1100 nm (L1, L2), diameter ½”. 

Wavelength range 400–700 nm (L3), diameter 1”. 

I1 ID12/M Aperture range 1–12 mm 

M1, M2, M3 PF10-03-G01 
Diameter of 1" and average reflectance of 71.3 % at 780 nm for 45° AOI S-

polarization laser beam. 

XY galvo 2D-MSA-A10 MINI  

Newson 

Entrance beam diameter of 10 mm, resolution of repeatability 20bits, 

repeatability less than 3 µrad and optical angular range of 180 mrad (10.3°). 
[197] 

Galvo controller CUA32-MST-AC 
3 deflectors control at 20 bits resolution, synchronized deflector, usb and 

ethernet connection, and SDP transfer protocol support. 

Z piezo NPO140SG 

Newport 

Close loop travel range of 100 µm, close loop resolution of 3 nm and typical 

repeatability of 3 nm. 

[198] Piezo controller NPC3SG 
3 piezoelectric stages control in close loop (position), stability of ± 0.1%, 

analog signal control. 

Z stage LTA-HL 
Travel range of 25 mm, bi-directional repeatability of ±1.0 µm and minimum 

incremental motion of 0.05 µm. 
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Part  Component Manufacturer System specifications required Ref. 

XY large stage LS-ONE-XY Lasing S.A. 
High speed analog encoders integrated, XY range travel of 200 mm and 

resolution of 10 nm. 
[199] 

DM FF670-SDi01-25X36  Semrock 

Average transmission greater than 90 % at 360–650 nm band, average 

reflection greater than 95 % at 685–1600 nm band and edge wavelength of 

670 nm. 

[200] 

OL MSPlan 50 Olympus 

Numerical aperture of 0.8, magnification of 50×, infinite conjugate, lens tube 

focal length of 180 mm, working distance of 0.47 mm and effective focal 

length of 3.6mm. 

[201] 

Lighting 

sources 

MV-I-R and ML-B50-

R 
Mvotem Optics Red light at wavelength range 620–625 nm. [202] 

Camera UI-1580LE-C-GL IDS 
CMOS Color sensor, pixel class of 5 MP, resolution of 2560x1920, pixel size 

of 2,2 μm and frame rate of 6,4 fps. 
[203] 

BS CCM1-BS013/M 

Thorlabs 

Non-polarizing BS, wavelength range 400–700 nm and absolute transmission 

and reflection of 47 ± 10 %. 
[196] 

F1 FESH0750 
Cut-off wavelength of 750 nm, transmission region (>90 %) 400–740 nm and 

rejection region 761–1200 nm. 

Motion 

controller 

SPiiPlusEC (Motion 

controller) 

ACS Motion Control 

4 axis control, TCP/IP, Ethernet/IP host (PC) communication, EtherCAT 

cycle rate up to 5kHz, and network/motion-boost. 

[204] 
NPMpm (Motion 

driver) 

2 Axis control, 4 encoder channels (sin/cos), servo-boost and nanoPWM, 

motion-process synchronization. 

UDMsd (Motion 

driver) 

4 axis control, 4 encoder channels (AqB, abs), servo-boost, and motion-

process synchronization. 
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4.4.2. 1PP setup 

1PP setup illustrated in Figure 4.7 is an extension of the optical components of the 2PP setup 

in the system for 1PP micro-fabrication, as summarized in Table 4.3. 

 

Figure 4.7: 1PP setup: A continuous-wave laser diode (CW laser), a spatial filter setup (F2), 

two plano-convex lenses (L4, L5), a mirror (M4) and a dichroic mirror (DM) compose the 

micro-fabrication part of the system. 1PP setup is an extended part of the 2PP setup. 

The CW laser diode generates a beam at a wavelength in the violet visible spectrum (405 nm). 

The implemented power control consists of a set of three spatial filters (F2). The main filter (𝑓𝑣) 

has a continuously variable neutral optical density (OD) that provides exponentially adjustable 

attenuation through rotation, while two secondary filters (𝑓𝑠𝑢𝑏1, 𝑓𝑠𝑢𝑏2) have fixed ODs that 

allow constant attenuation. Thus, the intensity of the laser beam in Equation (4.6) can be 

expressed in terms of transmitted power, therefore: 

 𝑃 = 𝑃𝑚𝑎𝑥 ⋅ 10
−𝑂𝐷(𝜃),      0° < 𝜃 < 270°  (4.11) 

where 𝑃𝑚𝑎𝑥 is the maximum power transmission of the laser beam and 𝜃 belongs to the 

minimum and maximum OD of the main filter. Depending on the required exposure power to 

execute 1PP-DLW processes on various photoresists with varying sensitivity to the laser beam 

wavelength, F2 can be configured to adapt the transmission of the applied filters. 

Two plano-convex lenses (L4, L5) with equal focal lengths are used to homogenize the laser 

beam along the optical axis of the optical path, satisfying the condition of Equation (4.3) for 

lens diameters of 25.0 mm. i.e., for the implemented CW laser, the output beam waist (𝐷2) is 

5.8 mm ≤ (0.8×25.0) mm. 
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A highly reflective longpass dichroic mirror (DM) in the violet and ultra-violet (UV) spectrum, 

and highly transmissive in the visible spectrum has been implemented. 

To satisfy Equation (4.4), an iris diaphragm installed in the optical path of the 1PP configuration 

reduces the beam waist to between 80 – 99% of the entrance pupil diameter (∅𝐸𝑃) of the OL. 

Table 4.3: Technical characteristics of the components for the 1PP setup. 

Part  Component Manufacturer System specifications required Ref. 

Laser 

diode 

Laser diode Unknown Average power of 500 mW, wavelength of 405 

nm and, output beam diameter of 5.8 mm 

-- 

F2 

 

NDC-100C-2 

(𝑓𝑣) 

Thorlabs Optical density range 0.04 – 2.0, coating radial 

angle 270° ± 5°, reflectance of 0.53 % for 8° AOI 

laser beam at 405nm. 

[196] 

ND10B 

(𝑓𝑠𝑢𝑏1) 

Optical density of 1.0, transmission of 9.7 % at 

405 nm and diameter of 25.0 mm 

ND30B 

(𝑓𝑠𝑢𝑏2) 

Optical density of 3.0, transmission of 0.098 % at 

405 nm and diameter of 25.0 mm 

L4, 

L5 

LA1252 Focal length of 25.4 mm, wavelength ranges 350–

2000 nm and diameter of 25.0 mm. 

M4 PF10-03-G01 Diameter of 1" and average reflectance of 89 % at 

405 nm for 45° AOI unpolarized laser beam. 

DM DMLP425R Transmission lower than 1.1 % and reflection 

greater than 97.4 % at 380–410 nm band and cut-

on wavelength of 425 nm. 

 

4.5. Ad-hoc design of hardware components and 2PP system 

The customized 2PP system was previously designed using high-performance CAD design 

software before fabrication and assembly. All optical and electronic devices described in Figure 

4.6 and Figure 4.7 meet the optical design requirements of the 2PP and 1PP setups precisely as 

described. 

The model in Figure 4.8 simulates the assembly of optical devices and stages to ensure their 

dynamics and proper functionality. Additionally, this model ensures the reduction of time, 

correction of design errors, and enhancement of the final system's quality through detailed 

documentation provided by the company Lasing S.A. to meet industrial regulations and quality 

standards [199]. 
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Figure 4.8: CAD design of the 2PP system assembly. 

Positioning of the optical components in Figure 4.9 involves assembling the 2PP setup for 

ultrafast pulsed N-IR laser beam emission (780 nm, 90 fs) by a laser head [194], power control, 

beam waist expansion, and routing of the polarized laser beam. Meanwhile, Figure 4.10 shows 

the assembly of the 1PP setup for continuous violet laser beam (405 nm) by a laser diode, power 

control, collimation, and routing of the laser beam. 

 

Figure 4.9: CAD simulation of the 2PP setup assembly. 
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Figure 4.10: CAD simulation of 1PP setup assembly. 

Only one laser beam is permitted to perform DLW processes. Both laser beams acting 

simultaneously are not allowed, because the customized system is not characterized for 

polymerizing photoresists using both one-photon absorption (1PA) and two-photon absorption 

mechanisms (2PA). The laser beams are generated separately by their sources and directed 

towards the main optical path up to the entrance pupil of the OL. Therefore, the optical switch 

(M4 in Figure 4.9) acts as a reflector for the violet laser when the system operates in 1PP-DLW 

mode, keeping the ultrafast pulsed light off, and vice versa for 2PP-DLW mode without M4. 

Additionally, different dichroic mirrors (DM) are implemented for each laser wavelength 

according to the technical requirements in Table 4.2 and Table 4.3 for each 1PP-DLW and 2PP-

DLW process. 

A vertical platform allows positioning of the optical components and XYZ nano-positioning 

stages (XY-galvos and Z-piezo) in the main optical path, as well as all vision optical 

components, ensuring they are collinear with the laser beams (violet and N-IR) along the Z-

axis of the customized 2PP system. Figure 4.11 shows a comprehensive simulation to prevent 

manufacturing and assembly errors. 

Finally, Figure 4.12 and Figure 4.13 depict the XY large stage and the integrated control 

electronics rack (controllers, computer, and power supply) required for the system operation. 

The system is implemented on an anti-vibration floating table isolated by injected air pressure 

to prevent external perturbations that may be transmitted to the 2PP system, thereby affecting 

the 1PP- and 2PP-DLW processes and reducing the resolution of critical micro/nanostructures 

for photonic devices and applications. 
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Figure 4.11: CAD simulation of the vision and XYZ nano-positioning of the system. 

  

Figure 4.12: CAD simulation of XY large stage assembly on anti-vibration table. 

 

Figure 4.13: CAD simulation of the control rack assembly. 
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4.6. 2PP System Assembly 

The final assembly of the 2PP system is shown in Figure 4.14, where each component is 

carefully designed and manufactured to meet the criteria of the CAD simulations from Figure 

4.8 to Figure 4.13. 

The 2PP system has been thoroughly tested, and the XYZ linear stages and rotary stage have 

been tuned using the SPiiPlus MMI Application Studio software from ACS Motion Control 

[204], and Lasing Processing Software (LPS) is thoroughly programmed and installed on the 

computer with the respective configurations and calibrations for controlling the entire hardware 

of the 2PP system [199]. 

 

Figure 4.14: Final view of the assembled 2PP system. 

The optical components and assembly mounts of the 2PP system are organized on three 

platforms (optical tables from Newport and Thorlabs). The top platform is shown in Figure 

4.15, while the vertical platform and the anti-vibration floating table are shown in Figure 4.16. 

1PP and 2PP setups are completely labeled in the figures with optical path of the laser beams. 
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Figure 4.15: Top platform of the assembled 2PP system. a) View of the assembled 2PP 

setup. b) Optical path of the assembled 2PP setup. c) View of the assembled 1PP setup. d) 

optical path of the assembled 1PP setup. 

Vision design and light optical design (N-IR and violet light) are shown in Figure 4.16. All 

assembly mounts used for this 2PP system are acquired from Newport and Thorlabs stock, 

while other nonstandard mounts are designed and manufactured according to the CAD 

simulations. 
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Figure 4.16: View of the vertical platform and anti-vibration floating table of the assembled 

2PP system. An additional mirror (M5) has been used to redirect the laser beam to the XY 

galvo, and a displacement laser module to manage focusing and surface mapping data from 

displacement laser [205]. 

In practice, optical aberrations, laser quality, and laser alignment can influence the efficiency 

of the 2PP system during DLW processes. The volume formed by the focal spot of the focused 

beam in the photoresists, particularly the voxel size created by a femto laser beam, is affected, 

aside from the properties of the photoresist which can also alter voxel dimensions. Therefore, 

the 2PP system must be correctly assembled and tuned prior to the fabrication of 

micro/nanostructures. 

The electronic components are organized in three cases inside the control rack:  control, power 

supply and computer case, as depicted in Figure 4.17-a. The control case, depicted in Figure 

4.17-b, is composed of galvo and motion controllers, a shutter, an AOM module, and signal 

conditioning, while the power supply case consists of DC power supplies of +5 volts, +24 volts, 

and +48 volts to provide the necessary tension and current for the entire 2PP system. All electric 

and coaxial cables used for the connections are fully distributed among all electronic 

components in the 2PP system. 
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Figure 4.17: View of the entire control rack of the assembled 2PP system. a) Organization 

of the cases of all electronic components. b) Inside view of the control case.  
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CHAPTER 5 

5. Results: Initial commissioning and 

optimization of the system 
The exposure power and marking/scanning speed are parameters to be optimized in 

photolithographic systems for the fabrication of 2D and 3D micro/nanostructures for photonic 

devices with the best achievable precision and resolution [27]. Two-photon polymerization 

(2PP) is the most versatile technique for achieving high-resolution micro/nanostructures 

smaller than 100 nm [158], [206]. Therefore, an optimization of the 2PP system to achieve the 

desired resolution in commercial photoresist must be carried out, similar to commercial systems 

for micro-fabrication based on 2PP [32], [33], [34]. 

This chapter presents the commissioning and optimization results of the customized 2PP 

system. Optimization is divided into two steps. 

Optimization of direct laser writing (DLW) using one-photon polymerization (1PP-DLW) and 

2PP-DLW in thin layers of negative-tone photoresist, followed by a comparison of their 

commissioning results. 

2PP-DLW optimization in thin and thick layers of positive-tone and negative-tone photoresists 

for voxel characterization in the customized 2PP system. 

1PP-DLW is used to calibrate and optimize the 2PP system without considering fine focusing 

on the photoresist surfaces. This is because polymerization in 2PP-DLW is more complicated 

when positioning or optical path errors occur during the 2PP system start-up. Also, it allows for 

thin-layer 2D lithography with a resolution above one micron. 

5.1. 1PP-DLW optimization on SU-8 photoresist 

The 1PP-DLW process uses the one-photon absorption (1PA) mechanism to polymerize 

photoresists. This technique is commonly used to fabricate 2D microstructures (usually in thin 

layers) for photonic devices and applied optics [8], [207]. The molecules absorb the necessary 

amount of energy, above the polymerization threshold without over-exposing the exposure area. 

The exposure time and the photon energy (ℎ𝜈𝑝ℎ) that induce the transition from the ground 

state to the excited state, along with the laser photon emission rate (photons/time), are key 

parameters of the process. Therefore, the laser beam power and scanning speed contribute to 
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the optimization of the polymerization reaction within the micrometric area formed about the 

focal point of the objective lens (OL) [155]. 

In this context, the optimized power is determined by the angle 𝜃 of the attenuator in the filter 

setup (𝐹2). This has been described in the 1PP setup of Figure 4.7 and expressed in Equation 

(4.11). It can be rewritten as follows: 

 𝑃 = 𝑃𝑚𝑎𝑥 ⋅ 𝑇𝑙𝑜𝑠𝑠𝑒𝑠 ⋅ 10
([−𝑂𝐷𝑚𝑎𝑥−(

𝑂𝐷𝑚𝑖𝑛−𝑂𝐷𝑚𝑎𝑥
250°

)⋅𝜃]−𝑂𝐷𝑠𝑢𝑏1−𝑂𝐷𝑠𝑢𝑏2) (5.1) 

where 𝑃𝑚𝑎𝑥 = 500 mW is the maximum average power output of the continuous-wave laser 

(CW laser), 𝑂𝐷𝑚𝑖𝑛 = 0.04 and 𝑂𝐷𝑚𝑎𝑥 = 2.0 are the minimum and maximum optical densities 

of the variable attenuator disk (𝑓𝑣), 𝑂𝐷𝑠𝑢𝑏1 = 1.01 and 𝑂𝐷𝑠𝑢𝑏2 = 3.01 are the optical densities 

of the fixed filters 𝑓𝑠𝑢𝑏1 and 𝑓𝑠𝑢𝑏2 respectively, 𝜃 is determined within the defined attenuation 

region of 𝑓𝑣 as {0° ≤ 𝜃 ≤ 250°}, and 𝑇𝑙𝑜𝑠𝑠𝑒𝑠 represents the remaining optical transmissions 

after accounting for the optical losses of all components at a wavelength of 405 nm. It is defined 

as follows: 

 𝑇𝑙𝑜𝑠𝑠𝑒𝑠 = 1 −∑(1 − 𝑅𝑖)

𝑀

𝑖=1

+∑(1 − 𝑇𝑗)

𝐿

𝑗=1

 (5.2) 

where 𝑅𝑖 represents the reflection losses of all mirrors, and 𝑇𝑗 represents the transmission losses 

of all lenses along the optical path of the system. 

 

Figure 5.1: a) Characteristic average powers of the 1PP setup measured and calculated from 

the attenuator disk (𝑓𝑣). b) Power of the CW laser applying the filter setup 

(𝐹2 = 𝑓𝑣 + 𝑓𝑠𝑢𝑏1 + 𝑓𝑠𝑢𝑏2). The dashed lines represent the powers obtained using the fixed 

filters (𝑓𝑠𝑢𝑏1 and 𝑓𝑠𝑢𝑏2) for their respective transmissions (ND10B and ND30B from 

Thorlabs) at λ = 405 nm. c) Representation of the variable attenuator 𝑓𝑣 (NDC-100C-2 

from Thorlabs). 

Figure 5.1-a represents the measured and calculated powers corresponding to the optical design 

of the 1PP setup. The CW laser power was measured at the entrance pupil of the OL using a 



Results: Initial commissioning and optimization of the system 

65 

 

power meter equipped with a Newport photodetector (1936-R and 918D-SL-OD3R). The total 

powers in Figure 5.1-b are determined based on the combination of filters applied for 

polymerization. Figure 5.1-c shows the descriptive profile of the attenuator disk (𝑓𝑣) in the filter 

setup (𝐹2). The attenuation region is linear with rotation, where (𝑂𝐷 ≈ 2.0|𝜃 = 0°) and (𝑂𝐷 ≈

0.04|𝜃 = 250°) determine the maximum and minimum attenuation limits in the system as 

obtained in Figure 5.1-a and -b. The non-attenuation region (𝑃𝑜𝑢𝑡 > 𝑃𝑚𝑎𝑥) represents the 

uncontrolled power region and has not been considered for system optimization. 

5.1.1. Methods and materials 

The system is designed to photopolymerize photoresists deposited on silicon, quartz, or glass 

substrates. 

In this chapter, commercial 0.7 mm-thick glass indium-tin oxide (ITO) coated slides are used 

as substrates. The ITO layer is nominally 130 nm-thick and provides good and uniform 

adherence of the photoresists. The CW-laser beam is focused inside the photoresist using a 50× 

microscope OL with numerical aperture (NA) of 0.80. Negative-tone photoresist can selectively 

be polymerized using the Equation (5.1) by 1PA explained in Chapter 2. 

Prior to 1PP-DLW meticulous substrate cleaning process was carried out in the clean-room of 

the UPM´s CEMDATIC [208]. First, the substrates are immersed in commercial acetone/2-

propanol for 1 minute and cleaned with lint-free cloths. Subsequently, ultrasonic cleaning of 

the substrates is performed for 30 minutes immersed in deionized water. Afterwards, the 

substrates are thoroughly dried with nitrogen flow. Finally, high-temperature baking at 200 °C 

for 120 minutes eliminates any remaining adsorbed water. 

Before dispensing the photoresist onto the ITO-glass substrates, they are placed under deep 

cleaning using an ultra-violet-ozone cleaner (UVO-Cleaner) for 10 minutes to eliminate any 

organic material (oils, greases and other waste). This step also makes the substrates surface 

more hydrophilic, improving the adhesion of the deposited photoresist. 

Photoresist is drop-casted onto the ITO-glass surface (1 ml of photoresist for each 25×25 mm² 

surface) for spin-coating. The used photoresist is SU-8 TF 6002 negative-tone photoresist 

(Kayaku Advanced Materials) obtained from Micro Resist Technology GmbH. SU-8 

photoresist is spin-coated in two steps. Firstly for 10 seconds at 500 rpm to achieve a uniform 

distribution of the material on the substrate; in the second step, the sample is rotated for 30 

seconds at 3000 rpm to reach the desired thickness. In both steps, acceleration ramps of 

500 rpm/s. are used. This creates a photoresist layer of approximately 2 µm of thickness. 

Finally, the spin-coated photoresist is immediately soft-baked at 110 °C for 3 minutes to get it 

ready for the 1PP-DLW processes. Pre- and post-exposure parameters are summarized in 

“Appendix A: Cleaning and spin-coating processes”. 
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Figure 5.2:  A pattern object for the 1PP-DLW process and a test grid to optimize the 

scanning speeds. 

 

Figure 5.3: Programming and configuration of pattern objects on the LPS software front 

panel.  The displayed test grid is processed at an average laser power. For other laser 

powers, the test grid is repeated multiple times on the same substrate. 

The 1PP-DLW process is implemented using the Lasing Processing Software (LPS) provided 

by the company Lasing S.A. [199]. LPS software is based on programmable recipes and 

features an intuitive interface for obtaining optimized parameters. Hence, a pattern object has 

been programmed in LPS software to be polymerized. The pattern object is a simple geometric 

shape measuring 50×50 µm², as depicted in Figure 5.2. In addition, a test grid of 𝑚×𝑛 pattern 

objects have been configured. 

X 

Y 
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Each pattern object of the test grid is programmed with different parameters, where 

{𝑣𝑚|𝑣0, 𝑣1, … , 𝑣𝑖−1} represent the increments in scanning speeds of the motion stages, while 

{𝑧𝑛|𝑧0, 𝑧1, … , 𝑧𝑗−1} represent the increments in heights along the Z-axis of the motion stages. 

Therefore, a pattern object (𝑣𝑖; 𝑧𝑗) is associated to a specific scanning speed and Z jumping. Z 

jumping is used to define the smallest possible linewidth on the spin-coated SU-8 layer 

thickness (maximum resolution) in 1PP-DLW process. 

Optimization is directly related to the ability of configuring parameter properties to generate 

laser processing pseudo-algorithms contained within a Recipe in LPS software. Figure 5.3 

shows the interface and the programming command list with their respective system 

configurations. 

SU-8 is commonly used to form 2D structures through 1PA induced by a CW laser beam [155]. 

1PP-DLW is governed by applying an appropriate exposure energy/time during the process. 

The characterized power shown in Figure 5.1 is used to define the polymerization threshold 

levels together with the focused CW laser beam scanning speed in the XY-plane of the 

substrates. Therefore, the absorption probability is linear and proportional to the beam intensity 

[40]. However, the absorption may be more complex, and 1PA might not be the dominant 

mechanism because of complex energy activation in SU-8, where the energy distribution and 

deep effects are relevant. 

The spin-coated SU-8 substrates are placed into the system to process the entire test grid of 

pattern objects shown in Figure 5.3. Pseudo-algorithms generated in LPS software are 

downloaded to the controllers of the 2PP system. These interpret the X and Y axes speeds, laser 

power control, synchronization, and other specific programming properties, such as vector 

positioning, field of view (FOV) adjustment, surface mapping, stitching, etc. 

The printing and focusing mode of the 2PP system is designed in air configuration mode, 

described in Chapter 4. Prior to optimization, the focusing was calibrated with initial, non-

extreme precision. Initially, the focal spot of the OL was adjusted on the photoresist surface by 

moving the Z stage. This adjustment must ensure that the separation between the surface and 

the OL matched the working distance (WD) of the OL. The system's vision camera has been 

used to meticulously set the WD with micrometer precision (step one in Figure 5.4). Next, a 

displacement laser was assembled and calibrated to its operational distance. The laser used is 

the OD5-25T01 (Sick Sensor Intelligence), a red laser sensor designed for focusing. According 

to the sensor specifications, the distance to obtain 90 % of the reflectance on the surface is 25 

mm, with accuracy of 0.02 µm of the measuring range of sensor (24–26 mm) [205]. This 

operational distance was meticulously calibrated, and the displacement laser should remain 

untouched to ensure that the OL’s WD is consistently the same for all processes (step two in 

Figure 5.4). When a new spin-coated SU-8 substrate is placed into the 2PP system, the sensor 

measures the distance again to detect any deviation (WD ± ∆). The system then moves the Z 
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stage to minimize this deviation (∆ ≈ 0), ensuring that OL’s WD must be the ideal by 

automatically setting the operational distance to 25 mm by reading the analog values of the 

sensor in LPS software (step three in Figure 5.4). This means that focusing is performed by 

reading the sensor, not by the system's vision. Finally, the OL and the displacement laser move 

together as a single block (Z head). This method may be referred to as coarse focusing. 

 

Figure 5.4: Steps for initial focusing in the 2PP system: After calibrating the distance of 

the objective lens (OL) and displacement laser, the Z stage is moved along the z-axis to 

ensure the operational distance to 25 mm throughout the processes. The sensor's range is 

between 24 mm and 26 mm, and measurements outside this range are not assured. The OL 

and displacement lasers are mounted on a Z head, which is moved by the linear Z translation 

stage. 

After coarse focusing, the test grid shown in Figure 5.3 was processed, and repeated several 

times on the same spin-coated SU-8 substrate, with different scanning speeds, as well as 

variations in Z-axis positions, to achieve better precision and gather more comprehensive data. 

The experiments have been repeated several times with different powers of the CW laser beam 

per substrate to empirically determine the minimum permissible power. For each exposed 

power value on the SU-8, different polymerization results have been obtained, and 

consequently, different resolutions. 

After the 1PP-DLW process, the substrates are immediately post-baked at 110 °C for 2 minutes 

to complete the polymerization process, according to the SU-8 technical datasheet [71]. 

Finally, the substrates are developed by submerging them in SU-8 developer (PGMEA) for 3 

minutes, then cleaned with 2-propanol for 30 seconds, and dried using a nitrogen flow. The 

post-exposure processes used in this work are summarized in “Appendix A: Cleaning and spin-

coating processes”. 

5.1.2. Results 

The position errors of the stages were mitigated by tuning all motion stages and adjusting the 

optical path of the CW laser to avoid aberrations and clipping the beam. This was continuously 
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verified to ensure the correct formation of the polymerized pattern objects for the presented 

results. 

The exposure time to polymerize SU-8 is an unknown value for the energy transfer required 

within the volume formed by the incident area (focused laser beam area) along the thickness of 

SU-8 (Z-direction). Hence, the power was determined by observing the lines after the 

development process using an optical microscope. Multiple test grids on the same substrate 

were processed, each with a different average laser power. In the experiments of the 1PP-DLW 

processes, an average laser power from 0.1 µW to 10.3 µW and scanning speeds from 50 µm/s 

to 600 µm/s were applied to simplify the analysis. Therefore, for this laser power range, 

polymerized microstructures in SU-8 were observed at a scanning speed of 300 µm/s and 

summarized in Table 5.1. 

Table 5.1: Classification of powers in 1PP-DLW processes at a scanning speed of 

300 µm/s. 

Average power applied [µW] 1PP-DLW linewidth resolution [µm] 

0.10 – 1.65 No results were reliable (Un-polymerized) 

1.85 – 5.15 ~ 1.0 (Polymerized) 

5.15 – 6.39 > 1.5 (Polymerized) 

6.39 – 10.3 > 2.5 (Polymerized) 

>10.3 > 3.0 (Over-exposed) 

 

At a scanning speed of 300 µm/s and an average power of 1.85 µW, according to Equation 

(5.1), the best achieved resolution observed was 1.106 µm, as shown in Figure 5.5. Different 

results have been observed at other scanning speeds, where the polymerized objects were not 

reliable. Outside of the mentioned range of the average laser power and scanning speed, no 

promising results were observed. The entire test grid corresponding to the experiments carried 

out in Figure 5.5 is depicted in “Appendix C: Results in optimization processes”. 

Pattern objects have been analyzed using a field emission scanning electron microscope SEM 

(EVO 10, ZEISS group). Prior to imaging, a 100 nm aluminum layer was deposited on the 

samples, and an electron beam voltage of 4 kV was applied. 

The SU-8 exhibited completely polymerized lines. In some cases, pattern objects exhibited 

broken shapes due to the polymerization being below the threshold. Consequently, the bonding 

of polymer chains was not successfully completed throughout the entire photoresist thickness, 

leaving some areas soluble to the SU-8 developer, as depicted in Figure 5.5. 
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Figure 5.5: SEM images of pattern objects exposed to 1.85 µW. The measurements 

obtained on the over-exposed, polymerized, and non-polymerized pattern objects 

correspond to different scanning speeds for a single test grid in 1PP-DLW processes. 

Non-polymerization results in either non-polymerized pattern objects, or blurred and 

indistinguishable pattern objects due to insufficient photon absorption throughout  the entire 

thickness of SU-8, i.e., the exposure dose is far below the threshold (see Figure 5.5). The laser 

intensity attenuates exponentially for small exposure doses as it penetrates in depth, as shown 

in Equation (2.3), leading to insufficient excitation of the photo-initiators required for 

photopolymerization throughout the entire thickness. As a result, these non-polymerized 

objects are unlikely to be observable during SEM analysis. Furthermore, the polymerized points 

depicted in non-polymerization micrograph of the Figure 5.5 are the result of double exposure 

during the 1PP-DLW processes and the (de-)accelerations of the motion stages. 

The over-exposure exhibits unfavorable outcomes with line widths exceeding 3 µm due to the 

uncontrolled chain reaction of monomer-radicals near the exposed area. Another issue with 

over-exposure is the effects of back reflections (multiple refraction/reflection of the laser beam 

within the substrate layers), causing undesired polymerizations and consequently reducing the 

precision and resolution of the polymerized microstructures. 

Different levels of polymerization are achieved with different scanning speeds, i.e., for average 

powers of 1.70 µW, 1.85 µW, and 2.68 µW, different results in polymerized linewidths have 

been obtained. The linewidths in Figure 5.6 exhibit exponential decays with increasing 

scanning speeds for the three mentioned power levels. Linewidths below 1 µm are not 

appreciable due to the dispersion of the data measured in the SEM. Linewidths exceeding 2 µm 

are also unacceptable due to over-exposure effects, which further increase variability in the 

SEM measurements. Therefore, well-polymerized pattern objects were successfully created in 
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the scanning speed range of 100 µm/s to 400 µm/s at 1.85 µW of laser power during this 

optimized 1PP-DLW process. 

 

Figure 5.6: a) Linewidths measured at three power values in 1PP-DLW processes. b) Fitted 

data corresponding to 1.85 µW. 

5.2. 2PP-DLW optimization on SU-8 photoresist 

The 2PP-DLW process uses the two-photon absorption (2PA) mechanism to polymerize SU-8 

[72], [209]. This technique is commonly used to fabricate high-resolution 2D and 3D 

nanostructures, achieving approximately 30 nm resolution in SU-8 [72], or less than 25 nm in 

other photoresists [23]. It is employed in the fabrication of micro-scaffolds [149], nano-needles 

[144], micro-lenses [105], liquid crystal alignment [93], and in-situ 2PP for medical 

applications [146]. 

After minimizing positioning and optical path errors in 1PP-DLW. The appropriate exposure 

time allows achieving maximum resolution in the nanometric volume formed by the laser spot 

(voxel) in the 2PP system. Therefore, optimization of scanning speed and beam power is 

primordial. 

The optimized femtosecond laser (femto laser) beam power is determined by the angle 𝜃 of the 

half-wave plate (HWP) in the 2PP setup shown in Figure 4.6 and expressed in Equation (4.10). 

It can be rewritten as follows: 

 𝑃 = 𝑃𝑚𝑎𝑥 ⋅ 𝑇𝑙𝑜𝑠𝑠𝑒𝑠 ⋅ cos
2(2𝜃 − 𝜑) (5.3) 

where 𝑃𝑚𝑎𝑥 = 250 𝑚𝑊 is the maximum average power, 𝜑 = 97.4° is the offset angle for the 

fast principal axis of the HWP installed in the 2PP system, and 𝑇𝑙𝑜𝑠𝑠𝑒𝑠 represents optical losses 

in the total transmission through all lenses and mirrors at the wavelength of 780 nm, defined by 

Equation (5.2). 
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Figure 5.7: Characteristic average powers of the 2PP setup measured and calculated from 

the control stage consisting of the half-wave plate (HWP) and polarizing beam-splitter 

(PBS). 

Figure 5.7 shows the measured and calculated femto laser beam powers using Equation (5.3). 

The beam power was measured at the entrance pupil of the OL using a Newport power meter 

(1936-R and 918D-SL-OD3R). To control the beam power, only 25 % of the total rotation range 

of the HWP has been utilized, which ranges from 0° to 45°, corresponding to a power range of 

0 mW to 160 mW in this 2PP system. 

5.2.1. Methods and materials 

Commercial 0.7 mm-thick glass ITO coated slides are also used as substrates. The 2PP setup 

description is provided in Chapter 4, where the femto laser beam is focused on the interface 

between the ITO and the SU-8 using the 50× OL with a NA of 0.80. 

The cleaning process is described in Section 5.1.1. Substrates are pre-cleaned using commercial 

acetone/2-propanol and ultrasonic immersion cleaning, dried with a nitrogen flow, baked at 200 

°C, and undergo deep cleaning with a UVO-Cleaner. SU-8 is then drop-cast onto the ITO-

coated glass surface for spin-coating, followed by a final soft-bake at 110 °C, as summarized 

in “Appendix A: Cleaning and spin-coating processes”. 

The same test grid of m×n pattern objects is used under identical conditions and configurations 

in LPS software for the 2PP-DLW process (see Figure 5.2 and Figure 5.3). The beam power 

required to cross the polymerization threshold is determined by Equation (5.3). The absorption 

probability of photons is proportional to the square of the incident intensity, making 2PA highly 

likely within the voxel of the focused laser beam rather than outside it (confined photons 

energy). 

Fine focusing into the photoresist in the air configuration of the 2PP system was employed. In 

the 2PP-DLW process, the focal spot of the OL must be placed between ITO-glass substrate 

and the spin-coated photoresist. The voxel starts polymerization at this interface and prevents 
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the polymerized objects from floating into the photoresist volume, avoiding the risk that they 

might be removed during the washing of the photoresist and that no result is obtained. 

Therefore, to achieve this focusing, coarse focusing is performed by moving the Z stage to find 

the OL’s WD with ∆ close to 0 (step one in Figure 5.8). This method has been used in 1PP-

DLW to locate the focal spot on the photoresist surface. Then, the 2PP system calculates a fine 

factor (𝐻’) to adjust the OL position downward until the laser spot is aligned with the 

photoresist-substrate interface, taking into consideration the thickness of the photoresist and the 

refractive indices of both air and the photoresist at the wavelength of the femto laser beam (step 

two in Figure 5.8). 

Fine focusing is specifically used to determine how far the laser spot needs to move downward 

for thicker spin-coated photoresists, ranging from a few microns to several hundred microns in 

air configurations mode. In “Appendix B: Fine focusing”, the description of fine focusing by 

the 2PP system is provided for better comprehension. 

 

Figure 5.8: Steps for fine focusing in the 2PP system: After determining the working 

distance (WD) of the objective lens (OL) by moving the Z stage, the 2PP system computes 

the factor (H’) to adjust the position of the OL until the laser spot is correctly positioned at 

the photoresist-substrate interface. 

After fine focusing, 2PP-DLW is performed to polymerize the pattern objects on a substrate. 

The test grid has been repeated several times on a single substrate to obtain more measurement 

data. Several substrates with the same parameters have been subjected to different laser beam 

powers to optimize 2PP-DLW process in SU-8. 

Finally, the substrates are baked at 110 °C to complete the SU-8 polymerization processes, then 

developed with PGMA by immersion, cleaned with 2-propanol, and dried with nitrogen flow, 

as summarized in “Appendix A: Cleaning and spin-coating processes”. 

5.2.2. Results 

The beam powers required to polymerize SU-8 in 2PP-DLW differ from the optimization values 

for 1PP-DLW in Section 5.1.2, for several reasons. First, the energy of a photon in near-infrared 
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(N-IR) is approximately half that of a photon at violet wavelengths [206]. Second, two photons 

must be simultaneously absorbed to excite the SU-8 photo-initiator molecules. Finally, the 

spatial and temporal concentration of photons (ultrafast pulsed beam) and high laser intensity 

increase the probability of absorption. This demands a very powerful laser beam to surpass the 

absorption threshold within the voxel volume. An average laser power from 1 mW to 160 mW 

and scanning speeds from 100 µm/s to 1000 µm/s were applied, where 300 µm/s was chosen to 

analyze the results in this section. Therefore, for this scanning speed and laser power range, 

polymerized microstructures in SU-8 were observed and summarized in Table 5.2. 

Table 5.2: Classification of powers in 2PP-DLW processes at a scanning speed of 

300 µm/s. 

Average power applied [mW] 2PP-DLW linewidth resolution [µm] 

1.0 – 88.0 No results were reliable (Un-polymerized) 

95.0 – 115.0 < 0.5 (Polymerized) 

115.0 – 150.0 > 0.5 (Polymerized) 

>150.0 ~ 1.0 (Over-exposed) 

 

It has been found that a laser beam power of 95 mW is appropriate to polymerize SU-8 at a 

speed of 300 µm/s, achieving a resolution of 301.7 nm, as depicted in Figure 5.9. The SEM 

images were obtained using an electron beam voltage of 4 kV. A 100 nm aluminum layer was 

deposited on all samples by physical vapor deposition. A complete test grid corresponding to 

the experiments is depicted in “Appendix C: Results in optimization processes”. 

 

Figure 5.9: SEM images of pattern objects exposed to 95 mW. The measurements obtained 

on the over-exposed, polymerized, and non-polymerized pattern objects correspond to 

different scanning speeds for a single test grid in 2PP-DLW processes. 
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Over-exposure yields unfavorable results with linewidths exceeding 600 nm due to excessive 

photon absorption, leading to uncontrolled chain reactions of monomer radicals formed within 

the voxel and extending beyond it. Moreover, at very high exposure times, excessively absorbed 

energy can lead to bubble formation or even voxel bursting, as illustrated in Figure 5.9, due to 

non-uniform temperature gradients toward the voxel center. Additionally, reflection effects can 

cause energy distributions in undesired areas of the SU-8. All these factors reduce the precision 

and resolution of the microstructures. 

Non-polymerization occurs when the absorbed intensity is reduced below the SU-8 threshold, 

defined as the maximum intensity at 1/𝑒2 of the half waist of a gaussian beam [39], [67], [210]. 

In these conditions, the probability of photon absorption to excite the photo-initiators is very 

low, consequently failing to initiate propagation of monomer-radicals in the exposed region. 

Furthermore, optical adjustments in the 2PP system can affect 2PP-DLW processes. For 

example, misalignment of the field of view (FOV) angle of the galvos can lead to beam clipping 

at the entrance pupil of the OL. This reduces exposure energy, resulting in non-polymerized 

areas near the edges of the OL FOV, as illustrated in Figure 5.9 for well-defined polymerized 

lines. 

Figure 5.10 shows three experiments conducted at average powers of 90 mW, 95 mW, and 115 

mW at the previously mentioned range of scanning speeds. The measured linewidth undergoes 

exponential decay with increasing scanning speed for a given power. Linewidths greater than 

0.8 µm may exhibit burnt SU-8, whereas widths less than 300 nm may indicate incomplete SU-

8 polymerization. 

 

Figure 5.10: a) Linewidths measured at three power values in 2PP-DLW processes. b) 

Fitted data corresponding to 95 mW. 

5.3. SU-8 resolution comparison 1PP vs 2PP 

Polymerization in 1PP-DLW is uniform throughout the entire thickness of SU-8 in the 

experiments carried out, whereas in 2PP-DLW, polymerization is very high within the voxel 

volume due to the high density of spatially and temporally confined photons. This enables 
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achieving high resolutions in nanoscale dimensions with appropriate exposure times, where the 

non-linear matter-light interactions is a dominant factor in SU-8. 

 

Figure 5.11: SU-8 resolution comparison of the optimization experiments. a) Linewidth of 

1PP-DLW vs. 2PP-DLW. b) Resolution relationship between 2PP & 1PP at the same 

scanning speed of 300 µm/s. 

The concentration of photo-initiators in SU-8 strongly absorbs light in the UV and violet light 

spectrum. In high optical density, the light intensity distribution undergoes exponential decay 

across the layer thickness as the light penetrates from top to bottom in 1PA. This leads to a 

limitation in the SU-8 layer thickness, approximately 2 µm in these 1PP experiments. 

When the incident light intensity is above the threshold, absorption causes a uniform light 

intensity distribution along the optical axis (thickness) of the thin SU-8 layer. This also occurs 

for low optical density interactions explained in Chapter 3. Conversely, very low light intensity 

decreases until extinction from top to bottom of the layer thickness, leading to non-polymerized 

SU-8 in the 1PP experiments. 

Figure 5.11-a shows the results of linewidth measurements from previously conducted 

experiments. Both processes were subjected to different laser powers (1.85 µW for 1PP-DLW 

and 95 mW for 2PP-DLW) due to their absorption conditions, but with the same scanning 

speeds. This allowed for comparison to observe the resolution difference in SU-8. For example, 

the average resolution achieved in 2PP-DLW is 0.39 µm compared to 1 µm in 1PP-DLW, 

highlighting a significant difference in spatial resolution between the two techniques, as 

depicted in Figure 5.11-b. 

The over-exposure and non-polymerization regions indicate that the results are unfavorable for 

both processes, where the non-polymerization region and the over-exposure region 

unachievable for extremely low and extremely high times, respectively. Additionally, the 

relationship exhibits a non-linear trend, while 1PP increases exponentially compared to 2PP. 

Therefore, it has been demonstrated that 2PP exhibits a logarithmic decrease as: 

 2𝑃𝑃𝑟𝑒𝑠 = 𝑎 ⋅ log10(𝑏 ⋅ 1𝑃𝑃𝑟𝑒𝑠) (5.4) 
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where 𝑎 and 𝑏 are experimentally defined resolution factors for different scanning speeds, and 

average laser powers at given wavelength, independent of the intrinsic properties of the 

photoresist. 

5.4. 2PP-DLW optimization on photoresists 

2PP-DLW is widely used for fabricating micro/nanostructures in commercial photoresists other 

than SU-8, such as the IP-series [93], [106], ORMO series [96], [211], SZ2080 [212], and 

SCR500 [23], among others summarized by Rajabasadi et al. [11]. Customized photoresists 

also utilize 2PP-DLW, demonstrating promising results [66], [213]. However, there are no 

reports on voxel sizes for other types of commercial photoresists, either negative-tone or 

positive-tone. This section presents optimizations of 2PP-DLW for S1800 series, Epo-Core, 

and mr-DWL photoresists, including SU-8 (2000 and 6000). 

5.4.1. Methods and materials 

Cleaned ITO-glass substrates are used to spin-coat photoresists, following the technical 

protocol for each photoresist from their datasheets, to obtain the desired thickness. “Appendix 

A: Cleaning and spin-coating processes” summarizes all steps of the spin-coating and baking 

preparation: photoresist deposition, spin cycle, thickness definition, bake times and 

temperatures, relaxation times and developing solutions. 

S1805 and S1818 positive-tone photoresists as well as SU-8 TF 6002, SU-8 2015, EpoCore 5, 

and mr-DWL 40 negative-tone photoresists have been used. All of these were obtained from 

Kayaku Advanced Materials and Micro Resist Technology GmbH [71], [80]. 

Negative-tone photoresists generate well-defined nanostructures with high resolution upon 

exposure to a laser beam. The cross-linked polymers produced by the 2PP-DLW process exhibit 

high resistance, while the unexposed portions are highly soluble in developing solutions [80]. 

Positive-tone photoresists are efficient in manufacturing hollow structures, requiring relatively 

low insolation energy and facilitating easy removal of the exposed photoresist during 

development (breaking the cross-linked polymers by 2PP-DLW process) [71]. 

A new recipe was configured in LPS software to introduce new polymerization parameters. In 

this case, 𝑛 test grids have been created within a single recipe. Each test grid is associated with 

a single scanning speed, and consists of 𝑚 pattern objects programmed with different power 

values. 

Figure 5.12 shows the pattern objects to be designed in the LPS software. Figure 5.13, shows 

the test grids programed in LPS software. In Table 5.3, the applied scanning speeds for all 

photoresists and average laser powers in these experiments can be observed. 
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Table 5.3: Processing parameters for photoresists printing. 

Photoresist Scanning speed [µm/s] Femto laser beam power 

S1805 100 – 1600 

1.6 – 160 mW 

S1818 100 – 1600 

SU-8 TF 6002 100 – 1600 

SU-8 2015 100 – 800 

mr-DWL 40 300 – 2400 

EpoCore 5 20 – 160 

 

 

Figure 5.12: 2D and 3D pattern objects to be polymerized for voxel characterization. 

For thin layers of spin-coated photoresists, specifically S1805, S1818, and SU-8 TF 6002, the 

recipe depicted in Figure 5.13 was executed to polymerize 2D pattern objects with sizes of 

40×40 µm² (see design in Figure 5.12-a). Meanwhile, for thick layers of photoresist, specifically 

SU-8 2015, mr-DLW-40, and EpoCore 5, the recipe from Figure 5.13 was reconfigured to 

program 3D pattern objects with sizes of 40×40×40 µm³ (see design in Figure 5.12-b). 



Results: Initial commissioning and optimization of the system 

79 

 

 

Figure 5.13: Programming and configuration of test grids on the LPS software front panel. 

After the 2PP-DLW process, the photoresists were post-baked, developed, and cleaned to obtain 

the solidified microstructures. Negative-tone photoresists were developed with PGMEA or mr-

DEV 600 developers, while positive-tone photoresists are developed with a microposit 

developer. 

5.4.2. Results 

The 2PP-DLW processes have shown positive results in all experiments, with well-defined 

microstructures in both 2D and 3D. 

Different polymerization and over-exposure thresholds have been identified for each used 

photoresist, depending on their intrinsic properties. For instance, S1805 and S1818 are the same 

material (photoactive compound and monomers), both highly sensitive to radiation [214]. 

However, the measured thresholds vary with thickness under standard spin-coating conditions 

(viscosity): 0.5 µm in S1805, and 1.8 µm in S1818. In comparison, S1818 has more photon-

absorbing material, making it more prone to burning at high powers levels under the same 

scanning speed conditions as S1805. Nevertheless, measured linewidth results are nearly 

identical for both photoresists. 

SU-8 TF 6002 and SU-8 2015 cannot be compared because they differ in their formulations, 

despite their common Epoxy base, such as viscosity, additives, and reactive components to 

exposure light. Therefore, exposure times vary in polymerization and over-exposure thresholds. 

X 

Y 
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The microstructures obtained on each substrate were metallized with a 50 nm thick aluminum 

deposition. Subsequently, the 2D and 3D pattern objects were analyzed using a SEM (EVO 10, 

ZEISS group), applying an electron beam voltage of 5 kV for more sensitive photoresists in 

Figure 5.15, Figure 5.16, and Figure 5.17, and 8 kV in Figure 5.18 and Figure 5.19 (for less 

sensitive photoresists). 

 

Figure 5.14: Measurement of lateral and axial voxel dimensions in 2PP. The lateral voxel 

size (xy-plane) is 654.2 nm, and the axial voxel size (z-direction) is 2.812 µm. 

The linewidths of the polymerized 2D pattern objects have been measured in all experiments 

and represent the sizes of xy sectioned voxels. In contrast, the z-voxel has been obtained by 

measuring the height of polymerized lines in negative-tone photoresists. The measured 

polymerized lines in 3D pattern objects must be separated from the ITO-Glass surface and 

supported horizontally by vertical micro-pillars, each 40 µm high at both ends and the center, 

to achieve well-defined microstructures and obtain an accurate z-voxel measurement, as 

depicted in Figure 5.18-a and Figure 5.19-a. 

The experimental voxel data versus laser power is compared with the results from numerical 

integration for curve fitting. Error bars represent the standard deviation of the averaged 

linewidths in the xy-, and z-voxel to obtain adjusted data representing the 3D voxel size trend 

across the entire power range for each scanning speed. An example of voxel size is depicted in 

Figure 5.14, where the 2PP-DLW process was carried out within negative-tone photoresists. 

Within the non-polymerization region (yellow region in the plots), no polymerized lines have 

been observed. Additionally, near the edge of this region, polymerized lines have been evident 

but were not sufficiently vertical to be measured. On the other hand, within the over-exposure 

region (red region in the plots), voxel bursts have occurred, although not uniformly across the 

polymerized pattern objects (e.g., see Figure 5.9). 
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Figure 5.15: Experimental data of the S1805 photoresist optimization. a) SEM images of 

2D pattern object polymerized. b) xy-voxel vs. laser power. 

 

Figure 5.16. Experimental data of the S1818 photoresist optimization. a) SEM images of 

2D pattern object polymerized. b) xy-voxel vs. laser power. 

 

Figure 5.17: Experimental data of the SU-8 TF 6002 photoresist optimization. a) SEM 

images of 2D pattern object polymerized. b) xy-voxel vs. laser power. 
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Figure 5.18: Experimental data of the SU-8 2015 photoresist optimization. a) SEM images 

of 3D pattern object polymerized. b) xy- and z-voxel vs. laser power. 

 

Figure 5.19: Experimental data of the mr-DWL 40 photoresist optimization. a) SEM images 

of 3D pattern object polymerized. b) xy- and z-voxel vs. laser power. 

 

Figure 5.20: Experimental data of the EpoCore 5 photoresist optimization. a) SEM images 

of 3D pattern object polymerized. b) xy- and z-voxel vs. laser power. 
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The gathered experimental data show that most of the photoresists experienced voxel bursting. 

This occurred because the exposed photo-initiators absorbed excessive photon energy beyond 

what they could withstand during the 2PP-DLW process, except for mr-DWL 40. This is 

because it is a chemically amplified photoresist, robust, and optimized for optical applications 

[80]. 

mr-DWL 40 exhibits very large linewidths without experiencing voxel bursting at high powers 

from 100 µm/s. The intrinsic properties of the photoresist (high absorption or scattering) cause 

excessive energy distributions, resulting in polymerization outside the voxel. Additionally, the 

high concentration of photo-initiators increases the probability of photon absorption, leading to 

uncontrolled polymer bonding. In contrast, EpoCore 5 shows unpolymerized microstructures 

at scanning speeds higher than 150 µm/s. To avoid this, the scanning speed was decreased (i.e., 

higher exposure time) to obtain reliable polymerized linewidths, avoiding burnt voxels during 

experiments at speeds starting from 20 µm/s. Therefore, the over-exposure edge in mr-DWL 

40 and EpoCore 5 photoresists has been represented as a sigmoidal distribution 

(𝑥𝑦𝑧‑𝑣𝑜𝑥𝑒𝑙 (1 + 𝑒𝑥𝑝 {𝛼(𝑥 − 𝛽)})⁄ ) of the maximum permissible voxel size with increasing 

scanning speed for manufacturing nanostructures using the maximum available laser beam 

power. This edge represents a limit value that can be exceeded without considering the 

resolution of microstructures with extremely elongated features. 

In “Appendix C: Results in optimization processes”, all SEM measurements of the polymerized 

2D and 3D pattern objects from the optimization experiments conducted in this chapter can be 

seen. Additionally, characterized xy- and z-voxels over a wider range of scanning speeds for 

all photoresists are presented in “Appendix D: Voxels characterization”. 

5.5. Associated challenges of the 2PP system 

During the commissioning of the 2PP system, several challenges were encountered that 

hindered the optimization of nano-positioning control systems and laser beam synchronization. 

In its first phase, the system was consisted of: 

• A non-motorized linear stage for manual focusing. 

• A controller for two linear axes. 

• Piezoelectric stages for nano-positioning in X and Y. 

• An acousto-optic modulator (AOM) for beam control. 

Additionally, limitations were identified, including instability caused by external vibrations, 

defocusing, and the lack of micrometric control, which negatively impacted direct laser writing 

(DLW) processes. 
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5.5.1. Improvements Implemented 

1. Focus Optimization 

The manual focus with the non-motorized linear stage made it difficult to maintain precision 

between substrates. To address this, a 25 mm micrometric motorized linear stage was installed 

on the Z-axis, complementing the existing Z piezoelectric stage. This allowed for automatic 

focus adjustment and significantly improved the lithography processes at the substrate-

photoresist interfaces. 

2. Controller Scalability 

The integration of additional motorized stages made the initial controller insufficient, as it could 

not manage multiple axes. It was replaced with a higher-capacity controller capable of 

managing up to 8 linear or piezoelectric axes, enabling the integration of more advanced nano-

positioning systems. 

3. Replacement of Piezoelectric Axes 

The piezoelectric stages exhibited synchronization issues with the laser beam at speeds over 

100 µm/s, affecting repeatability and causing errors in microfabrication. These were replaced 

with galvanometric mirrors, which provide nanometric positioning with low inertia, eliminating 

synchronization problems. This change allowed for an increase in lithography speed up to 2.3 

mm/s in photoresist like mr-DWL 40. 

4. Laser Beam Control Improvements 

The initial acousto-optic modulator (AOM) had insufficient efficiency, delivering only 47% of 

the laser power and limiting the maximum focus power to 78 mW. It was replaced with a higher-

efficiency AOM, resulting in an 85 % increase in power, reaching a maximum focus power of 

160 mW. 

5.5.2. Proposals for the Second Phase 

To develop a fully commercial 2PP system, the following aspects must be addressed: 

1. Structural and Stability Improvements 

Implement structures designed for optical microscopy or metal alloys resistant to vibrations and 

thermal expansion. 

2. Resolution and Focus Optimization 

Incorporate immersion objective lenses that allow for automatic changes without compromising 

focus quality or the optical path. 

3. Laser Power Increase 
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Replace the current laser with one of higher capacity that can process low-sensitivity materials 

and expand the system's material database. 

4. Field of View Expansion 

Relocate the galvanometric scanners closer to the objective lens to expand the field of view, 

currently limited to 40 µm.
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CHAPTER 6 

6. Results: Manufacturing of 2D sub-micrometric 

structures 
In recent decades, two-photon polymerization (2PP) has become the most attractive technique 

for producing functionalized devices [210]. Usually, these are produced with specific 

customized design features for their application fields. For example, nano-grids for 

manipulating THz waves in spectroscopy [215], aligned ridges in neural models [216], optical 

elements for manipulating light [217], [218], [219], and surface patterning for liquid crystals 

(LC) devices [93]. 

This chapter presents arbitrary surface alignment in complex patterns on thin layers of negative-

tone and positive-tone photoresist to create patterned polarizers in dye doped LC, which is one 

of the many applications that can be achieved using 2PP direct laser writing (2PP-DLW). The 

assembled cell based on nematic LC doped with black dichroic dyes are assessed employing 

additional standard polarizers. 

6.1. An example of 2PP application: Liquid crystal alignment 

LC alignment has been carried out for a wide range of applications in optical devices [220]. 

Surface alignment is commonly employed to control the LC molecular orientation [221]. Any 

alignment method that results in aligned LC or polymerized reactive mesogen films may serve 

in various applications, such as spatial geometric phase modulators [222], since the alignment 

layer provides precise control of 2D and 3D molecular orientation in LC cells [223]. Adding 

dichroic dyes or fluorescent dyes to the LC opens up for more applications [224], [225], [226]. 

The 2PP-DLW technique may be employed for curing photoresists and creating microstructures 

that align LCs [133], [227]. 2PP-DLW enhances the dimensional characteristics of 2D and 3D 

microstructures with nanometric resolution [9], [125]. 

2PP-DLW has been used to study the behavior and quality of LC alignment surfaces [93], [228], 

aiming to enhance the optical properties of cholesteric LCs [229] and explore innovative 

techniques for alignment in 3D structures in LC cells [227], [230].  

Anchoring and periodicity evaluation of nematic LC alignment surfaces has been carried out 

using 2PP-DLW to create complex patterns on thin layers of commercial negative-tone 

photoresists [93], and even on titanium layers on glass substrates [231]. A compartmentalized 
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alignment method for polymeric ribbons in LC has been developed [232], allowing the creation 

of relief gratings on surfaces. This method enables the production of arbitrary configurations of 

curved shapes and checkerboard patterns in microstructures. 

2PP-DLW has proven instrumental in maximizing the capacity to modify the morphological 

geometry of LC structures [233]. Notably, multi-layered LC cells (2-3 layers) have been 

designed and surface-aligned to create 3D spatial light modulators, resulting in significantly 

improved response times when compared to conventional single-layer counterparts [134]. A 

compact and transmissive multi-layer polymer-based LC device with 3D switching capabilities 

has been developed for generating holograms through voltage-induced modulation [228]. 

Finally, configurable patterns for image encryption and encoding through 2PP-DLW in LCs 

have been used in authentication and security applications. For instance, a rewriting technique 

employing 2PP-DLW and applied voltage to encode the features of a fully assembled 

polymerizable LC was employed [135]. This method ensures the local orientation of the director 

along the laser beam direction at different voltage amplitudes. 

Surface alignments are involved in many applications, particularly in the context of the 

geometric phase known as the Pancharatnam-Berry phase. Several contributions have been 

involved to create interesting planar optics devices. For example, compact see-through near-

eye displays [234], augmented reality (AR) near-eye displays based on Pancharatnam-Berry 

phase lenses [235], holographic cholesteric LC reflective lenses with high efficiency and 

polarization selectivity [236], coexisting superstructures with opposite chirality for 

Pancharatnam-Berry phase inversion in cholesteric LCs (generating reflective optical vortices) 

[237], and 2D geometric phase LC diffraction gratings (generating arrays of equi-energetic 

optical vortices) [238]. These devices, many of which are already employed in the industry are 

costly manufactured using conventional techniques [239], can be produced with 2PP-DLW 

technique, at a lower cost with increased reliability of the complex alignment in LC [108]. 

6.1.1. Liquid crystal aligning methods 

There are various methods of obtaining LC alignment, i.e., homeotropic, homogeneous, 

pretilted and intermediate alignment. 

Homeotropic alignment –i.e., an alignment where molecules align perpendicularly to the 

surface– may be achieved in several different ways. For example, coating the surface with a 

surfactant such as lecithin, which can be dissolved in ethanol or 2-propanol. The lecithin layer 

may be created by simply wiping a cloth soaked in the solution over the surface, leaving the 

polar hydrophilic parts adhered to the substrate and the hydrophobic tails perpendicular to the 

surface. Consequently, the LC molecules align parallel to the hydrophobic tails, i.e., aligning 

vertically with the surface [240]. Conventional dip- or spin-coating is adequately applied in labs 

for hydrophobic polyimide alignment [241]. 
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Homogeneous alignment –i.e., an alignment where molecules align parallelly to the surface in 

a specific direction– can be carried out with various methods to align the LC molecules planarly 

on substrates. Rubbing is a commonly used mechanical method to align LC. A polyimide layer 

is coated onto a substrate and then uniformly rubbed using a roller wrapped with a velvet cloth. 

The LC that come into contact with the polyimide adopt a degenerative azimuthal angle of the 

director within the plane of the substrate, i.e., in the direction in which the polyimide is rubbed 

[242]. Rubbing can also be accompanied by a surface pretilt, known as pretilted alignment, 

depending on the direction of the rubbing process, the type of polyimide used, and the LC. The 

pretilt angle is generally between 0° and 10° [221]. Alternatively, evaporation is a non-contact 

alignment method. It involves the oblique deposition of silicon oxide using a vacuum chamber. 

The uniform alignment direction is achieved by defining the azimuthal angle of the evaporation 

direction [243]. Thirdly, Photo-alignment is a common method used to generate customized 

patterns on alignment surfaces [244]. This technique employs polymers sensitive to ultra-violet 

(UV) radiation. When the polymer layer is exposed to polarized UV light, it becomes 

anisotropic, thereby inducing homogeneous alignment. 

Intermediate alignment is a method that combines homeotropic and planar alignment by 

employing various strategies. For example, creating a solution of two polymers that can 

individually form regions separated in phases through solvent evaporation [245]. Another 

common method involves creating patterned alignments. This non-uniform alignment is 

achieved by manipulating the surface to generate patterns with varying azimuthal alignment 

directions within either a homeotropic or planar alignment layer. Photo-alignment can create 

patterns on a single surface using a mask [246], [247], while a focused UV laser beam on the 

substrate creates smaller regions capable of aligning LC in the direction of the recording beam 

[248]. Therefore, one-photon polymerization DLW (1PP-DLW) can produce complex patterns 

without a mask, whereas 2PP-DLW adds enhanced features introduced earlier, as the central 

focus of this chapter. 

Additionally, complex surface alignment of LC has involved combining photo-alignment and 

2PP-DLW. In this case, a uniform UV exposure has been used to orient a liquid crystalline 

conjugated polymer, and 2PP-DLW has been employed to write patterns in a dye, successfully 

transferring patterns to the film through thermotropic reorientation and solidification at room 

temperature [133]. These advancements underscore the versatility and potential of 2PP in the 

realm of surface alignment and LC-based device manufacturing. 

6.1.2. Liquid crystal aligning by microgrooves 

LC alignment by 2PP-DLW allows for the fabrication of efficiently aligned microgrooves. The 

desired configuration of the microgrooves causes them to behave as effective physical guides 

for orientation [93]. Periodicity can also be used to achieve a balance between elastic energy 
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and anchoring of LC molecules [249]. Furthermore, depth and spacing can provide robust 

alignments (potential for LC reorientation from other alignment directions towards the 

microgroove direction) [250]. 

Therefore, the period of the microgrooves on a surface is a crucial factor that affects the 

direction and alignment quality. By controlling the period and depth of the microgrooves, the 

alignment of LCs can be designed and manipulated to create arbitrary polarizers with practical 

contrast [241]. In this chapter, periodic microgrooves of 1 µm with spacing and microgrooves 

depth half the period have been designed, as shown in Figure 6.1. Moreover, pretilted azimuthal 

angles of the microgrooves enable control over molecule orientations to modulate transmitted 

light in a complex pattern of a LC cell. 

 

Figure 6.1: Microgroove requirements in LC surface alignment by 2PP-DLW, where B is 

the thickness of the photoresist or microgrooves depth, A is the width of microgroove or 

linewidth, and Pt is the period of the microgrooves. 

6.2. Manufacturing methods and materials 

The patterned alignment surfaces were prepared by spin-coating photoresist on commercial 0.7 

mm-thick glass ITO-coated substrates. The indium-tin oxide (ITO) layer is nominally 130 nm-

thick and provides good and uniform adherence of the photoresist. 

Prior to spin-coating, a meticulous cleaning process was carried out. First, the substrates were 

cleaned with lint-free cloths and immersed in 2-propanol/acetone for 1 minute, followed by 

ultrasonic cleaning in deionized water for 30 minutes. They were then rinsed with deionized 

water, dried with a nitrogen flow, baked at high temperature (200 °C) for 120 minutes, and 

finally placed under deep ultra-violet light (UVO-Cleaner) for 10 minutes to eliminate any 

organic material on the substrate surface. This step makes the surface more hydrophilic, 

improving the adhesion of the deposited photoresist. 

Photoresists were drop-casted onto the ITO-glass substrate for spin-coating. A volume of 

approximately 1 ml of photoresist for each 25×25 mm² substrate was deposited manually in the 

center of the substrate using graduated pipettes. Two different types of photoresists were used: 
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SU-8 TF 6002 (SU-8) negative-tone photoresist and Shipley 1805 G2 (S1805) positive-tone 

photoresist, both obtained from Micro Resist Technology GmbH.  

The required thickness of the photoresist layer (𝐵 = 0.5 µm) must be at least five times less 

than the ideal voxel depth (axial resolution) along the optical axis as described by: 

 𝑧‑𝑣𝑜𝑥𝑒𝑙 =
2𝜆𝜂

𝑁𝐴2
 (6.1) 

where 𝑁𝐴 is the numerical aperture of the objective lens (OL), and 𝑛 is the refractive index 

(𝑛𝑎𝑖𝑟 =1.00027, 𝑛𝑆𝑈‑8 =1.58098, and 𝑛𝑆1805 =1.62451) at the wavelength of the femtosecond 

laser (femto laser) in the 2PP system. 

The SU-8 was mixed with cyclopentanone (C₅H₈O) solvent to reduce the viscosity of the 

photoresist. A mixture containing 75 wt% of C₅H₈O was used to achieve a thickness of ⁓0.5 

µm, as shown in Figure 6.2. To get this thickness the solution was ramped slowly at 100 rpm/s 

up to 500 rpm, where it spins for 5 seconds. Subsequently, it was ramped up at 500 rpm/s to 

3000 rpm and spun for 30 seconds to achieve the desired thickness. 

S1805 is specifically designed to achieve a thickness of 0.5 µm, according to the technical 

datasheet [71]. Therefore, it was spin-coated as supplied at 3500 rpm for 30 seconds, with 

acceleration ramps of 500 rpm/s. Finally, the photoresists were soft-baked at 115 °C for 1 

minute to get it ready for the 2PP-DLW. Spin-coating and baking parameters of both 

photoresists are summarized in Table 6.1. 

 

Figure 6.2: Thickness of SU-8 photoresist spin-coated onto an ITO-glass substrate. 

The LC surface alignments were fabricated by adjusting the 2PP system to setup the printing 

parameters to obtain the desired voxel diameter (xy-size) for the linewidth (𝐴 = 0.5 µm) 

requirement in this 2PP-DLW process. Hence, the femto laser beam with a wavelength of 780 

nm was focused on the air-photoresist interface using a 50× OL with an NA of 0.80, as depicted 

in Figure 6.3. 
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Figure 6.3: Schematic illustration of photoresist orientation using the two-photon 

polymerization direct laser writing (2PP- DLW). 

SU-8 has previously been used for LC alignment [232], [233]. Upon polymerization, it 

generates well-defined 3D microgrooves with high resolution and high aspect-ratio once 

exposed to the laser beam [72], [75], [251]. It exhibits high resistance to solvent, while the 

unexposed portion is highly soluble in developing solutions. S1805 is efficient in manufacturing 

hollow lines, requiring relatively small insolation energy and easy removal of the exposed part 

of the material when developed [71]. 

The S1805 results in structures inverse to those generated with SU-8 when the same exposure 

pattern is used. Both may serve as direct aligning pattens or as master molds for creating, via 

nanoimprint, LC alignment surfaces in other materials [4], [252]. Both photoresists share the 

property of being practically transparent in the visible spectrum [214]. Furthermore, SU-8, is 

thermally stable [9], [71]. 

The laser exposure energy was optimized to match the polymerization threshold levels by 

adjusting the voxel travel speed in the XY-plane and controlling the average laser power. This 

process ensures the generation of truncated voxels for both photoresists, as depicted in Figure 

6.3. Optimization steps are described in Chapter 5 to ensure the appropriate polymerization of 

the entire thickness of the photoresist. 

To execute the 2PP-DLW process, the designed patterns were loaded and programmed on 

Lasing Processing Software (LPS) based on programmable Recipes. LPS software allows 

patterning parameters on photoresists in function of scanning speed and average laser power. 

After the polymerization, SU-8 was post-baked at 115 °C for 4 minutes in order to complete 

the cross-linking process. The S1805 does not need any post-bake, although it can be used to 
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harden unexposed photoresist before the developing process. The post-exposure processes were 

determined empirically and summarized in Table 6.1. 

Table 6.1: Spin-coating and baking parameters of photoresists and polyimide deposition. 

Material 

Spin-coating parameters Baking parameters 

steps 
Speed 

(rpm) 

Acceleration 

(rpm/s) 

Time 

(sec) 
Soft-bake Post-bake 

SU-8 + 

C5H8O 

1/2 500 100 5 
1 minute at 115 °C 4 minutes at 115 °C 

2/2 3000 500 30 

S1805 1/1 3500 500 30 1 minute at 115 °C 4 minutes at 115 °C 

PI2525 
1/2 500 100 5 

5 minutes at 80 °C 60 minutes at 250 °C 
2/2 2500 500 30 

 

Finally, the substrates were developed by submerging them into photoresist developer 

(PGMEA developer for SU-8 and Shipley developer for S1805) for 10 seconds and 30 seconds 

respectively, then cleaned for 30 seconds (2-propanol for SU-8 and deionized water for S1805) 

and dried using nitrogen flow. 

6.3. Development of liquid crystal patterned polarizers 

Alignment patterns with a pitch (Pt) of 1 µm and a linewidth (A) of ~0.5µm in 25×25 µm² area 

per pattern, as shown in Figure 6.4, are employed. The chosen microline aspect ratio, width and 

pitch has previously been employed in the group for nano-imprint alignment of LC. The 

microlines of a printed pattern were generated using vectorial plotting at any given alignment 

angles (𝜑) resulting in nicely define structures as seen in Figure 6.5 and Figure 6.6. 

 

Figure 6.4: Definition of pitch (Pt) and linewidth (A). 

To assess the fidelity of the polymerized surface, the actual widths of the fully resolved 

microlines/microgrooves were previously measured using electronic microscopy. In order to 
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analyze the actual topology of the alignment layer, a 100 nm thick layer of gold was deposited 

on all polymerized photoresist, and an electron beam voltage of 8 kV was applied. 

The photoresist exhibited perfectly polymerized microlines with a repetitive periodicity (~1 

µm) in all directions, as depicted in Figure 6.5 and Figure 6.6. In Figure 6.7, perfectly defined 

microlines are observed in the printing directions of 0 and 𝜋/2 radians (90°) on both 

photoresists, while in the other directions, microlines exhibit slightly less perfection. The 

scanning electron micrographs show patterns with microgrooves of 0.5 µm width and polymer 

microlines with a depth of 0.5 µm, and a pitch of 1 µm. These structures enable the arbitrary 

surface alignment of patterned LC. Fully patterned surfaces in both photoresists were measured 

for polymerized microline/microgroove patterns, as shown in “Appendix E: Results in surface 

alignment”. 

 

Figure 6.5: Scanning electron micrographs of polymerized microline patterns in directions 

of 0, 2𝜋/9 (20⁰) and 𝜋/2 (90⁰) on SU-8 photoresist. 
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Figure 6.6: Scanning electron micrographs of polymerized microgroove patterns in 

directions of 0, 7𝜋/18 (70⁰) and 𝜋/2 (90⁰) on S1805 photoresist. 

 

Figure 6.7: Scanning electron micrographs in 3D visualization of the printed patterns for 

both photoresists (top: SU-8, bottom: S1805). 
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6.3.1. Patterned polarizer design 

Patterned polarizers have been prepared with the 2PP-DLW printing microlines and 

microgrooves at different angles defining the molecular orientation (𝜑). Nematic LC (5CB, 

Merck) doped with 2.0 wt% of black dichroic dye (D8, Mitsui Chemical Inc.) was used. LC 

cells were fabricated by assembling two ITO-glass substrates. One of the substrates was 

patterned using 2PP-DLW, while the other was coated unidirectionally rubbed polyimide 

(PI2525) to achieve a homogeneous planar orientation. The polyimide was spin-coated to obtain 

an average 200 nm uniform layer thickness, followed by soft-baking at 80 °C for 5 minutes, 

and cured by post-baking at 250 °C for 60 minutes. The spin-coating conditions for all aligning 

surfaces are listed in Table 6.1.  

 

Figure 6.8: Representation of an assembled LC cell. 

A simple cell structure with an LC alignment pattern is shown in Figure 6.8, where 2PP-DLW 

printed microline directions are shown on the lower substrate, while the polyimide rubbing 

direction is indicated on the top substrate. The 2PP-DLW aligned LC molecules, parallel to the 

microgrooves in the lower substrate, and the LC molecules aligned parallel to the polyimide 

rubbing direction on the top will generally cause twist orientations of the LC in different 

patterns of the cell. This configuration resembles to some extent a conventional twist-nematic 

cell [253], although the device is actually a guest-host system [254]. 

The cell gap was determined by silica bead spacers of 14 µm, which must obey the Mauguin 

condition for the thickness of the LC cell, where: 

 
2𝑑∆𝑛

𝜆
≫ 1 ⇔

𝜆

2
≪ 𝑑Δ𝑛 (6.2) 

where 𝑑 is the cell thickness and ∆𝑛 = 𝑛𝑒 − 𝑛𝑜 is the birefringence of LC 5CB at the 

wavelength of light incident on the LC cell, in this case within the sensitive range of the human 

eye. 
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The cells were filled with the LC and sealed and examined under a polarized microscope 

(MDi8, Leica) equipped with a digital camera (D3400, Nikon) and standard linear polarizers. 

6.3.2. Results in SU-8 

Cells with dichroic dye-doped LC, mounted as sketched in Figure 6.8, scale transmission 

images when linearly polarized light is incident on the 2PP-patterned surface. The uniformly 

rubbed surface, with known LC alignment direction, confirmed that the absorbing polarization 

coincided with the LC director. When the alignment angle of the LC (𝜑), and thus the guest 

dichroic dye, coincides with that of incident light polarization, a minimum light will be 

transmitted [254], while if the incident polarization is perpendicular to the alignment angle, a 

maximum of light will be transmitted. For any other 𝜑 an intermediate fraction of the light will 

be transmitted. 

 

Figure 6.9: Comparison of a set of the 10 patterns of a SU-8 aligned patterned polarizer 

that defines 10 grayscale levels in LC cells as a function of the alignment angles (𝜑) with 

incoming vertical polarization for all patterns. 

In a single LC cell, 10 distinct patterns of parallel microlines have been defined and printed 

under identical conditions. Each pattern, 𝑛, is characterized by an alignment angle 𝜑𝑛 =

(
𝜋

18
) × {(𝑛 − 1)|1 ≤ 𝑛 ≤ 10}, as shown in Figure 6.9.  The 10 different 𝜑𝑛 values result in 

varying light transmission of the assembled cell when illuminated by linearly polarized white 

light from the patterned side. The nanostructured texture is reflected in visible variations in the 

light transmission, confirming that the dye and LC are aligning parallel to the engraved 

microlines, as seen in previous studies [232], [233]. 
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The 2PP structure in SU-8 exhibits good alignment of the LC with a high repeatability in all 

directions uniformly across the individual alignment patterns. The transmitted intensities of the 

patterns, shown in Figure 6.9, were measured, and the grayscale transmission obeys Malus’ 

law, defined in the Equation (4.1), as shown in Figure 6.10. The measurements were taken with 

the patterned polarized backlit with vertically polarized light. The polyimide rubbing direction 

(RD) of the other substrate (RD) does not affect the transmission of the light. 

 

Figure 6.10: Condition of Malus' law for the measured patterns of an LC cell in SU-8. 

Crossed polarization (𝑃⊥) of the standard polarizer with respect to the rubbed polyimide 

substrate implies that the patterns obey the equation 𝐼0 𝑐𝑜𝑠
2(𝜑), while parallel polarization 

(𝑃||) of the standard polarizer with respect to the rubbed polyimide substrate for the same 

patterns follows the phase-shifted equation 𝐼0 𝑐𝑜𝑠
2(𝜑 + 𝜋/2). 

In Figure 6.11, a patterned polarizer with patterns arranged in a chessboard-like configuration 

is shown, together with ascending/descending grayscales. A visible edge between adjacent 

patterns can be appreciated, corresponding to the inter pattern space in the design as seen in 

Figure 6.4. 
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Figure 6.11: Optical micrograph of the entire pattern employed in the dichroic dye-doped 

LC cell with chessboard pattern and the 10-step grayscale repeated twice. The grayscale of 

the transmitted light of the patterns was defined by the alignment angle (𝜑). 

The quality of the patterned polarizers in the LC cells has been quantified by the contrast ratio 

(CR) [93]. The transmitted light intensities were quantified using a NIKON D3400 camera 

configured with sensibility ISO-400, with exposure time of 1/125 seconds and 1/30 seconds. 

Subtracting the average minimum intensity transmitted by the standard crossed polarizers, 

denoted as (𝐼𝑏̅𝑘𝑔𝑟), with the microscope precisely focused onto a glass surface, the following 

CR was calculated: 

 𝐶𝑅 =
(𝐼𝑚̅𝑎𝑥,𝑚𝑒𝑎𝑠 − 𝐼𝑏̅𝑘𝑔𝑟)

(𝐼𝑚̅𝑖𝑛,𝑚𝑒𝑎𝑠  −  𝐼𝑏̅𝑘𝑔𝑟)
 (6.3) 

where 𝐼𝑚̅𝑎𝑥,𝑚𝑒𝑎𝑠 is the average transmitted light intensity by the brightest pattern, and 𝐼𝑚̅𝑖𝑛,𝑚𝑒𝑎𝑠 

is the minimum average transmitted light intensity by the darkest pattern. This resulted in a 

normalized CR of 14 for SU-8. 

The uniformity of the pattern in the LC cells has been analyzed by employing image entropy 

(H) [255]. This parameter measures the disorder in the intensity distribution and provides 

insights into uniformity of the molecular orientation within the microgrooves formed after 2PP-

DLW. The disorder was calculated using the Shannon expression: 

 𝑆(𝐼) =∑𝑃(𝐼) × 𝑙𝑜𝑔2(𝑃(𝐼))

𝑁

𝐼=0

 (6.4) 
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where 𝑃(𝐼) is the probability of the occurrence of intensity 𝐼 within the pixel pattern area and 

𝑁 is the number of intensities measured within the same pixel pattern area. 

The uniformity distribution is normalized, dividing the 𝑆(𝐼) computed as disorder measured by 

the maximum entropy of pixel pattern 𝑚𝑎𝑥(𝑆(𝐼)) when all intensities are equally likely to 

occur (𝑃(𝐼) = 1/𝑁). Thus Equation (6.4) becomes: 

 𝐻(𝐼) = −
𝑆(𝐼)

𝑙𝑜𝑔2(𝑁)
× 100% (6.5) 

Here, 𝐻 ≈  0 % denotes perfect uniformity, while 𝐻 ≈  100 % shows a random intensity 

variation of the image pixels. Figure 6.12 shows the uniformity of each of the 10-pixel patterns. 

All the patterns show similar disorder under both parallel and crossed polarization, although 

each introduces a different twist in the LC cell, indicating a strong azimuthal anchoring. 

𝐻 was calculated over an area of 25×25 μm² corresponding to 200×200 pixels² per pattern. The 

degree of disorder 𝐻 is approximately 35 %, representing around 65 % of the uniformity. 

 

Figure 6.12: Grayscale pattern entropy (𝐻) of dichroic dye-doped LC cell in SU-8 aligned 

patterned polarizer. Parallel polarization (𝑃||) and crossed (𝑃⊥) of the standard polarizer 

with respect to the rubbed substrate. 

6.3.3. Results in S1805 

The same cell structure and analysis have been performed on S1805. In this case a 3.2×3.2 mm² 

logotype of CEMDATIC of UPM has been patterned instead of the checkerboard structure. The 

alignment of the LC molecules and dye is parallel to the orientation of the microgrooves cut in 

the S1805. 
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Figure 6.13 shows photos of the dichroic dye-doped LC cell backlit with polarized light incident 

onto the uniformly rubbed and patterned alignment surfaces respectively. The discrete 2PP 

aligned areas are clearly visible, with a visibly high contrast. In Figure 6.14, the original 

pixelated image and measurements of the transmitted light intensities in the doped cell are 

shown with the incident light polarization parallel to the alignment direction in the text 

(appearing dark text on bright background) or perpendicular hereto (appearing bright text on 

dark background). 

 

Figure 6.13: Photos taken of the sample backlit with polarized light. Left: Light incident 

onto the uniformly rubbed surface. Middle and Right: Light incident onto the patterned 

surface, where recognizable features are clearly visible in separate aligned regions. 

 

Figure 6.14: Original logotype used in the LC cell, and optical micrograph with a standard 

polarizer placed in parallel (𝑃||) and crossed (𝑃⊥). The alignment angles (𝜑𝑛) are labeled to 

distinguish the grayscale of the transmitted light of the patterns. 

The normalized contrast ratio (CR) was of 37 for the measurements using Equation (6.3). 

As Equation (6.5) the normalized Shannon entropy (𝐻) of the intensity distribution of grayscale 

patterns, has been used to assess the alignment quality. In this case 𝐻 was also calculated over 

an area of 25×25 µm² (200×200 pixels²/pattern). 
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Figure 6.15 shows the degree of disorder in the intensity distributions, approximately 37 %, 

representing 63 % of the uniformity in the doped LC. The repetition rate of the laser pulses was 

too slow for the scanning rate, leading to imperfect alignment microgrooves. Even so the 

resulting structure aligned the LC. Table 6.2 presents a summary of the alignment quality for 

S1805 compared with its counterpart SU-8, both subjected to the same analysis conditions. 

 

Figure 6.15: Grayscale pattern entropy (H) of LC cell in S1805 aligned patterned polarizer. 

Parallel polarization (𝑃||) and crossed (𝑃⊥) of the standard polarizer with respect to the 

rubbed substrate. 

Table 6.2: Alignment quality comparison (CR and H) for both SU-8 and S1805 alignment 

surface. 

Alignment Quality SU-8 alignment S1805 alignment 

Normalized CR 14 37 

Entropy (H) 
35 ±3.1 % 

65 % of uniformity 

37 ±5.3 % 

63 % of uniformity 

 

S1805 photoresist is an option for creating patterned polarizers in doped LCs. The patterning 

processes in large-sized LC cells is significantly faster in S1805 due to its high photo sensitivity 

(62 minutes of 2PP-DLW processing at a scanning speed of 6 mm/s) compared to SU-8 

photoresist for the same CEMDATIC logotype (205 minutes at 1 mm/s). 
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CHAPTER 7 

7. Results: Manufacturing of 3D sub-micrometric 

structures 
Printing at extremely high resolutions for creating complex polymeric structures for nanoscale 

applications and advanced photonic devices [156] is a challenging task.  Two-photon 

polymerization (2PP) is the most precise technique employed for manufacturing 

micro/nanostructures with resolution below 50 nm [158]. Thus, the 2PP direct laser writing 

(2PP-DLW) method has commonly been used to fabricate complex 3D microstructures in a 

variety of polymers, ceramics, and acrylates [19], [22], [256]. Photosensitive materials such as 

polymers, nanocomposites, and hydrogels have been synthesized, developed, and widely used 

to fabricate functional 3D components [24], [257]. Additionally, dimensional manipulation of 

materials using 2PP-DLW is key to 2.5D and 3D manufacturing processes [2], [99]. 

In this chapter, manufacturing of high-resolution microstructures in polymeric negative-tone 

photoresist is revised. The microstructures are fabricated using both 2.5D conventional printing 

technology (layer-by-layer) and true 3D printing technology. The nanoscale feature sizes 

achieved with the custom 2PP system can be used for advanced applications such as photonic 

integrated circuits, optical coupling, micro-scaffolds, micromachines, and many others. 

7.1. 2.5D microstructures results 

The 2PP system illustrated so far in this work was used for manufacturing 2D microstructures 

by 2PP-DLW for surface alignment in liquid crystal polarizers, as developed in Chapter 6. 

Three-dimensional microstructures are widely explored in long wide of applications e.g. 

microfluidic [139], [145], [149], photonic wire bonding [117], [118], [119], and microlenses 

[103], [104]. The spatial resolution of the microstructures inside the photoresists is key to the 

photo-chemical reaction technique [39], [67], [175], [258], [259], 2PP processes [260], [261], 

and focusing configurations [31], [181]. The nanostructures molded by 2PP-DLW can be 

considered as an orderly arrangement of interconnected volumetric pixels (voxels) in space, 

formed by the beam focused inside the photoresist [156]. The shape of the voxel, often 

spheroidal, depends on the numerical aperture (NA) of the objective lens and can be regarded 

as the fundamental building block of a manufactured microstructure. The effect of the NA, 

which increases the resolution of the microstructures, is described in Chapter 3. 
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Manufacturing of 2.5D microstructures was made using slicing, layer-by-layer scanning 

technology. This traditional technology, commonly applied by commercial systems such as 

Nanoscribe [32] or UpNano [34], employs the displacements of the Z stage along the optical 

axis of the microstructure. 

2.5D polymeric microstructures created by computer-aided design are often used. Laser 

processing software (LPS) used so far is designed to be fed into the custom 2PP system, 

featuring the transcription of 2.5D design data. The process of converting 2.5D design data in 

LPS software is called slicing. This process involves dividing a microstructure into layers in 

the XY-plane, which can then be used to recreate the 3D microstructures. The two-dimensional 

data from design layers define the movement of the focused laser beam across the field of view 

(FOV) of the system, with processing properties that enable the creation of accurate 3D 

microstructures. 

 

Figure 7.1: An example of layer-by-layer scanning description in 2PP-DLW. The red voxel 

represents the progression of the laser during the fabrication of microstructures. 

During the 2PP-DLW processes shown in Figure 7.1, the layers are fabricated through x- and 

y-axis movements while the laser is synchronized and turned on/off between layers of the 

microstructure. After each completed layer, the voxel moves up along the optical axis, jumping 

the distance between layers. This leads to a slow progression of fabrication. 

In the processes described in Figure 7.1, the laser focus spot is directed to the interface between 

the substrate and the photoresist, as depicted in step one. The laser is then turned on, and the 

voxel moves along the length and width of the first layer (in the XY-plane) at a defined scanning 

speed, as depicted in step two. After completing the layer, the laser is turned off, and the laser 

focus spot is adjusted to the next layer, as shown in step three. The laser is turned on again, and 

the voxel moves along the second layer. These processes are repeated as many times as needed 
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to complete the entire 3D microstructure, whether using just the contour method or the filled 

method in LPS software, as depicted in step four. 

7.1.1. Design of 2.5D microstructures 

A WordArt block was designed for these experiments. A recipe file generated by the LPS 

software contains pseudo-algorithms of the CAD design shown in Figure 7.2-b. This design 

was selected to demonstrate the ability of the 2PP-DLW processes to create solid 3D 

microstructures with high filled surface roughness. 

In these experiments, the 2.5D microstructure consists of layers that were repeated three times 

along the Z-axis to be fabricated. Each layer was designed to produce a solid microstructure by 

filling the layer with lines – a process known as hatching. The hatching consists of lines 

repeated and distributed equally within the layer. The hatching factor within the layers is 

defined by the voxel resolution in the x- and y-dimensions, while the distance between layers 

is determined by the z-height of the defined voxel – also referred to as voxel depth. 

The microstructure layers were controlled by adjusting the average laser power and scanning 

speed. The xyz-voxel sizes used to define the hatching parameters for SU-8, mr-DWL, and 

other photoresists are summarized in “Appendix D: Voxels characterization” for microstructure 

designs and replotted in Figure 7.3 for these experiments. 

 

Figure 7.2: 2.5D microstructure in LPS software. a) Description of printing layers with a 

hatching factor of 0.5 µm and a z-jump factor (layer separation) of 3.1 µm, defined by the 

voxel diameter and depth. b) Design of a 2.5D microstructure (letters: LASING S.A.) used 

for the experiments. The design dimensions are 500×57×9.3 µm³, applying the hatching 

factor and layer separation. 

Prior to being exposed to the 2PP-DLW processes, ITO-glass substrates are meticulously 

cleaned and then spin-coated with photoresist, which is applied by drop-casting onto the ITO 

layer. Two types of photoresists were used: SU-8 2015 (SU-8) and mr-DWL 40 (mr-DWL). 

Both were spin-coated to achieve a thickness of 40 µm on substrates. Substrate preparation 
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parameters for both photoresists are provided in “Appendix A: Cleaning and spin-coating 

processes”. 

SU-8 is commonly used to create 3D microstructures with high aspect-ratio [75], while mr-

DWL, which is chemically similar to SU-8 [262], has been specifically tested for 3D 

microstructure polymerization using commercial 2PP systems [71]. Both photoresists are 

highly transparent to visible light and thermally stable. 

During the 2PP-DLW process, the microstructures were replicated several times on the same 

substrate. The resolution in voxels can be determined by precisely controlling the average laser 

power and scanning speed. This parameter (resolution in voxels) differs from one photoresist 

to another. In order to quantify the achievable voxel size, the scanning speed of the XY-plane 

was set to 100 µm/s in SU-8 and 300 µm/s in mr-DWL. This resulted in an xy-voxel size of 0.5 

µm and a z-voxel size of 3.1 µm for both photoresists, as shown in Figure 7.2-a. The 

characterized voxel size of SU-8, corresponding to these experiments, is illustrated in Figure 

7.3. The jumping speed in the Z direction was set to 100 µm/s. This value may differ because 

the z-jump factor, defined by the distance between two consecutive layers, is related to the z-

voxel size at scanning speed of the XY plane. The average power was set to 70 mW in SU-8 

and 22 mW in mr-DWL for the fixed scanning speed. 

 

Figure 7.3: Definition of voxel size in SU-8 and mr-DWL photoresists for these 

experiments, using a 50× objective lens with a numerical aperture (NA) of 0.8. The 

expressed voxel resolution in the plots is defined at 100 µm/s and 300 µm/s for SU-8 and 

mr-DWL photoresists. 

After the polymerization, the samples were placed on a hotplate to complete the polymerization 

of the microstructures through post-baking. Relaxation times  following soft-baking and post-

baking in mr-DWL photoresist are needed [80], with cooling at room temperature, 

approximately 21 °C and 40–60 % relative humidity. The substrates were then washed to 

remove the unexposed photoresist by submerging them in PGMEA for SU-8 and mr-DEV 600 

for mr-DWL. 
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7.1.2. Scanning electron microscopy characterization 

The substrates were coated with a 50 nm layer of aluminum by physical vapor deposition before 

being measured using scanning electron microscopy (SEM) at 8 kV in SU-8 and 5kV in mr-

DWL photoresist, taking care not to burn the samples (EVO 10, ZEISS group). 

The hatching factor was evaluated in the microstructures, and the xy-voxel size was measured, 

yielding values for the characterized voxels of both photoresists. Figure 7.4 shows the voxel 

sizes on the coated surface of a photoresist, with an xy-size of 592 ± 60.21 nm. The values are 

close to that of the defined in Figure 7.3. 

SEM micrographs of the resulting SU-8 microstructure show correctly polymerized 2.5D 

microstructures, with the measured dimensions shown in Figure 7.5. 

 

Figure 7.4: Measurements of the hatching factor (xy-voxel size) in SU-8 photoresist. 

 

Figure 7.5: Scanning electron micrographs of an entire 2.5D microstructure in SU-8 2015. 

The xy dimensional characterization was measured, showing sizes as predicted in the CAD 

design in Figure 7.2. The voxel shape predicted by the microstructure was also observed to 

become more deeper (> 3.1 µm), and the height of the entire structure resulted higher than the 

CAD design (> 9.3 µm). This was because the presence of travel errors in the Z stage 

(piezoelectric), which resulted in a displacement of approximately 1.5 µm for every micron of 

movement in the Z-axis. Additionally, hatching can cause an accumulation of energy outside 

the voxel, leading to polymerized structures that are thicker than expected. 
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Figure 7.6: Scanning electron micrographs of the measured 2.5D microstructure with the 

applied voxel sizes in SU-8 2015. 

Figure 7.6 shows a well-polymerized 2.5D microstructure. Approximately half of the first layer 

was polymerized because the laser focus spot was placed at the interface between the ITO-glass 

and the photoresist. 

 

Figure 7.7: 2.5D microstructure used for the experiments. a) The design dimensions are 

232×29×9.3 µm³, with a hatching factor of 0.5 µm and a z-jump factor (layer separation) 

of 3.1 µm. b) Scanning electron micrographs of an entire 2.5D microstructure in mr-DWL. 

The design was developed in LPS software. 
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The custom 2PP system was adjusted based on the measurement results. A new WordArt block 

was designed under the same conditions for layer separations and voxel size as defined in Figure 

7.3 in LPS software for experiments using the mr-DWL photoresist, as shown in Figure 7.7-a. 

SEM micrographs of the mr-DWL photoresist also show well-polymerized microstructures. 

The xyz dimensional characteristics were measured, and the sizes correspond to those predicted, 

as shown in Figure 7.7-b. 

Table 7.1: XYZ dimensions measurements of the microstructure in both photoresists. 

Photoresist Design [µm] Measured [µm] 

SU-8  

x = 500 

y = 57 

z = 9.3 

x = 501.4 ± 1.97 

y = 57.2 ± 0.33 

z = 11.7 ± 4.03 

mr-DWL 

x = 232 

y = 29 

z = 9.3 

x = 233.9 ± 2.68 

y = 29.9 ± 1.37 

z = 9.98 ± 0.96 

 

Table 7.1 summarizes the designed and standard deviation of measured dimensions of the 

microstructure in the X, Y, and Z axes for both photoresists. 

7.1.3. Surface roughness analysis 

In the 2PP-DLW process, SU-8 and mr-DWL photoresists were cured during the voxel tracing, 

and 2.5D microstructures on substrates were analyzed by measuring the roughness on the 

microstructure surface. The voxel tracing is the primary parameter that affects surface 

roughness [263]. The distance between voxels during polymerization, defined by the hatching 

factor, allows surface roughness to be controlled by adjusting the voxel diameter. Thus, an 

atomic force microscope (AFM) was used to quantify the surface roughness (PicoLE, 

Molecular Imaging). Measurements were taken at selected depths using a 10 nm radius silicon 

tip on each 2.5D microstructure. Scanned surfaces were 5×5 μm with a resolution of 256×256 

points. Three measures per each scanned microstructure were carried out. 

The surface roughness is defined by three parameters in this work: average roughness, root-

mean-square roughness, and skewness roughness. 

The average roughness (𝑅𝑎) represents the mean value of the absolute values of the height 

deviations of the surface relative to a mean value over the evaluation length [264], given by: 

 𝑅𝑎 =
1

𝑁
∑|𝑧𝑖 − 𝑧̅|

𝑁

𝑖=1

 (7.1) 

where 𝑁 is the number of surface points of a total scanned surface, 𝑧𝑖 is the height of each point, 

and 𝑧̅ is the mean height of the surface.  
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The root-mean-square roughness (𝑅𝑞) is the standard deviation of the height values of the 

surface relative to the mean value over the evaluation length and is given by: 

 𝑅𝑞 = √
1

𝑁
∑(𝑧𝑖 − 𝑧̅)2
𝑁

𝑖=1

 (7.2) 

The skewness roughness (𝑅𝑠𝑘) is a statistic parameter and describes the distribution asymmetry 

of the heights with respect to the mean value, given by: 

 𝑅𝑠𝑘 =
1

𝑅𝑞
3𝑁
∑(𝑧𝑖 − 𝑧̅)

3

𝑁

𝑖=1

 (7.3) 

The roughness reveals a surface characterized by nanogrooves fabricated by lines due to the 

voxel effect of a femtosecond laser (femto laser), inherent to the hatching factor in the 

manufacturing process. Nevertheless, the roughness can be reduced by adjusting the laser 

tracing with an adapted exposure dose and incorporating roughness parameters (e.g., 𝑅𝑠𝑘 and 

𝑅𝑎) into the 2PP system, allowing for the control of smooth surfaces in 2.5D and 3D 

microstructures, achieving values close to those of highly commercial systems in 2PP 

lithography (< 10 nm). In Table 7.2, the roughness of both photoresists used in these 

experiments can be observed, showing lower values in SU-8 compared to mr-DLW subjected 

to the same voxel conditions. Figure 7.8 shows the surface roughness measurement on SU-8 

microstructures. 

 

Figure 7.8: Micrographs taken from surfaces of microstructures polymerized with SU-8 

photoresist. SEM micrographs (left); AFM micrographs for measuring roughness (right). 

Table 7.2: Roughness evaluation of the 2.5D microstructure surfaces. 

Roughness SU-8 mr-DWL 

𝑅𝑎 22.72 nm 45.61 nm 

𝑅𝑞 28.98 nm 57.74 nm 

𝑅𝑠𝑘 -0.3751 0.1229 
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The evaluation difference between the two photoresists is related to their intrinsic properties, 

which are not evaluated in this work, but may be considered to increase accuracy in obtaining 

microstructures more efficiently. 

7.2. 3D microstructure results 

High viscosity of the photoresists is one of the keys to producing true 3D microstructures that 

float within the photoresists during photopolymerization processes [160] exploited for 

manufacturing using 2PP-DLW. Consequently, three-dimensional movements of the voxel 

freely inside the volume of the photoresist can be applied, eliminating the traditional layer-by-

layer printing technology and ensuring the microstructure architecture [9], [125], [164], [265], 

[266]. 

The process of converting 3D design data is called volumetric additive manufacturing (VAM) 

[267], which may be easily carried out [268], using 3D 2PP-DLW. This novel manufacturing 

process allows rapid, freeform, layer-less 3D printing. 

3D microstructures can be manufactured at all points within the photoresist volume, involving 

three-dimensional vectorial processing. The 3D design data in LPS software defines the 

movements of the focused laser beam at any point to start the 2PP-DLW process, with 

processing properties to recreate the 3D microstructure. 

 

Figure 7.9: An example of 3D scanning description in 2PP-DLW. The point represents the 

initial and final progression of the laser during the fabrication of microstructures. 

In the simple process described in Figure 7.9, the laser focus spot might start at any point 

directly at the interface between the substrate and the photoresist, as depicted in step one. 

However, it could also be initiated from any vectorial point defined by the 3D design far from 

the substrate (as shown in step three). The laser is then turned on, and the voxel is moved along 
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the spin-coated photoresist volume (xyz scanning directions), as depicted in steps two and three. 

The laser is correctly synchronized to turn on and off at the processing of vectorial points (P₀ – 

P₅) of the microstructure to avoid unwanted polymerized parts. The voxel follows all points, 

connecting them with polymerized microlines, which describe the 3D design of the 

microstructure, as depicted in step four. 

7.2.1. Design of 3D microstructures 

Applying the concept of 3D 2PP-DLW to microstructures, the CAD designs illustrated in 

Figure 7.2 and Figure 7.7 were redesigned. In this case, the layers were tilted 35º and 90º with 

respect to the y-axis (surface substrate), as depicted in Figure 7.10. The layer dimensions in 35º 

tilted microstructures were kept in both photoresists, while the layer dimensions in the 90º tilted 

microstructures were reduced to confine the designs within the spin-coated photoresist volume. 

In the 90° tilted microstructures, fourteen layers were added to prevent collapse during the 

development process due to their aspect ratio, which is approximately 10:1 [269]. The printing 

strategy applied to make 3D microstructures is illustrated in Figure 7.10-a and -b.  This 

approach allows defining the xyz printing directions of all points in the designs at a defined tilt 

angle. Each tilted layer used the hatching method, as defined by the voxel sizes shown in Figure 

7.3 for both SU-8 and mDWL photoresists. The separation between tilted layers was defined 

by the voxel depth of 3.1 µm for the 35º tilted microstructure, depicted in Figure 7.11-a, and by 

the voxel diameter of 0.5 µm for the 90° tilted microstructure, depicted in Figure 7.11-b. 

 

Figure 7.10: Description of printing layers (2.5D microstructure strategy) with a hatching 

factor of 0.5 µm and a z-jump factor (layer separation) of 3.1 µm, defined by the voxel 

diameter and depth. 
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Figure 7.11: Redesign of a 3D microstructure (WordArt: LASING S.A.) used for the 

experiments: a) 35º and b) 90º tilted microstructure. The design was developed in LPS 

software with the applied hatching factor (voxel sizes) in SU-8 2015 and mr-DWL 40 

photoresist. 

7.2.2. Scanning electron microscopy characterization 

SEM micrographs show well-polymerized 3D microstructures. The angles of the tilted layers 

were measured, and the values are close to those predicted by the CAD design, as shown in 

Figure 7.12. Table 7.3 summarizes the angle measurements and the standard deviations of the 

tilted layers of the microstructures for both photoresists. Completed SEM micrographs of 3D 

microstructures and their dimension measurements can be found in “Appendix F: Results in 3D 

microstructures”. 

Table 7.3: Angle measurements of the tilted microstructure in both photoresists. 

Photoresist Design [deg.] Measured [deg.] 

SU-8 
35 

90 

36.9 ± 2.61 

89.5 ± 0.78 

mr-DWL 
35 

90 

35.6 ± 0.85 

90.7 ± 0.92 

 

It can be concluded that the custom 2PP system developed in this project effectively produces 

2D, 2.5D, and 3D microstructures. The standard deviations of the dimensional structures are 

minimized, and the variability depends on the calibration of the system, especially the 

mechanical stages. These introduce errors in positioning and (de-)accelerations of the stages 

during the printing processes. Hence, they must be thoroughly calibrated to ensure 100% 

reliability of the system, both in hardware and software. 
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Figure 7.12: 3D microstructure measurements in both SU-8 and me-DWL photoresists. a) 

The tilted layer is at 35º. b) The tilted layer is at 90º. 

7.3. Micro-scaffolds for bio-applications 

Micro-scaffolds are widely used, with mechanical and chemical resistance being crucial 

features for specific applications, such as in biological and medical fields [15], [149], [270], 

[271]. They are also useful for evaluating new polymers for photonic devices  [272]. For this 

reason, micro-scaffolds cannot be overlooked, and are designed to pave the way to systematic 

studies of multidisciplinary applications, aligning with the research interests of the UPM and 

the company Lasing S.A. These include micro-fluidics and tissue engineering applications 

[273], [274], [275], using the custom 2PP system presented in this project. 

 

Figure 7.13: Micro-scaffolds for test grids optimization (40×40×40 µm³) in SU-8 carried 

out in Chapter 5. 

40 µm 
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Micro-scaffolds for characterizing voxel sizes were previously introduced in Chapter 5. The 

obtained results serve as an introduction to the design of 3D microstructures, as depicted in 

Figure 7.13. To extend the 3D polymeric microstructures, the mr-DWL photoresist was used. 

In this case, grids of orthogonal rods in the XY-plane and interconnected rods in the Z direction 

were designed. As depicted in Figure 7.14-a, the micro-scaffold consists of bi-dimensional grids 

with a stacking sequence that repeats every 𝑛 times in the Z direction. 

Micro-scaffolds have also been created out of micro-rings. In Figure 7.14-b, the micro-scaffold 

consists of bi-dimensional ring grids with a stacking sequence that repeats every 𝑛 times in the 

Z direction. Within each 2D ring grid, the rings are sequential in the X and Y directions with 

each one having a radius (𝑟). 

 

Figure 7.14: Schematic illustration of 3D microstructures. a) Micro-scaffolds composed by 

2D grids. b) Micro-scaffolds composed by 2D ring grids. 

The micro-scaffolds depicted in Figure 7.14 were designed on LPS software applying the design 

conditions previously described. Figure 7.15-a shows, on the left, micro-scaffolds composed of 

2D grid designs with dimensions of 160×160×37.5 µm³, and on the right, micro-scaffolds 

composed of 2D ring grids with dimensions of 200×200×37.5 µm³. The thin lines in the designs 

are transferred into voxels with a depth of about 2 µm and a diameter of 0.5 µm. The 2D grids 

and rings were fabricated with an average laser power of 18 mW under a constant scanning 
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speed of 300 μm/s. The vertical rods of both designs were constructed by increasing the 

exposure time to achieve higher mechanical stability, using a scanning speed of 200 µm/s at the 

same applied average laser power. Figure 7.15-b shows the realization of the micro-scaffolds, 

corresponding to the designs in Figure 7.15-a. The micro-scaffolds were replicated several 

times on the same substrate to obtain more structural analysis. The first level of the 

microstructure, near the substrate surface, is only partially written due to some inaccuracy in 

focusing on this specific structure. 

 

 

Figure 7.15: a) Micro-scaffolds design on LPS software. b) SEM micrographs of the micro-

scaffolds fabricated. 

The 2D grids of rods formed square micro-pores in the micro-scaffolds in the design. The square 

pores defined by (𝑥𝑠𝑡𝑒𝑝 & 𝑦𝑠𝑡𝑒𝑝) are 5×5 µm² in size, with an approximate linewidth of 0.5 µm, 

while the rings pores defined by (2𝑟 = 𝑥𝑠𝑡𝑒𝑝 & 𝑦𝑠𝑡𝑒𝑝) are approximately 78 µm² in size (𝜋𝑟2) 

with 0.5 µm of linewidth, The diameter of the rings is approximately 10 µm (2𝑟), satisfying the 

design conditions of the micro-scaffolds. 

Finally, the fabrication of micro-scaffolds with well-defined geometry was successfully 

achieved through 2PP-DLW processes. The SEM micrographs of the fabricated microstructures 
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are shown in Figure 7.16-a and -b. A complete set of results of this analysis is presented in 

“Appendix F: Results in 3D microstructures”. 

 

Figure 7.16: Analysis of the measurement of micro-scaffolds in both designs in mr-DWL 

photoresist. 

7.4. High Resolution samples 

High resolution in 3D microstructures was achieved. For example, during the fabrication of 3D 

test grids, the smallest polymerized linewidth measured by SEM was 280 nm in mr-DWL 40 

photoresist (Figure 7.17-a) and 378 nm in EpoCore 5 (Figure 7.17-b). Additionally, by applying 

the characterized voxel criteria, high resolution was also achieved in the design of micro-

scaffolds, with linewidths of 333 nm and 357 nm in the 2D ring of 3D microstructures (Figure 

7.17-c and -d). 

The highest resolution can be achieved by applying effective techniques to reach values well 

below 50 nm, such as depletion microscopy applied to lithography to overcome the diffraction 

limit. These techniques can involve combining methods such as voxel tracing strategies in 3D 

vectorial movements, adding inhibitors to the photoresists, and using two-color lasers [163], 

[172]. 
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Figure 7.17: Maximum resolution reached in 3D microstructures designs. 
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CHAPTER 8 

8. Conclusions and future works 

8.1. Conclusions 

The main aim of this Thesis was the design and development of a customized system capable 

of manufacturing microphotonic devices using the 2PP technique. This goal has been achieved, 

meticulously optimized, and is now fully operational in the cleanroom of the Grupo de Fotónica 

Aplicada (GFA) at CEMDATIC, UPM. 

1. A customized 2PP system has been designed and assembled with various components and 

modules to create a compact, low-cost open-hardware system with performance similar to 

current commercial systems. This direct laser writing (2PP-DLW) equipment is suitable for 

the micro-fabrication of 2D and 3D structures and includes the firmware programming of 

the system. 

2. Additionally, a setup for single-photon polymerization direct laser writing (1PP-DLW) for 

calibration and 2PP system optimization in conventional lithography has been integrated. 

3. The characteristic voxel of commercial negative-tone and positive-tone photoresists was 

tested and characterized, providing a database for the micro-fabrication of structures with 

controlled resolution based on programmable scanning speed and laser power parameters in 

the system's software. 

4. Patterned polymeric surfaces composed of microgrooves or microlines (~0.5 µm) were 

successfully fabricated and used for liquid crystal alignment. By employing dichroic dye-

doped liquid crystals, advanced arbitrarily patterned polarizers were generated. 

5. The equipment has demonstrated its capacity to produce 2.5D (layer-by-layer) and true 3D 

sub-micrometric structures. 

6. Complex micro-scaffolds with a typical resolution of approximately 500 nm for 

bioengineering applications were also manufactured. 

8.2. Future works 

1. The development of new structures, such as photonic wire bonding, micro-lenses, micro-

optic spiral phase plates, and micro-antennas, is proposed. 
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2. From the wide variety of existing photoresists, several of the most relevant ones have been 

used. This study could be extended to other photoresists specifically designed for 2PP, 

particularly those that produce fluorescence or index changes when illuminated, which 

would improve focusing precision. 

3. Post-curing effects on 3D micro/nanostructures need to be analyzed in greater depth to assess 

the accuracy and repeatability of the 2PP system after manufacturing. 

4. Modification of the objective holder is proposed for easier changes of the objective lens for 

testing the 2PP system in oil immersion configuration and dip-in laser lithography. 

5. An improvement in focus is proposed by applying more sophisticated analysis techniques, 

such as using nanometric measurement lasers collinear with the femtosecond laser or 

employing advanced image processing with the system's vision camera. 

6. Redesigning the system's assembled structure with thermal expansion-resistant alloys and 

granite is suggested to increase its resistance to variations or vibrations. 

Finally, further sophistication of the 2PP system for micro-fabrication can be pursued, for 

example: 

1. Surpassing the Abbe’s diffraction limit for ultra-high resolution. Although a maximum 

resolution of ~280 nm has been achieved in this work, it has not been repeatable. Therefore, 

it is possible to apply advanced lithography techniques, such as stimulated emission 

depletion (STED) microscopy integrated to 2PP-DLW, to further enhance resolution in the 

nanofabrication of photonic devices with features as small as 10 nm. 

2. Multi-beam generators for simultaneous fabrication of multiple microstructures using spatial 

light modulators, diffractive optical elements, or digital micromirror devices. 

3. Micro-fabrication in other materials such as hybrid sol-gel for photonic materials, or material 

subtraction in metals. These would largely spread the number of application fields. 
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Appendix A: Cleaning and spin-coating processes 

Cleaning processes carried out on all used substrates, as well as spin-coating and baking 

processes applied to the photoresists used in this work. 

Table A.1: Cleaning processes on ITO-Glass substrates. 

N. Process Times [minutes] 

1 Immersion in Acetone 1 

2 Immersion in 2-propanol 1 

3 Ultrasonic 30 

4 Nitrogen flow drying No specific times* 

5 Baking @ 200 °C > 120 

6 Cooling to room temperature  30 

7 UVO-Cleaning 10 

 

Table A.2: Spin-coating and baking parameters of photoresists in this thesis. 

 S1800 SU-8 TF 6002 SU-8 2015 mr-DWL 40 EpoCore 5 

Film 

thickness 

[µm] 

0.5 (S1805) 

1.8 (S1818) 
2.0 38.0 40.0 15.0 

Spin-

coating 

3500 rpm, 

500 rpm/s, 

30 sec 

500 rpm, 

100 rpm/s, 

5 sec 

500 rpm, 

100 rpm/s, 

5 sec 1500 rpm, 

500 rpm/s, 

60 sec 

1000 rpm, 

500 rpm/s, 

30 sec 3000 rpm, 

500 rpm/s, 

30 sec 

1000 rpm, 

300 rpm/s, 

30 sec 

Soft-Bake 
1 min @ 115 

°C 
3 min @ 110 °C 4 min @ 95 °C 

2 min @ 50 °C 2 min @ 50 °C 

5 min @ 90 °C 4 min @ 90 °C 

Relaxation -- -- -- 30 min -- 

Exposure 2PP 1PP & 2PP 2PP 2PP 2PP 

Post-bake Not needed 2 min @ 110 °C 6 min @ 95 °C 
5 min @ 50 °C 2 min @ 50 °C 

5 min @ 90 °C 4 min @ 85 °C 

Relaxation -- -- -- 2 hrs 30 min 

Develop-

ment 

30 sec 

(Microposit) 

3 min 

(PGMEA) 

5 min 

(PGMEA) 

5 ±1 min 

(mr-Dev 600) 

1 min 

(mr-Dev 600) 
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Appendix B: Fine focusing 

Calculation of the factor 𝐻′ for fine focusing on the air configuration of the custom 2PP system. 

 

Figure B.1: a) Description of light propagation in two media with different refractive 

indices at the wavelength of the light. b) Derivation of the focal spot of the light within the 

photoresist for focusing at the photoresist-substrate interface. 

Law of Snell: 

𝑛1 sin 𝛼 = 𝑛2 sin 𝛽 

Numerical aperture (NA) of objective lens (OL) in the air configuration: 

𝑁𝐴 = 𝑛𝑎𝑖𝑟 sin 𝛼  

𝑁𝐴 = 𝑛𝑝ℎ𝑟 sin 𝛽 

Beam waist on photoresist surface: 

tan𝛼 =
𝐴′

𝐻′
 

tan𝛽 =
𝐴′

𝐻
 

Deduction of factor 𝐻′: 

𝐻′ tan𝛼 = 𝐻 tan 𝛽 

𝐻′ = 𝐻 
tan𝛽

tan 𝛼
 

By applying the identity sin2 𝜃 + cos2 𝜃 = 1 to factor 𝐻′ and simplifying tan 𝜃, where 𝜃 is the 

angle for the respective medium, the factor 𝐻′ can be rewritten as: 

a) b) 
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𝐻′ = 𝐻 √
𝑛𝑎𝑖𝑟
2 − 𝑁𝐴2

𝑛𝑝ℎ𝑟
2 − 𝑁𝐴2

 

Assigning, 𝛧 = √
𝑛𝑎𝑖𝑟
2 −𝑁𝐴2

𝑛𝑝ℎ𝑟
2 −𝑁𝐴2

 

𝐻′ = 𝛧 𝐻 

Therefore, 

𝑑𝐻′

𝑑𝐻
= 𝛧 

That means, if the thickness 𝐻 of the photoresist increases in micron units, the factor 𝐻′ 

increases in 𝛧 inside of the photoresist. Finally, 

𝐹 = 𝐻 − 𝐻′ 

𝐹 = 𝐻(1 − 𝛧) 

𝑑𝐹

𝑑𝐻
= 1 − 𝛧 

That mean, when H increases, the focal spot (𝐹) of the laser beam increases 1 − 𝛧. This assures 

that the focusing may occur at the photoresist-substrate interface when H varies. 

Therefore, 𝐻′ and 𝐹 also depends on the refractive index of both air and the photoresist and 

used OL. The NA of the OL is a constant commonly given by the fabricant, but refractive index 

is calculated using Cauchy's equation to define how much the path of light is bent in the medium 

at wavelength (𝜆) of the light. This expression is commonly given by the photoresist fabricant, 

and is expressed by: 

𝑛(𝜆) = 𝐴 +
𝐵

𝜆2
+
𝐶

𝜆4
+⋯ 

where, 𝐴, 𝐵 and 𝐶 are coefficients of the material. Table B.1 summarized the coefficients of 

photoresists used in this work. 

Table B.1: Coefficients of the air and photoresists, and refractive indices at 𝜆 = 405 nm 

and 780 nm. 

Material A B C 𝒏(λ = 405)  𝒏(λ = 780)  

air 1.00027262 1.53271037 1.319296e+4 1.00028245 1.00027517 

S1800 1.5935 1.8854e+4 4.1211e+6 1.70859906 1.62450061 

SU-8 2000 1.5660 7.96e+3 1.4e+8 1.61973284 1.57946172 

SU-8 6000 1.5674 8.03e+3 1.4e+8 1.62155960 1.58097678 

mr-DWL 1.5700 8.20e+3 3.5e+8 1.63300150 1.58442353 

EpoCore 1.5730 7.50e+3 4.7e+8 1.63619413 1.58659717 
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Figure B.2: Refractive indices of used photoresists in this work. 
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Appendix C: Results in optimization processes 

SEM results of the polymerized 2D and 3D patterned objects from the optimization experiments 

in 1PP-DLW and 2PP-DLW processes. 

 

 

Figure C.1: a) SEM images of an entire polymerized test grid in 1PP-DLW process 

optimization. The red squares are over-exposed objects, the blue ones are polymerized, and 

the yellow ones are non-polymerized. b) SEM images of an entire polymerized pattern 

object in SU-8. 

a) 

b) 
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Figure C.2: a) SEM images of an entire polymerized test grid in 2PP-DLW process 

optimization. The red squares are over-exposed objects, the blue ones are polymerized, and 

the yellow ones are non-polymerized. b) SEM images of an entire polymerized pattern 

object in SU-8. 

 

a) 

b) 
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Figure C.3: SEM images of an entire polymerized test grid in 2PP-DLW for voxel 

characterization in positive-tone photoresist S1805. 

 

Figure C.4: SEM images of an entire polymerized test grid in 2PP-DLW for voxel 

characterization in positive-tone photoresist S1818. 
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Figure C.5: SEM images of an entire polymerized test grid in 2PP-DLW for voxel 

characterization in negative-tone photoresist SU-8 TF 6002. 
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Figure C.6: a) SEM images of an entire polymerized test grid in 2PP-DLW for voxel 

characterization in negative-tone photoresist SU-8 2015. b) View of one 3D pattern object. 

 

a) 

b) 

10 µm 
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Figure C.7: 3D-view of the test grid where one is completely burned, and the other one is 

perfectly polymerized. 

 

100 µm 

100 µm 
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Figure C.8: a) SEM images of an entire polymerized test grid in 2PP-DLW for voxel 

characterization in negative-tone photoresist mr-DWL 40. b) View of two 3D pattern 

object. 

 

a) 

b) 

10 µm 

 

20 µm 
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Figure C.9: a) View of an over-exposed 3D pattern object in mr-DWL 40. b) View of one 

polymerized 3D pattern object. 

 

a) 

b) 

10 µm 

 



Appendix C: Results in optimization processes 

159 

 

 

 

 

Figure C.10: a) SEM images of an entire polymerized test grid in 2PP-DLW for voxel 

characterization in negative-tone photoresist EpoCore 5. b) View of two 3D pattern object. 

 

  

a) 

b) 

10 µm 
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Appendix D: Voxels characterization 

Characterized voxels over a wider range of scanning speeds and across the entire range of 

available laser power for S1800 series, SU-8, mr-DWL, and EpoCore photoresists. 

 

Figure D.1: Optimization of S1805 photoresist. 
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Figure D.2: Optimization of S1818 photoresist. 

 

Figure D.3. Optimization of SU-8 TF 6002 photoresist. 
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Figure D.4: Optimization of SU-8 2015 photoresist. 

 

Figure D.5: Optimization of mr-DWL 40 photoresist. The maximum xy- and z-voxels were 

empirically defined as 5 µm and 15 µm, respectively, to compute the over-exposure limit. 
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Figure D.5: Optimization of EpoCore 5 photoresist. The maximum xy- and z-voxels were 

empirically defined as 1.45 µm and 6 µm, respectively, to compute the over-exposure limit. 
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Appendix E: Results in surface alignment  

Surface alignment analysis results obtained with scanning electron microscopy for both SU-8 

and S1805 photoresists. 

 

Figure D.1: Scanning electron micrographs of an entire polymerized surface in SU-8. 

  

Figure D.2: Polymerized patterns at different alignment angles (𝜑) in SU-8. 

30 µm 

10 µm 10 µm 
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Figure D.3: Scanning electron micrographs of an entire polymerized surface in S1805. 

  

Figure D.4: Polymerized patterns at different alignment angles (𝜑) in S1805. 

 

 

20 µm 

10 µm 10 µm 
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Figure D.5: 3D visualization of patterns in SU-8 (top) and S1805 (bottom). 

   

Figure D.6: Improperly polymerized surface at very high scanning speed in S1805. 

 

10 µm 10 µm 

20 µm 10 µm 

2 µm 4 µm 



Appendix E: Results in surface alignment 

167 

 

 

 

Figure D.7: Unsuitable surfaces in SU-8 thicknesses greater than 2 µm. The microlines 

collapse during the development process. The microgrooves are not well defined under 

these conditions, and consequently, LC alignment will not comply. 

 

 

  

4 µm 

2 µm 



Byron Oswaldo Ganazhapa Jiménez 

168 

 

 

 

Appendix F: Results in 3D microstructures 

SEM micrographs of 3D microstructures and their analysis conducted in these experiments. 

 

Figure F.1: SEM images of the 3D microstructure in SU-8 photoresist. The upper images 

were taken from behind the structure, showing the tilted layers. The cut structure shown in 

the upper micrograph is due to the thickness of the spin-coated photoresist being less than 

the height of the microstructure. 

 

Figure F.2: 35° tilted microstructures in SU-8 and mr-DWL photoresists. 
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Figure F.3: 90° tilted microstructure measurements in SU-8 (upper images) and mr-DWL 

(bottom images) photoresists. 

 

Figure F.4: Example of microstructures not adhered to the substrate. This is due to an 

inadequate development and substrate cleaning process, which makes the microstructures 

difficult to measure and hinders obtaining the desired results in the fabrication of photonic 

devices. 

 

 



Byron Oswaldo Ganazhapa Jiménez 

170 

 

 

 

Figure F.5: Scanning electron micrographs of micro-scaffolds (micro-grids) in mr-DWL 

photoresist, a) top view and b) pictorial view. 

a) 

40 µm 

b) 
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Figure F.6: Scanning electron micrographs of micro-scaffolds (micro-rings) in mr-DWL 

photoresist, a) top view and b) pictorial view. 

 

 

  

a) 

b) 

100 µm 
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Appendix G: 2PP System technical specifications 

The custom 2PP system is an open-hardware prototype for microfabrication, demonstrating 

solid performance in this research work. However, it does not directly compete with equipment 

from companies specializing in 2PP lithography, such as UpNano GmbH. In this prototype 

version, it stands out for offering a larger build volume, enabled by long-travel linear axes 

(200×200×25 mm³), and mainly for its capabilities to perform both layer-by-layer fabrication 

and true 3D manufacturing through vectorial voxel movements within the material. This is 

achieved thanks to integrated software for hardware system management and process control 

(CAD and code generation). Table G.1 presents the technical specifications of this first version 

of the 2PP system compared to its commercial counterparts. 

Table G.1: Technical Specifications of the 2PP System Compared to Commercial Systems. 

Equipment 2PP System NanoOne 
Photonic 

Professional GT2 
MPO 100 

Company Lasing S.A. UpNano NanoScribe 
Heidelberg 

Instruments 

Average Power 

[mW] 

250 

(160 mW at 

focusing) 

up to 1000 120 

600 

(≥ 200 mW at 

focusing) 

Laser wavelength 

[nm] 
780 780, 515 780 522 

Pulse length [fs] 90 90 100 250 

Light source Femtosecond fiber laser 

Max. scanning 

speed [mm/s] 
up to 2.3 up to 1200 up to 625 up to 10000 

Manufacturing 

process 

Layer-by-layer 

True 3D 
Layer-by-layer 

Build volume [mm³] 200×200×25 100×120×49 100×100×8 100×100×10 

Scanner Galvanometer scanner 

Printing 

configuration 
Air-configuration 

Oil and water 

immersion 

Air-configuration, 

Oil immersion, 

Dip-laser lithography 

Objectives lens 50×, NA of 0.8 Reconfigurable 

Field of View [mm] 0.04 up to 5 up to 1 up to 2 

Resolution [nm] > 220 100 160 100 

Roughness [nm] > 20 ≤ 10 ≤ 20 ≤ 10 

 

Software 
Lasing process 

software 
Think3D 

DeScribe 

NanoWrite 

LithoSoft3D 

LithoStream 
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Equipment 2PP System NanoOne 
Photonic 

Professional GT2 
MPO 100 

Materials 
Commercial 

photoresists 

Custom 2PP photoresists and 

commercial ones 

Commercial 

photoresists 

 

Ambient conditions 
Standard cleanroom conditions. 

Air pressure required for vibration isolation. 

 

Price [euros] ~200 k 0.5 – 1 M 
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User Manual of 2PP System 
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Simplified illustration of the Two-Photon Polymerization (TPP) process. 

This user manual presents the hardware and software for the usage of the 2PP system for 

micro/nanofabrication in negative-tone and positive-tone photoresists. 

Two-photon polymerization direct laser writing (2PP-DLW) is an optical lithography 

technology. In 2PP, the light-matter interaction occurs only within the volume of the focused 

laser spot, commonly known as a voxel, which can be freely traced in three dimensions within 

the material. This is where micro and nanostructures take shape, similar to building the pyramid 

brick by brick, but on a nanometric scale. 

1. Hardware 
This section presents the hardware and accessories of the 2PP system. Detailed explanations on 

the usage of each component, as well as all the procedures necessary for the proper operation 

of the system, are provided. The below figure shows the 2PP system completely assembled with 

the major viewed components. 
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Overview of the 2PP system 

1.1. Anti-vibration table 

The 2PP system is mounted on an optical test table that is isolated from vibrations using 

pneumatic isolators. The optical table receives compressed air or nitrogen at a pressure of 5–10 

psig (0.4–0.7 kg/cm²) to ensure optimal damping of vibrations and sudden movements of the 

2PP system axes. The general specifications of the optical table are: 

• Load Capacity (per isolator): 240 kg (60 kg). 

• Dimensions: 750mm × 900mm × 58mm. 
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The Vision IsoStation vibration isolated workstation of the 2PP system. 

1.2. Optical components table 

The laser header and optics are mounted on the superior breadboard. The 2PP setup and 1PP 

setup are mounted in this optical table. 

 

Superior breadboard. 

1.3. Vision and nano-positioning stages components table 

The vision components, nano-positioning stages (piezo and galvos), and optics are mounted on 

the vertical breadboard. 
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Vertical breadboard: In this illustration, the XY galvos and Z piezo stage are shown. 

1.4. Focusing system 

The 2PP system is composed of a 50X objective lens with a numerical aperture of 0.8 and a 

displacement laser to measure the distance between the objective lens and the material surface 

for focusing the laser beam into the photoresist and for observing the printing process. 

 

Focusing system: In this illustration, the Z piezo stage is shown. 
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1.5. Micro-positioning 

The 2PP system is assembled with a long linear stage for coarse positioning along the X, Y, 

and Z axes, and a piezo stage with galvos for fine positioning along the same axes. The linear 

stage enables stitching processes in micro and meso-structures on a single substrate. The 

working area is 200 mm × 200 mm. The Z linear stage has a travel range of 25 mm. 

The Z piezo stage is mounted on the vertical breadboard, and its movements are thus 

coordinated with the stage movements, providing a travel range of 100 µm in the Z axis. The 

XY galvos are mounted on the vertical breadboard in the laser beam path to move the laser 

beam in the XY plane across the sample. The XY galvos have a field of view of 40 µm × 40 

µm (with the used objective lens) for printing on the sample. 

The Z piezo stage and XY galvo work together with the X and Y linear stages for stitching and 

synchronize the laser movement on the sample. They are also perfectly programmed to perform 

the focusing for direct laser writing processes. 

   

  

Micro-position stages: X and Y linear stage in (a), and Z linear stage in (b). Nano-position 

stages: XY galvos in (c), and Z piezo stage in (d). 

a b 

c d 
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1.6. Laser 

The 2PP system is equipped with a femtosecond pulsed fiber laser source with a central 

wavelength of 780 nm. The laser power varies between 0 mW and 160 mW, with pulse widths 

of 90 fs. To adjust the laser power, the user must configure a variable in the software to control 

a rotating stage that rotates a half-wave plate, thereby varying the intensity of the polarized 

output. 

The laser module is located under the anti-vibration table, while the laser header is located on 

the Superior breadboard. 

   

Laser module (left) and laser header (right). 

1.7. Control rack 

The control rack is located under the laser module and anti-vibration table. The control rack 

houses the power supply case, the control case, and the computer for the 2PP system, as well 

as the galvos controller within the control case. 

 

Control rack. 
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2. Start Up the Hardware of the 2PP System 
Before using the 2PP system, the user must follow several steps to power on all electronic 

components and prepare the 2PP system prior to the DLW process, considering laser safety 

standards and ensuring proper functionality for polymerization on photoresist materials. The 

following steps outline the necessary procedures. 

1) Turn on the control rack. The main switch, located at the back of the rack, distributes 

power to the entire 2PP system. 

 

2) Turn on the control case, power case, and computer case. Each case has its own switch 

for added safety. The switches are located at the front of the cases. 

   

3) Turn on the piezo controller. The switch is located at the back of the piezo controller. 

Ensure that the piezo stage is correctly initialized in controller. 

   

Computer switch 

Control case switch 

Power case switch 

Piezo stage enabled 

Piezo controller switch 

Main switch 
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4) Turn on the illumination controller. Although the illumination does not affect the 

DLW processes, it ensures proper functionality of the vision system. 

   

5) Finally, turn on the laser module without switching on the shutter. The shutter should 

only be enabled for DLW processes; in all other situations, it must remain off. 

 

  

 

When the laser is fired, use protective glasses for the laser radiation to prevent eye 

damage when operating the 2PP system. 

 

 

Illumination switch 

Laser module switch 

Top Bottom 

Shutter key - Set to OFF 
Shutter key - Set to ON 
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3. Software 

This section introduces the Lasing Processing Software (LPS) commonly used in conjunction 

with the 2PP system. However, it does not provide detailed instructions for programming the 

LPS software, as these will be covered in the software guide. Please refer to the Help tab in the 

LPS software for more details and specific instructions. 

LPS software is only enabled for operating systems of Microsoft Windows 10 and 11. 

 

Icon of LPS software. 

3.1. Front panel 

The LPS software provides an easy-to-use graphical front panel for controlling the 2PP system. 

The entire system hardware is managed by software, which is correctly configured and 

calibrated for DLW processes. 

The front panel is divided into tools menu, recipe window, command properties window and 

preview window. 

• The tools menu provides all available configurations for the 2PP system. 

• The recipe window lists sequential commands, such as variables, functions, CAD files, 

geometric objects, controller code files, ports, settings, etc. 

• The command properties window shows the settings for the command selected in the 

recipe window, such as program variables, geometric object shapes, hatching, marking 

properties, etc. 

• The preview window displays a representation of the recipe, including geometric 

objects and CAD files. 
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Front panel of the LPS software. 

3.2. Tools menu 

The Tools menu provides all available tools for processing, calibration, and management of the 

2PP system, organized into the following tabs: 

Tabs Description 

File File management tools and General Settings. 

Home Main Tools used in the machining process. 

Control Tools used to control various connected devices 

Camera/Vision Tools related to cameras, their adjustment and control (visible only when 

Machine Vision module is installed and at least one Camera is enabled in the 

Settings). 

Edit Tools used in CAD Object Editing. 

Edit 3D Tools used in 3D CAD Object Editing. 

Help Support contacts, bug reporting and manual. 

 

3.3. File tab 

The File tab is a drop-down menu that allows users to create new recipes, open software files 

in the .rps format, save recipes (also in .rps format), and open the Settings window. 

Additionally, sample files are provided for running examples in the LPS software. Please note 

that only the English language is available in the LPS software. 

Preview window 
Recipe 

window 

Command 

properties 

windows 

Tools menu 
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File tab functions. 

3.4. Settings window 

The general settings window can be accessed via the File tab, opening a new window with 

multiple pages, some of which are subdivided into tabs. This settings window contains all 

configurable hardware options available for the 2PP system controlled by the software, such as 

motion controller, stages, galvos, laser, camera, etc. 

All hardware must be configured in this window for the correct use of the 2PP system. 

 

Settings window of the 2PP system hardware. 
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3.5. Home tab 

The home tab can be divided into process, geometry, recipe flow, device, positions and view. 

• Process provides access to the main functions in the manufacturing workflow, such as 

Connect/Disconnect System, Compile Recipe, Run Recipe, Joystick window, and 

Cancel Process. 

• Geometry is used to create motion trajectory commands for positioning stages, galvo 

scanners, or other motion devices, such as lines, circles, rectangles, text, etc. 

• Recipe Flow describes the use of tools and commands in the recipe window that 

influence the behavior of other commands during recipe execution. For example, 

creating sequences of geometric objects with the array command, repeating a geometric 

object with the for command, applying conditions with the if command, 

exporting/importing data, adding notes, controller codes, etc. 

• Device describes the tools and commands in the recipe window that control hardware 

behavior during recipe execution. 

• Positions show current position of the positioning axes, i.e, X, Y, Z linear stages, Z 

piezo stage, X and Y galvos stages, and can be shown the Displacement Laser Unit 

(DLU) for Z axis – DLU(Z). 

• View controls the preview window. 

 

Home tab in Tools Menu. 

3.6. Joystick window 

The joystick window is a tool allowing manual control of all available positioning stages in the 

2PP system. 

The keyboards displayed in the window for each linear stage control the position by setting a 

specific speed or jog distance. Homing and enabling/disabling of each stage can be done using 

the buttons next to the stage name. 

The Faser Fire button triggers the laser to fire at the current power setting. 

 

Please wear safety goggles and adhere to other system-specific safety requirements 

when firing the laser. 
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Position buttons (P1, P2, P3, P4) allow the user to store specific frequently used positions, such 

as loading/unloading positions. Motion to predefined positions can be executed by clicking on 

the P1...P4 buttons. The current position can be assigned to a button by pressing Ctrl + position 

number on the keyboard (1, 2, 3, 4) or set manually in the Joystick settings. In the Joystick 

settings, each axis must be enabled or disabled for each position. For example, if the rotary axis 

is disabled for P1, it will not rotate when P1 is clicked. 

Finally, the settings window can be opened directly by clicking the settings button. 

 

Joystick window. XY galvos buttons are not shown in this window. 

3.7. Other Tools menu tabs 

For detailed information on the Control, Camera/Vision, Edit, and Edit 3D tabs, refer to the 

Help tab in the LPS software directly, or press F1. 

4. Start Up the Software of the 2PP System 
Before starting a DLW process, the user must follow several steps to prepare the LPS software, 

ensuring that all hardware is correctly configured and calibrated. 

1) Open the LPS software. It can be found in your computer desktop or Windows start tab. 
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2) Press Connect To Hardware button. It can be found in Home tab > Process. 

 

It identifies and checks that all hardware is correctly connected to the 2PP system; 

otherwise, an error may be displayed if any hardware is not connected. 

 

The homing processes for all positioning axes are automatically executed if no errors 

are present, but some warnings can be appeared in the positions tab. 

 



Start Up the Software of the 2PP System 

191 

 

If homing is not executed correctly, press the  icon for each stage to repeat it one by 

one. 

To clear all warnings and possible errors, simply press the  icon for all stages. 

 

The warning for the Displacement Laser Unit (DLU) is triggered because the sensor is 

not positioned on the surface of the sample, resulting in a measurement range outside 

of 24 mm to 26 mm. This error does not stop or hinder your DLW processes. 

3) Execute the "Find Focus" example to find the height of the objective lens relative to the 

surface, i.e., the working distance of the objective lens. 

 

 

A sample e.g., glass or silicon must be placed on the sample holder to execute the 

example; otherwise, the objective lens may collide with the sample holder, and it 

may damage the objective lens. 

 

This example is not available in the example recipes of the LPS software; therefore, it 

can be easily programmed by adding an ACSPL+code command, which can be found 

in the Home tab > Recipe Flow > More > ACSPL+code. 

In the Command Window, you can enter the following code by selecting ACSPL+code 

command in the Recipe window: 



Byron Oswaldo Ganazhapa Jiménez 

192 

 

START 7, FOCUS 

TILL ^PST(7).1 

STOP 

Then, press the run icon to automatically find the focus. It process is known as coarse 

focusing. 

 

Finally, you can verify the focus by checking the position indicators of the stages, where 

the Z piezo is related to the measurements from the DLU (0.0028 mm in the below 

picture). The height of the objective lens is computed automatically and can be 

displayed in the Z linear stage indicator (8.0123 mm). 

 

 

The height of the objective lens may vary if a different sample is placed in the sample 

holder. To find the new focus, the "Find Focus" example must be executed again. 

 

4) Execute the "Surface mapping" example to determine the topology of the surface 

sample. This step allows you to find the inclination of the sample on the sample holder 

and the height (in the Z axis) of the measurement points. 
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This example is not available in the example recipes of the LPS software; therefore, it 

can be easily programmed by adding some commands found in the Home tab > Recipe 

Flow > More. Below is the list of commands needed for this example. 

• Variable 

• ACSPL+code 

• Export Data 

• Z Map 

Two variables are used to set the width (XP) and length (YP) of the surface to be 

analyzed. In the Command Window, you can enter the following code by selecting each 

variable command in the Recipe window: 

set_acs_var(XP=7.5) 

set_acs_var(YP=10) 

This XP and YP can be changed according to the used needs. 

In the Command Window, you can enter the following code by selecting ACSPL+code 

command in the Recipe window: 

START 7, Z_MAP 

TILL ^PST(7).1 

STOP 

By selecting the Export Data command in the Recipe window, you can program the list 

of measured points on the surface. These measurements are obtained from the global 

variables of the ACS controller, and the LPS software builds a table that you can save 

as a TXT file in any location. 

 

Each item must be programmed one by one, and the following table provides the details 

for each of them: 
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No. Type Data No. Type Data 

1 Variable get_acs_var(?DATAH(0)) 22 New Line  

2 Variable get_acs_var(?DATAH(1)) 23 Variable get_acs_var(?DATA(4)(0)) 

3 Variable get_acs_var(?DATAH(2)) 24 Variable get_acs_var(?DATA(4)(1)) 

4 Variable get_acs_var(?DATAH(3)) 25 Variable get_acs_var(?DATA(4)(2)) 

5 Variable get_acs_var(?DATAH(4)) 26 New Line  

6 New Line  27 Variable get_acs_var(?DATA(5)(0)) 

7 Variable get_acs_var(?DATA(0)(0)) 28 Variable get_acs_var(?DATA(5)(1)) 

8 Variable get_acs_var(?DATA(0)(1)) 29 Variable get_acs_var(?DATA(5)(2)) 

9 Variable get_acs_var(?DATA(0)(2)) 30 New Line  

10 New Line  31 Variable get_acs_var(?DATA(6)(0)) 

11 Variable get_acs_var(?DATA(1)(0)) 32 Variable get_acs_var(?DATA(6)(1)) 

12 Variable get_acs_var(?DATA(1)(1)) 33 Variable get_acs_var(?DATA(6)(2)) 

13 Variable get_acs_var(?DATA(1)(2)) 34 New Line  

14 New Line  35 Variable get_acs_var(?DATA(7)(0)) 

15 Variable get_acs_var(?DATA(2)(0)) 36 Variable get_acs_var(?DATA(7)(1)) 

16 Variable get_acs_var(?DATA(2)(1)) 37 Variable get_acs_var(?DATA(7)(2)) 

17 Variable get_acs_var(?DATA(2)(2)) 38 New Line  

18 New Line  39 Variable get_acs_var(?DATA(8)(0)) 

19 Variable get_acs_var(?DATA(3)(0)) 40 Variable get_acs_var(?DATA(8)(1)) 

20 Variable get_acs_var(?DATA(3)(1)) 41 Variable get_acs_var(?DATA(8)(2)) 

21 Variable get_acs_var(?DATA(3)(2)) -- -- -- 

 

 

The LPS software also includes the FOCUS and Z MAP commands for finding the 

focus of the objective lens and performing the surface mapping process, 

respectively. However, these commands are not reliable as they exhibit errors in 

stage positioning at resolutions below 5 microns. 

Finally, Z MAP is only used to import files for applying surface mapping in the 

recipes obtained during this startup step. 

 

Finally, the Z Map command is used to display the mapped surface by reading the 

previously created TXT file. 
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Nine default points are defined in this example. If you need to extend the 

measurement range with more points, you must modify Export Data command 

adding more variables and modified the “DATA” array from the ACS controller 

code, located in D-Buffer and Buffer 7. 

 

 

 

The "Find focus" and "Surface mapping" examples can be used as many times as 

needed for the required samples before executing the DLW processes. 

 

Buffers 
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5. Application examples 
2D and 3D structures are commonly polymerized in the 2PP system; therefore, the following 

examples show how to program them in the LPS software. 

The LPS software does not have a structured programming format; you must ensure that all 

commands used are correctly ordered according to the sequential lines in the recipe window. 

5.1. Process Geometric Objects 

In this example, you will program a 10×10 matrix of square objects. Each square object is 

configured with different laser power, increasing from 0.1 mW for the first object to 160 mW 

for the last object. All objects will be polymerized at the same scanning speed of 0.1 mm/s. The 

size of the square objects is 40×40 µm². Additionally, a cross object is inserted inside each 

square object. 

 

The LPS software must be prepared beforehand to program 2D structures; this means that 

focusing using the "Find Focus" example and mapping the topology of the photoresist with the 

"Surface Mapping" example must be performed on the photoresist surface where the structure 

will be polymerized. 

"Find Focus" and "Surface Mapping" examples are explained in section 4. 

1) First, insert the necessary variables to define object positions, object sizes, and initialize 

scanning speed or laser power. Using these variables is not mandatory but simplifies the 

program's flow. 

The variable command can be found in Home tab > Recipe Flow > Variable 



Application examples 

197 

 

 

2) Next, a mandatory command is to import the mapping file of the material surface created 

by the previously specified "Surface Mapping" example. 

The Z Map command can be found in Home tab > Recipe Flow > More > Z Map. 

In the Command Window, you can configure the required parameters to import the file 

and display the mapped surface topology in the Preview window: 

 

3) If the thickness of the photoresist is less than the voxel depth of the focused femtosecond 

laser along the optical axis, the factor 𝐻’ cannot be applied. 

𝑧‑𝑣𝑜𝑥𝑒𝑙 =
2𝜆𝜂

𝑁𝐴2
 

4) Then, you insert to the recipe window an Array command, to build a matrix of squared 

objects with crosses. For this, Array command can be found in Home tab > Recipe 

Flow > More > Array. 

 

X and Y Count parameters let set the size of the matrix, it is 10×10 objects. 

StepX and StepY are optional variables inserted in the first step of this example to define 

the separation between consecutive objects along the X and Y axes. 
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5) To increase the laser power for each object, two variables will be used to control each 

iteration, and will be inserted inside of the Array command. 

The One variable command is set as 𝑃𝑜𝑤𝑒𝑟 =  𝑃𝑜𝑤𝑒𝑟 +  0.1 

 

 

The laser power value may vary depending on the used photoresist. You should 

verify the data available in “Appendix D: Voxels characterization” of this PhD 

project. 

 

The laser power is defined by the next equation: 

𝑃𝑜𝑤𝑒𝑟 = 160 𝑐𝑜𝑠2(2𝜃 − 97.4°) 

where the power is attenuated by varying the angle 𝜃. 

So, the second variable command is set as 𝜃 =
1

2
(acos (√

𝑃𝑜𝑤𝑒𝑟 

160
) + 97.4°) 

 

6) According to the 𝜃 computed in the variable command, you need to rotate the half-wave 

plate (HWP) assembled inside the rotary stage. Therefore, you must use an Axis 

command to rotate the HWP based on the angle obtained from the variable command. 

The Axis command can be found in Home tab > Devices > More > Axis. 

In the Command Window, you can select the Rotary HWP to move the stage and set the 

angle 𝜃 multiplied by 3. The constant is used because the axis of rotation of the rotary 

stage is reduced by a factor of 3 with respect to the internal motor's rotation. 

 

The speed of the rotary stage can be set according to the user requirements. 

7) Next, you can insert the geometric object to be polymerized in the photoresist. The 

squared object can be found in Home tab > Geometry > Rectangle. 
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SizeX and SizeY are variables to set the object size, it is 40×40 µm². 

PosX and PosY are variables to set the object position in the Preview Window. 

The cross object can be created by inserting two-line command, and it can be found in 

Home tab > Geometry > Line. 

   

8) Finally, the objects to be polymerized on the photoresist are configured according to 

scanning speed parameter in marking properties. 

 

If scanning speed parameter is not configured, the object will not be polymerized. 

 

In the Command Window, you can configure this parameter by selecting marking tab 

of the geometry object. 



Byron Oswaldo Ganazhapa Jiménez 

200 

 

 

Marking parameters can be created and saved for use in other objects or recipe projects. 

The Motion Device allows you to select which stages can be used to execute motion for 

the DLW processes. 

 

If the size of the geometric objects is larger than the field of view of the XY galvos, 

the stitching command must be added to the recipe window; otherwise, errors may 

appear during compilation. 

 

The Mark Speed (mm/s) allows you to set the scanning speed for DLW processes. The 

stages will be moved to the set speed. This can be used and variable command to set the 

speed variable for other recipes projects or objects. 

9) In the next figure you can see the completed example in the LPS software with all 

commands displayed in the recipe window. 
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5.2. Process DXF file 

In this example, you will load a DXF file to be processed in 2PP system. This file will be 

configured according to the processing parameters, adding hatching parameters and stitching 

command. 

 

The LPS software must be prepared beforehand to program 2D structures; this means that 

focusing using the "Find Focus" example and mapping the topology of the photoresist with the 

"Surface Mapping" example must be performed on the photoresist surface where the structure 

will be polymerized. 

"Find Focus" and "Surface Mapping" examples are explained in section 4. 



Byron Oswaldo Ganazhapa Jiménez 

202 

 

1) First, insert the necessary variables to define, for example, CAD positions, CAD sizes, 

and initialize scanning speed or laser power. Using these variables is not mandatory but 

simplifies the program’s run flow. 

The variable command can be found in Home tab > Recipe Flow > Variable 

 

2) Next, a mandatory command is to import the mapping file of the material surface created 

by the previously specified "Surface Mapping" example. 

The Z Map command can be found in Home tab > Recipe Flow > More > Z Map. 

In the Command Window, you can configure the required parameters to import the file 

and display the mapped surface topology in the Preview window: 

 

3) Then, you can insert the stitching command. This command can be found in Home tab 

> Devices > More > Stitching. 

In the Command Window, you can configure all parameters by selecting stitching 

command in recipe window. 
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The Stitching Type allows you to choose how to divide the CAD object into n 

processing tiles. 

The X and Y dimensions of the tiles must be configured to be less than the field of view 

of the galvos in X (mm) and Y (mm), here it can be set to 30 × 30 µm². 

4) If the thickness of the photoresist is less than the voxel depth of the focused femtosecond 

laser along the optical axis, the factor 𝐻’ cannot be applied. 

𝑧‑𝑣𝑜𝑥𝑒𝑙 =
2𝜆𝜂

𝑁𝐴2
 

5) The configured laser power is constant in this example. Therefore, two variable 

commands are used to configure it. 

One variable command is set as 𝑃𝑜𝑤𝑒𝑟 =  150 

 

 

The laser power value may vary depending on the photoresist used. You should 

verify the data available in “Appendix D: Voxels characterization” of this PhD 

project. 

 

The laser power is defined by the next equation: 
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Power = 160 cos2(2𝜃 − 97.4°) 

where the power is attenuated by varying the angle 𝜃. 

So, the second variable command is set as 𝜃 =
1

2
(acos (√

𝑃𝑜𝑤𝑒𝑟 

160
) + 97.4°) 

 

6) According to the 𝜃 computed in the variable command, you need to rotate the half-wave 

plate (HWP) assembled inside the rotary stage. Therefore, you must use an Axis 

command to rotate the HWP based on the angle obtained from the variable command. 

The Axis command can be found in Home tab > Devices > More > Axis. 

In the Command Window, you can select the Rotary HWP to move the stage and set the 

angle 𝜃 multiplied by 3. The constant is used because the axis of rotation of the rotary 

stage is reduced by a factor of 3 with respect to the internal motor's rotation. 

 

The speed of the rotary stage can be set according to the user requirements. 

7) Next, you can insert the CAD object to be polymerized in the photoresist. The DXF file 

can be loaded from Home tab > Geometry > Import CAD. 

 

In the Command Window, you can configure all parameters by selecting the CAD 

Object command in the recipe window. 
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The CAD size can be set using a user variable command (SizeX). 

The position of the CAD object can be set using PosX and PosY variables. 

8) Then, the CAD object is configured to add hatching properties. 

In the Command Window, you can configure this parameter by selecting the hatching 

tab of the CAD object. 

 

Different hatching types are available, allowing you to set the spacing, angle, order, etc. 

9) Finally, the CAD object to be polymerized on the photoresist are configured according 

to scanning speed parameter in marking properties.  
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If scanning speed parameter is not configured, the object will not be polymerized. 

 

In the Command Window, you can configure this parameter by selecting   marking tab 

of the geometry object. 

 

Marking parameters can be created and saved for reuse in other objects or recipe projects 

The Motion Device allows you to select which stages can be used to execute motion for 

the DLW processes. 

 

If XY linear stages are used for DLW processes, the stitching command does not 

need to be used. 

 

The Mark Speed (mm/s) allows you to set the scanning speed for DLW processes. The 

stages will be moved to the set speed. This can be used and variable command to set the 

speed variable for other recipes projects or objects. 

10) In the next figure you can see the completed example in the LPS software with all 

commands displayed in the recipe window. 



Application examples 

207 

 

 

5.3. Process STL files 

In this example, you will load an STL file to be processed in the 2PP system. This file will be 

configured according to the processing parameters, with added hatching parameters and 2.5D 

settings. You will program a wafer of lenses, as shown in the figure below. All lenses are 

configured with the same laser power and scanning speed.  

The lens design can be downloaded from Newport or Thorlabs in any format and then converted 

to STL format. The lens size is flexible but will be resized to micron dimensions within the LPS 

software. 

    

Find Focus and Surface Mapping must be previously performed on the photoresist. "Find 

Focus" and "Surface Mapping" examples are explained in section 4. 
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1) First, insert the necessary variable commands to define parameters such as lens 

positions, lens sizes, separation between lenses, scanning speed, and laser power, etc. 

The variable command can be found in the Home tab > Recipe Flow > Variable. 

Next, the inserted variables for this example are shown in the recipe window in the 

figure below. 

 

The wafer size can be bigger or less than 2 mm. If it is bigger, the LPS software can 

take more time to compile the example. 

 

The photoresist used in this example is mr-DLW 40. Therefore, the height of the 

lenses must be less than the thickness of the spin-coated photoresist. 

 

The laser power is defined as a constant value in this example, and all lenses will be 

processed with the same intensity as a function of 𝜃. 

To define the angle 𝜃 at the given laser power, you will set the following equation in a 

variable command: 

𝜃 =
1

2
(acos(√

𝑃𝑜𝑤𝑒𝑟 

160
) + 97.4°) 

According to the 𝜃 computed in the variable command, you need to rotate the half-wave 

plate (HWP) assembled inside the rotary stage. Therefore, you must use an Axis 

command to rotate the HWP based on the angle obtained from the variable command. 

The Axis command can be found in Home tab > Devices > More > Axis. 

In the Command Window, you can select the Rotary HWP to move the stage and set the 

angle 𝜃 multiplied by 3. 
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2) Next, import the mapping file of the photoresist surface created by "Surface Mapping" 

example. 

The Z Map command can be used to import the TXT file, and it can be found in Home 

tab > Recipe Flow > More > Z Map. 

In the Command Window, you can configure the required parameters to import the file 

and display the mapped surface topology in the Preview window: 

 

3) Next, insert an ACSPL+ code command to compute the factor 𝐻’ for the mr-DLW 40 

photoresist. This will move the Z linear stage downward until the laser spot is aligned 

with the photoresist-substrate interface. 

The ACSPL+code command can be found in the Home tab > Recipe Flow > More > 

ACSPL+code. 

In the Command Window, you can enter the following code by selecting ACSPL+code 

command in the Recipe window: 

!Set the thickness of the spin-coated photoresist in mm. 

THK=0.060 

 

START 7, mr_DLW 

TILL ^PST(7).1 

STOP 

To apply the factor 𝐻’, you must know the thickness of the spin-coated photoresist. In 

this example the thickness is 60 µm. The photoresist datasheet must be checked to obtain 

the desired thickness. 

The following table lists the photoresist codes available in the ACS controller database.  
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Photoresist Code in ACSPL+code command 

S1800 G2 serie S1800 

SU-8 2000 serie SU8_2000 

SU-8 6000 serie SU8_6000 

mr-DLW serie mr_DLW 

EpoCore serie EpoCore 

 

4) Next, insert Loop commands to construct the wafer. This is achieved by using two 

nested Loops to calculate the arrangement and quantity of lenses that will form the 

wafer. 

The Loop command can be found in the Home tab > Recipe Flow > More > Loop. 

  

Each loop is assigned by n2 for iteration in y-axis, and n1 for iteration in x-axis. 

   

5) Next, you can insert the STL object to be polymerized in the photoresist. The STL file 

can be loaded from Home tab > Geometry > Import CAD. And it is nested in the second 

Loop command. 

 

In the Command Window, you can configure all parameters by selecting   the CAD 

Object command in the recipe window. 
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The lenses size can be set using a user variable command (SizeX, SizeY and SizeY). 

The positions of the lenses can be defined using the expressions shown in the figure 

above. These define the distribution of the lenses on the wafer. 

The mode used in this example is 2.5D Slicing. This means that the lenses will be 

polymerized by layers. 

 

A 3D mode for STL files is also available in the LPS software. 

 

6) Then, the Lenses are configured to define the separation between layers. 

In the Command Window, you can configure it by selecting the Slicing tab of the STL 

object. 

  

 

The distance between layers is determined by the voxel height for the given 

photoresist. 
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7) Then, the Lenses are configured to add hatching properties. 

In the Command Window, you can configure it by selecting the hatching tab of the STL 

object. 

 

Different hatching types are available, allowing you to set the spacing, angle, order, etc. 

 

The hatching parameter is defined by the lateral voxel size in the XY plane for the 

given photoresist. 

 

8) Finally, the scanning speed parameter in the marking properties will be configured for 

the STL objects. Linear stages are used instead of galvos. 

In the Command Window, you can configure it by selecting the marking tab of the 

geometry object. 

 

If scanning speed parameter is not configured, the object will not be polymerized. 
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Marking parameters can be created and saved for reuse in other objects or recipe 

projects. 

The Motion Device allows you to select which stages can be used to execute motion for 

the DLW processes. 

 

If XY linear stages are used for DLW processes, the stitching command does not 

need to be used. 

 

The Mark Speed (mm/s) allows you to define the scanning speed for DLW processes, 

adjusting stage movement to the specified speed. This setting can be used with a variable 

command to set the speed as a variable for other recipe projects or objects. 

9) In the next figure you can see the completed example in the LPS software with all 

commands displayed in the recipe window. 
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Additionally, you can see the layers of the Lenses in Preview tab. 

  

 

 


